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Important
This equipment has been tested and found to comply with the limits for a Class B digital
device in accordance with the specifications in Part 15 of FCC rules. See instructions if
interference to radio or television reception is suspected.

Radio and television interference
The equipment described in this manual generates, uses, and can radiate radiofrequency energy. If it is not installed and used properly—that is, in strict accordance
with Apple’s instructions—it may cause interference with radio and television reception.
This equipment has been tested and found to comply with the limits for a Class B digital
device in accordance with the specifications in Part 15 of FCC rules. These specifications
are designed to provide reasonable protection against such interference in a residential
installation. However, there is no guarantee that interference will not occur in a
particular installation.
You can determine whether your computer system is causing interference by turning it
off. If the interference stops, it was probably caused by the computer or one of the
peripheral devices.

S Important: Changes or modifications to this product not authorized by Apple
Computer, Inc., could void the FCC Certification and negate your authority to
operate the product.
This product was tested for FCC compliance under conditions that included the use
of shielded cables and connectors between system components. It is important that
you use shielded cables and connectors to reduce the possibility of causing
interference to radios, television sets, and other electronic devices. For Apple
peripheral devices, you can obtain the proper shielded cables from your Appleauthorized dealer. For non-Apple peripheral devices, contact the manufacturer or
dealer for assistance. S
DOC Class B Compliance This digital apparatus does not exceed the Class B limits for
radio noise emissions from digital apparatus set out in the radio interference regulations
of the Canadian Department of Communications.
Observation des normes—Classe B Le présent appareil numérique n’émet pas de
bruits radioélectriques dépassant les limites applicables aux appareils numériques de la
Classe B prescrites dans les règlements sur le brouillage radioélectrique édictés par le
Ministère des Communications du Canada.

If your computer system does cause interference to radio or television reception, try to
correct the interference by using one or more of the following measures:

m
m
m
m

Turn the television or radio antenna until the interference stops.
Move the computer to one side or the other of the television or radio.
Move the computer farther away from the television or radio.
Plug the computer into an outlet that is on a different circuit from the
television or radio. (That is, make certain the computer and the television or radio
are on circuits controlled by different circuit breakers or fuses.)

If necessary, consult your Apple-authorized service provider or Apple. See the service
and support information that came with your Apple product. Or, consult an
experienced radio/television technician for additional suggestions. You may find helpful
the following booklet, prepared by the Federal Communications Commission:
Interference Handbook (stock number 004-000-00493-1). This booklet is available from
the U.S. Government Printing Office, Washington, DC 20402.
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Preface

How to Use This Book

Certain kinds of information are not included in this book.
n

This book has several parts.
n

n

n

Chapter 1 explains how to set up your computer and learn
how to use it.
Chapters 2–4 are a tutorial designed for people who have not
used a Macintosh computer before. If you are new to the
Macintosh, you should read this section of the book before
you start your own work.
Chapters 5–14 contain reference information that will help
you as you become more proficient with your computer.
You can turn to these chapters for information about a
particular topic.
Most of the equipment designed specifically for use with your
PowerBook Duo—the Duo Dock, the Duo Floppy Adapter,
the Duo MiniDock, the external floppy disk drive, the external
battery recharger—is documented in these reference chapters.

n

n

n

Information about modems. If your computer has a built-in
modem, or if you purchase one later, you receive a separate
modem manual with instructions for its use.
Information about application programs. Your best source of
information about a particular program is the set of books and
disks that came with that program.
Technical specifications for your PowerBook Duo model.
These are on a separate sheet in the box with your computer.

(The illustrations contained in this book are of several PowerBook
Duo models, so the pictures may not exactly match your
PowerBook.)
Turn to Chapter 1 to set up your new PowerBook Duo computer.
Welcome to PowerBook Duo.

At the back of the book you’ll find a troubleshooting section
and an index.

xv

Chapter 1

Setting Up Your
PowerBook Duo

n

n

In this chapter
n

Setting up your computer

n

Learning how to use your computer

n

Turning the computer on and off

n

Important care and safety instructions

n

Being comfortable while you work

n

New Macintosh users: If you have never used a Macintosh
computer before, read this entire chapter. It explains how to
set up your computer, learn to use it, and turn it on and off.
New PowerBook users: If you have used other Macintosh
computers but are new to the PowerBook, follow the setup
instructions that begin on the next page and then go to the
section “Turning the PowerBook On and Off.”
Experienced PowerBook users: Skim this chapter for
information that applies to your computer.

S Important: No matter what your level of experience, please
read the safety information in this chapter before beginning
your own work. This information can help protect you and
your computer from possible harm. S

1

Setting up the computer
Step 1: Plug in the power adapter

2. Plug the power adapter cable into the power adapter
port on the back panel of the computer.
You can keep extra cable out of the way by winding it around
the clips that open out from the power adapter.

Plugging in the power adapter recharges the computer’s battery
while you work. You should plug it in now in case the battery has
drained during shipping and storage.
s Warning: Use only the power adapter that came with your
PowerBook computer. Adapters for other electronic devices
(including other portable computers) may look similar, but
they may damage your computer. s
Your computer’s power adapter comes with a detachable power
cord.
1. Plug one end of the power cord into the power adapter,
and the other end into a three-hole grounded outlet or
power strip.
s Warning: Your PowerBook is equipped with a three-wire
grounding plug—a plug that has a third (grounding) pin. This
plug is a safety feature, and is meant to fit only a grounded AC
outlet. If you are unable to insert the plug into an outlet,
contact a licensed electrician to replace the outlet with a
properly grounded outlet. s

2 Chapter 1: Setting Up Your PowerBook Duo

Depending on where you purchased your computer, you may also
have received a wall mount plug. You can use this plug instead of
the power cord to plug the power adapter directly into an
electrical outlet.

Step 2: Open the display
n

Slide the latch to the right and lift up the display.

Position the display at a comfortable viewing angle. You can
adjust the angle of the display at any time.

continues .
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Step 3: Turn on the computer
n

Turn on the computer by pressing the Power On key
above the keyboard.

Power On key

You hear a tone when you turn on the computer. It takes the
computer a moment to start up.
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When you see the Macintosh desktop on your screen, the
computer is ready to use.

Trouble?
n

n

The computer made a sound, but you can’t see anything on
the screen.
Adjust the brightness and contrast controls until an image
appears and the screen is easy to read. (Some models do not
have control buttons to manually adjust the contrast. In these
cases, just the brightness controls appear.)

Nothing happened when you pressed the Power On key.
Make sure the power adapter is firmly connected to both
the computer and a power source. If the power adapter is
plugged into a power strip, make sure the power strip is
plugged in and turned on. Then try pressing the Power On
key again.
If you still get no results, press the power button on the back
of the computer.

Contrast
Brightness

Power button

If neither the Power On key nor the power button turns the
computer on, the service and support information in the
reference section of this book explains how to get help.
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n

You see a blinking question mark icon on the screen.

What to do next
n

n

This icon means that you need to install system software on
the computer’s hard disk. System software includes the
programs the computer uses to start itself up. You received a
set of system software disks in the box with your computer.
For instructions, see the chapter on installing system software
in the reference section of this book.
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n

If you have never used a Macintosh computer before,
continue with the next section, “Learning the Basics.”
If you have never used a PowerBook computer before,
continue with the section “Turning the PowerBook On and
Off.” This section contains information about power states
that can help you use your computer efficiently.
If you are an experienced PowerBook user, you are ready to
start your own work.

Learning the basics

Before you begin

The PowerBook comes with a tour and a tutorial to help you start
using your computer as quickly as possible.

Make sure your computer is turned on. If the screen is dark, try
the following steps in order until you see the Macintosh desktop
on your screen.

n

n

The Macintosh Basics tour teaches the most basic skills you
need to master before you can use your computer.
The tutorial section of this book (Chapters 2–4) reviews the
basic skills taught in the tour, and teaches a few additional
skills you’ll find helpful as you become more proficient.

Take the Macintosh Basics tour first.

1. Adjust the screen brightness and contrast controls.
If you see the Macintosh desktop, skip to “Starting the Tour.”
2. Press any key on the keyboard (except Caps Lock).
Pressing a key wakes the computer if it was in sleep (a powerconserving state described later in this chapter). If you see the
Macintosh desktop, skip to “Starting the Tour.”
3. Press the Power On key above the keyboard.
Pressing the Power On key turns the computer on if it was off.
Continue with “Starting the Tour.”
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Starting the tour
1. Roll the trackball to move the arrow pointer around on
the screen.
Place the index finger of your dominant hand on the trackball
and the thumb of the same hand on the lower trackball
button. Don’t press either button yet.
Watch the arrow on the screen while you roll the trackball,
and notice that the arrow moves in the same direction that
you roll the trackball.
You may need to roll the trackball around for a few seconds to
“break in” the mechanism so it works smoothly.
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2. Roll the trackball to move the arrow over the picture
labeled “Macintosh HD.”
v Different name? The picture on your screen may be labeled
“PowerBook HD” instead of “Macintosh HD.” The different
name is not important; you can still follow directions in this
manual by replacing references to “Macintosh HD” with
“PowerBook HD.” v
Make sure the tip of the arrow is over the picture, not over
the words “Macintosh HD.”

3. Being careful not to roll the trackball, press the
trackball button twice in quick succession.
Now your screen should look like the picture following
step 4. If it doesn’t, try steps 2 and 3 again, paying special
attention to the following:
n

n

n

Make sure the tip of the arrow is touching the picture, not
the words beneath it.
Be sure to press the trackball button twice.
Try pressing twice more quickly and be careful not to roll
the trackball while you press.
continues .
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4. Roll the trackball to move the arrow over the picture of
the folder labeled “Macintosh Basics.”
Make sure the tip of the arrow is over the picture, not over
the words “Macintosh Basics.”

5. Being careful not to roll the trackball, press the
trackball button twice in quick succession.
Now your screen should look like the following illustration:

The items in the illustration below may not exactly match
those on your screen. The only item you need right now is the
Macintosh Basics folder.

6. Roll the trackball to move the arrow over the picture of
the man labeled “Macintosh Basics.”
Make sure the tip of the arrow is over the picture of the man,
not over the words “Macintosh Basics.”
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7. Press the trackball button twice in quick succession.
Now your screen should look like the following picture:

8. Follow the instructions on the screen and work through
the tour.
When you finish the tour, continue with “Turning the PowerBook
On and Off ” and read the rest of this chapter for information that
can help you use your computer safely and efficiently. Then turn
to Chapter 2 and begin the tutorial.

If you don’t see this screen, try again, paying special attention
to the following:
n

n

n

Make sure the tip of the arrow is touching the picture, not
the words beneath it.
Be sure to press the trackball button twice.
Try pressing twice more quickly and be careful not to roll
the trackball while you press.
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Turning the PowerBook on and off

To turn the PowerBook off

Your PowerBook can be in one of three power states: off, sleep, or
on.

n

If the computer is on, choose the Shut Down command from
the Special menu. (The Macintosh Basics tour teaches how to
choose a menu command.)

Off
When the PowerBook is off, the computer is not using any power
or doing any work. The terms shut down and off both refer to this
state.
Turn the computer off to
n

insert it into a PowerBook Duo Dock or Duo Dock II

n

connect it to a desktop Macintosh as a SCSI disk

n

conserve power when you won’t be using it for several hours
n

n

12 Chapter 1: Setting Up Your PowerBook Duo

If the computer is in sleep, wake it by pressing any key on the
keyboard (except Caps Lock), and then choose Shut Down.
If a problem with the computer prevents you from choosing
Shut Down, press the power button on the back panel of the
computer. This turns off the power; it is not a graceful exit,
because you will lose any work you did not save. Use the
power button only in an emergency.

Sleep
When the PowerBook is in sleep, it draws enough power
to maintain the information in its memory (including any open
programs and documents). The computer is on, but almost
completely inactive.
Put the computer to sleep to
n

connect it to a PowerBook Duo MiniDock or a PowerBook
Duo Floppy Adapter

n

change the battery

n

conserve power during your work breaks

n

To put the PowerBook to sleep
n

If the computer is on, choose the Sleep command from the
Special menu.

You can also put the computer to sleep by closing the display.

Automatic sleep
If you don’t use the computer for several minutes, it goes to sleep
automatically. This conserves battery power. You will notice that if
you spend several minutes reading without using the computer,
or if you take a break, the screen may be dark when you’re ready
to resume working.
To wake the computer, press any key on the keyboard (except
Caps Lock). The desktop reappears looking just the way it did
before the computer went to sleep.
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On

n

When the PowerBook is on, you can do your work.

To turn the PowerBook Duo on
n

If the computer is off, press the Power On key.

In an emergency, you can turn the computer on by pressing
the power button on the back panel. Don’t use the power
button routinely. If the computer is in sleep rather than off,
pressing the power button will turn the computer off, and you
will lose any work you did not save.

On/off summary
If the
power
state is

And you want it to be
Off

Sleep

On

Off

—

—

Press Power On key
(or power button*)

Sleep

Press any key†
to wake, and then
choose Shut Down

—

Press any key†
(pressing the Power
On key also works)

On

Choose Shut Down
(or press power
button*)

Choose Sleep

—

Power On key

n

If the computer is in sleep, press any key on the keyboard
(except Caps Lock). You can also press the Power On key to
wake the computer.

* Use the power button only in an emergency.
† Except Caps Lock.

See the chapter on power management for more information
about managing your computer’s power consumption.
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When you turn on your computer
When you turn on your PowerBook, the computer looks on the
hard disk inside the computer for the system software it uses to
start itself up. (A disk that contains the system software is called
a startup disk.) When the computer finds the system software, it
displays the icon shown and proceeds to start itself up.

Menu bar
Startup disk
icon

Trash icon

When the startup process is complete, the Macintosh desktop
appears on the screen. The desktop is a gray pattern with
n

n

n

a menu bar across the top (containing the names and icons
of menus)

When you “wake” your computer from sleep, it does not go
through the startup process because it is already on (at a
reduced power level). The Macintosh desktop reappears on the
screen immediately, looking just the way it did before the
computer went to sleep.

an icon near the upper-right corner representing the startup
disk
an icon near the lower-right corner representing the Trash
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Restarting a computer that’s already on
You need to restart your computer—turn it off and back on again
immediately—when you want to make certain changes to your
control panels, use a newly installed system software file, or start
up the computer from a different disk.
n

To restart your computer, choose Restart from the Special
menu.

You also need to restart if you see a “system error” message on
the screen (indicating a temporary software problem). In this
case, use the trackball to click the Restart button that appears.

Restarting a computer that can’t be
turned on normally
If your system crashes (a rare event resulting from temporary
software problems), or if a computer with a properly installed and
charged battery does not respond when you try to turn it on, you
should be able to restart it using one of the methods described in
this section. Try them in the order given.
n

Press the x (Command), Control, and Power On keys at
the same time.
When pressed at the same time, these keys turn the computer
off and back on. This key combination produces the same
result as pressing the reset switch on other Macintosh models.
The PowerBook Duo does not have a reset switch.

When you choose Restart, the computer prompts you to save
your work, closes all open programs, and restarts itself.
Choosing Restart does not affect your RAM disk (if you
created one) or its contents.
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Restarting the computer this way does not affect your RAM
disk (if you created one) or its contents.

n

Press the power button, wait a second, and then press it
again.
This procedure also has the effect of turning the computer off
and back on. Turning the computer off with the power button
removes a RAM disk and its contents.

n

If you have a floppy disk drive, restart from a floppy
disk.
1. Insert the Disk Tools disk into the floppy disk drive.
2. Press the Power On key.
If the computer turns on, there is probably a problem with
your hard disk. You may be able to fix the problem yourself
(using the Disk First Aid program or another disk repair
program; see the chapter on disks in the reference section).
Or you may prefer to take the computer to your Appleauthorized service provider.

n

If you have a Duo MiniDock and an Apple HDI-30 SCSI
Disk Adapter cable, connect your PowerBook Duo to a
desktop Macintosh and start it up as a SCSI disk.
Your PowerBook Duo can be connected to a desktop
Macintosh and used as an external SCSI disk drive. This
feature allows you to reinstall system software on the
PowerBook’s internal hard disk drive.
The procedure has two parts. First you need to connect your
computer to a desktop Macintosh. Then you need to reinstall
system software on your computer’s hard disk. Chapters 13
and 5, respectively, contain specific instructions.
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Important care and safety instructions

m Always handle batteries carefully.

For your own safety and that of your equipment, read and follow
all the instructions in this section. Keep these instructions
available for reference by you and others.

m Do not drop, puncture, disassemble, mutilate, or incinerate
the battery.

± Warning

m Transport batteries either inside the computer or in the
protective case provided with each battery. Do not transport
unprotected batteries.

m Electrical equipment may be hazardous if misused. Operation
of this product, or similar products, must always be
supervised by an adult. Do not allow children access to the
interior of any electrical product and do not permit them to
handle any cables.
m Do not use the computer in or near water.
m Do not use cables that are frayed or otherwise damaged. Hold
a cable by its connector (the plug, not the cord) when
connecting or disconnecting it.
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m Recharge batteries only as described in this manual and only
in ventilated areas.

m Do not short-circuit the battery terminals (that is, do not
allow a metal object such as a paper clip or key chain to touch
the terminals). Doing so may cause an explosion or a fire.

s Caution
m If you have a problem with your computer and nothing
presented in the manuals that came with the computer solves
the problem, take the computer to your Apple-authorized
dealer or service provider. Attempting to repair the computer
yourself may void the Limited Warranty. Contact your Appleauthorized dealer or service provider for additional
information about this or any other warranty question.
m Do not attempt to open the computer’s case. There are no
user-serviceable parts inside. Take the computer to an Appleauthorized service provider if necessary.
m Do not drop or jar the computer.

m Do not move the computer when you can hear its hard disk
spinning. When you put the computer to sleep, wait until the
screen is blank before moving the computer.
m Use only the power adapter supplied with your computer.
Adapters designed for other electronic devices may look
similar, but they may not work with your equipment and may
damage the computer.
m Your power adapter has a detachable power cord. To
disconnect power to the adapter, unplug the power cord from
the adapter.
m Never force a connector into a port. Make sure that the
connector matches the port and that it’s right side up. If the
connector and port do not join easily, they do not match.

Chapter 1: Setting Up Your PowerBook Duo 19

m Do not use the computer in wet or dusty environments.

S Important

m Keep dirt and liquids away from the ports on the back panel,
the keyboard, and the trackball. If you spill any food or liquid
onto the computer, shut it down immediately and unplug it
before cleaning up the spill. Depending on what you spilled
and how much got into the computer, you may have to bring
the computer to an Apple-authorized service provider for
cleaning.

m If the computer has been in a cold place for several hours, let
it warm up to room temperature before you use it.

m Do not touch the screen with any sharp or pointed objects.
m Use only the battery supplied with your computer. Batteries
designed for other portable computers may look similar, but
they may not work with your computer and may damage it.
m When recharging the battery, use only the power adapter
supplied with your computer. Adapters designed for other
electronic devices may not work with your equipment and
may damage the computer or the recharger.
m Do not leave batteries in hot locations (such as the trunk
of a car).
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m Use the computer only in environments where the
temperature range is between 50° F/10° C and 104° F/40° C.
m Do not expose the computer to very low (less than
–13° F/–25° C) or very high (more than 140° F/60° C)
temperatures.
m If necessary, clean the outside surfaces of your computer
equipment with a damp (not wet) cloth or paper towel.
m Clean the screen with soft, lint-free paper or cloth and a mild
glass cleaner. Do not spray the glass cleaner (or any other
liquid) directly onto the screen.

Health-related information about
computer use
Muscle soreness, eye fatigue, and other discomforts and injuries
sometimes associated with using computers can occur from
performing any number of activities. In fact, misuse of the same
muscles during multiple activities can create a problem that might
not otherwise exist. For example, if you engage in nonwork
activities that involve repetitive stress on the wrist—such as
bicycling—and also use your computer’s keyboard improperly,
you may increase your likelihood of developing wrist problems.
Some individuals are at greater risk of developing these problems
because of their health, physiology, lifestyle, and general exposure
to stress. Work organization and conditions, such as workstation
setup and lighting, also play a part in your overall health and
comfort. Preventing health problems is a multifaceted task that
requires careful attention to the way you use your body every
hour of every day.
The most common health effects associated with using a
computer are musculoskeletal discomfort and eye fatigue. We’ll
discuss each area of concern below. For information about electric
and magnetic emissions, look in the reference material that comes
with your computer.

Musculoskeletal discomfort
As with any activity that involves sitting for long periods of time,
using a computer can make your muscles sore and stiff. To
minimize these effects, set up your work environment carefully,
using the guidelines that follow, and take frequent breaks to rest
tired muscles. To make working with your computer more
comfortable, allow enough space in your work area so that you
can change position frequently and maintain a relaxed posture.
Another type of musculoskeletal concern is repetitive stress
injuries (RSIs), also known as cumulative trauma disorders
(CTDs). These problems can occur when a certain muscle or
tendon is repeatedly overused and forced into an unnatural
position. The exact causes of RSIs are not totally understood, but
in addition to awkward posture, such factors as the amount of
repetition, the force used in the activity, the individual’s
physiology, workplace stress level, and lifestyle may affect the
likelihood of experiencing an RSI.
RSIs did not suddenly arise when computers were invented;
tennis elbow and writer’s cramp, for example, are two RSIs that
have been with us for a long time. Although less common than
other RSIs, one serious RSI discussed more often today is a wrist
problem called carpal tunnel syndrome, which may be aggravated
by improper use of computer keyboards. This nerve disorder
results from excessive pressure on the median nerve as it passes
through the wrist to the hand.
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This section offers advice on setting up your work area to
enhance your comfort while you use your computer. Since the
effects of repetitive movements associated with using a computer
can be compounded by those of other work and leisure activities
to produce or aggravate physical problems, proper use of your
computer system must be considered as just one element of a
healthy lifestyle.
No one, of course, can guarantee that you won’t have problems
even when you follow the most expert advice on using computer
equipment. You should always check with a qualified health
specialist if muscle, joint, or eye problems occur.

Eye fatigue
Eye fatigue can occur whenever the eyes are focused on a nearby
object for a long time. This problem occurs because the eye
muscles must work harder to view an object that’s closer that
about 20 feet (6 meters). Improper lighting can hasten the
development of eye fatigue. Although eye fatigue is annoying,
there’s no evidence that it leads to permanent damage.
Whenever you’re engaged in an activity that involves close-up
work—such as reading a magazine, doing craft work, or using a
computer—be sure to have sufficient glare-free lighting and give
your eyes frequent rest breaks by looking up and focusing on
distant objects. Remember to have your eyes examined regularly.
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To prevent discomfort and eye fatigue:
n

n

Arrange your work space so that the furniture is properly
adjusted for you and doesn’t contribute to an awkward
working posture.
Take frequent short breaks to give your muscles and eyes a
chance to rest.

Arranging your work area and equipment
The suggestions in this section can help you work more
comfortably with your computer.

Chair
n

An adjustable chair that provides firm, comfortable support is
best. Adjust the height of the chair so your thighs are
horizontal and your feet flat on the floor.
The back of the chair should support your lower back (lumbar
region). Follow the manufacturer’s instructions for adjusting
the backrest to fit your body properly.

Keyboard and trackball
n

n

When you use the keyboard and trackball, your shoulders
should be relaxed. Your upper arm and forearm should form
an approximate right angle, with your wrist and hand in
roughly a straight line.

Use a light touch when typing or using the trackball and keep
your hands and fingers relaxed. When using the trackball,
avoid rolling your thumbs under your palms.

This

This

n

Some computer users may develop discomfort in their hands,
wrists, or arms after intensive work without breaks. If you
begin to develop chronic pain or discomfort in your hands,
wrists, or arms, consult a qualified health specialist.

Not this

You may have to raise your chair so your forearms and hands
are at the proper angle to the keyboard. If this makes it
impossible to rest your feet flat on the floor, you can use a
footrest with adjustable height and tilt to make up for any gap
between the floor and your feet. Or you may lower the
desktop to eliminate the need for a footrest. Another option is
to use a desk with a keyboard tray that’s lower than the
regular work surface.

Not this

n

Change hand positions often to avoid fatigue.
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n

If you prefer, you can adjust the angle of the keyboard by
rotating the elevation feet at both ends of the back panel until
they snap into position.

Built-in display
n

n

Adjust the angle of the display to minimize glare and
reflections from overhead lights and windows.
If your display screen has manual brightness and contrast
controls, you may need to adjust the brightness and contrast
of the screen when you take the computer from one work
location to another, or if the lighting in your work area
changes.

Contrast

The back of the keyboard is slightly elevated when the feet are
in use. Otherwise, the keyboard is level.

Mouse
n

If you use a mouse, position the mouse at the same height as
your keyboard. Allow adequate space to use the mouse
comfortably.
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Brightness

External monitor

Avoiding fatigue

If you use an external monitor, this suggestion may be helpful.

n

n

If possible, arrange the monitor so the top of the screen is
slightly below your eye level when you’re sitting at the
keyboard. The best distance from your eyes to the screen is
up to you, although most people seem to prefer 18 to 28
inches (45 to 70 cm).

n

n

n

Change your seated position, stand up, or stretch whenever
you start to feel tired. Frequent short breaks are helpful in
reducing fatigue.
Allow adequate workspace so that you can work comfortably.
Place papers or other items so you can view them easily while
using your computer. A document stand may make reading
papers more comfortable.
Eye muscles must work harder to focus on nearby objects.
Occasionally focus your eyes on a distant object, and blink
often while you work.
Clean your screen regularly. Keeping the screen clean helps
reduce unwanted reflections.
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Chapter 2

Working on the Desktop
In this chapter

Before you begin
You should have already
n

Review basic trackball skills:
n
n

Moving the pointer

n

Choosing a command

n

Opening an icon

n

Looking at the contents of a window

set up your computer according to the instructions in
Chapter 1
gone through the Macintosh Basics tour supplied with your
computer

Make sure your computer is on.

And learn:
n

How to close a window

n

How to move a window

n

What the icons on your desktop represent

27

Use the trackball

Point

Your computer has a two-button trackball. You use the ball itself to
control the movements of a pointer on the screen. The pointer
you’ll see most often is an arrow (8).

You point to an object on the screen by rolling the trackball so the
pointer is positioned over that object. When the pointer is an
arrow, the tip of the arrow must be exactly over the object.

You use the buttons to initiate actions that you want the computer
to perform. Both trackball buttons do the same thing. You can
always use whichever one you prefer.

Practice pointing to different objects on the Macintosh desktop,
such as the startup hard disk icon near the upper-right corner, the
Trash icon near the lower-right corner, and the Help menu icon
near the right end of the menu bar.

Much of the work you do on the PowerBook uses four trackball
actions: pointing, clicking, pressing, and dragging.
(If you want to return to the Macintosh Basics tour for more
practice with the trackball, see Chapter 1 for instructions.)
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Click
You click an object on the screen by pressing and quickly releasing
a trackball button while the pointer is over that object.

Practice clicking different objects on the Macintosh desktop, such
as the startup hard disk icon near the upper-right corner and the
Trash icon near the lower-right corner.

When you click an icon, it becomes highlighted (the icon is
darkened). A highlighted icon is said to be selected. A selected
icon is the object of whatever action you choose next.
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Press
You press by holding down a trackball button without moving the
trackball.
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Practice pressing the menu names and icons in the menu bar—
start with the Apple (K) menu icon at the left side, through the
menu names, and across to the Help and Application menu icons
at the right side. Pressing a menu name or icon “pulls down” the
menu. Read the items in each menu you pull down.

Drag
You drag an object on the screen by pointing to that object and
holding down a trackball button while you roll the trackball.

Practice dragging the startup hard disk icon and the Trash icon
around the Macintosh desktop. When you drag an icon, an outline
of the icon follows the pointer on the screen. When you release
the trackball button, the icon itself moves.

When you’re finished practicing, drag the icons back to their
original positions. Then click once in the middle of the desktop.
(Clicking anywhere outside a selected icon returns that icon to its
original “unselected” state.)
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Choose a command
Choosing a command involves using a combination of the
trackball actions you’ve reviewed.
1. Point to the Special menu title in the menu bar.

Giving orders to your computer
Telling the PowerBook to do something involves two steps:
1. selecting an object on the screen, and

2. Press to pull down the Special menu.

2. choosing the action you want to perform on that
object.

3. Drag to the first item in the menu (the Clean Up
Desktop command) so it becomes highlighted,
and then release the trackball button.

When you select an object, you’re telling the PowerBook
to act upon that object.
The objects you can select include an icon on the Macintosh
desktop, a sentence in a word-processing program, and a
picture in a graphics program—to give just three examples.
Most of the actions you can perform on the selected object
are listed in the menus at the top of the screen. The items, or
actions, in the menus are called commands. When you
choose a command, you are telling the computer to take
the action you’ve chosen on the selected object.
So—you tell your PowerBook what to do by using a very
simple “language” with only two kinds of words:

When you choose Clean Up Desktop, the hard disk icon and the
Trash return to their original positions (as long as they’re already
close).

n

nouns (the objects), and

n

verbs (the actions)

and with only one rule:
n
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First the noun, then the verb (to this object, do that
action). In Macintosh terms: select an object, then choose
a command.

Open an icon
Opening an icon is your first exercise in telling the computer
what you want it to do.
1. Click the startup hard disk icon to select it.
The icon is in the upper-right corner of the screen.
Unless someone has changed its name, the icon is called
“Macintosh HD” (or “PowerBook HD”). Make sure that the
icon is highlighted (darkened), which means that it’s selected.

When you choose the Open command, the selected icon
opens into a window (in this case, the Macintosh HD
window). The icon becomes filled in with a pattern
of dots, indicating that it has been opened.

2. Point to the File menu title in the menu bar.
3. Press to pull down the File menu.
4. Drag to the Open command (the second item in the
File menu) so it becomes highlighted, and then release
the trackball button.
v Different icons? The Macintosh HD window on your screen
may contain items not shown above. The differences are not
important; you can still do the exercises in this chapter and
the next. v
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Look at the contents of a window
Every window has several features that help you view the
window’s contents. But before you can work with the contents of
a window, you need to make that window the active window.

1. Click the Trash icon near the lower-right corner of the
screen to select it.
Make sure that the icon is highlighted, which means that
it’s selected to be the object you’ll act upon next.

Make a window the active window
You can have several windows open on your screen at one
time, but only one window can be the active window. An active
window is one in which you can select objects and choose actions
to perform on those objects.
The Macintosh HD window is currently on your Macintosh
desktop. (The window appeared when you opened the Macintosh
HD icon.) You’re going to open another window now.
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2. Point to the File menu title in the menu bar.
3. Press to pull down the File menu.

4. Drag to the Open command so it becomes highlighted,
and then release the trackball button.

When you choose the Open command, the Trash icon opens
into a window (the Trash window). The Trash icon becomes
filled in with a pattern of dots, indicating that it has been
opened.

Active window

You should now have two windows on your Macintosh
desktop: the Macintosh HD window and the Trash window.
The Trash window is the active window. An active window has
a series of solid lines at the top of the window.
continues .
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5. Click anywhere in the Macintosh HD window to make
it the active window.
Notice that the solid lines now appear at the top of the
Macintosh HD window. (The area containing the window title
and the solid lines is called the title bar.) When windows
overlap, the active window is the one that’s on top.
Active window

Make a window larger or smaller
Sometimes you want to make a window larger, so you can see
more of its contents, or smaller, so it takes up less space on your
screen. You can change a window’s size by dragging its size box
or by clicking its zoom box.
1. Point to the size box in the lower-right corner of the
(active) Macintosh HD window.

Size box
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2. Drag the size box in any direction, and then release the
trackball button.

3. Click the zoom box near the right end of the title bar.
Zoom box

While you drag, an outline follows the pointer to indicate the
window’s new size. The new size takes effect when you
release the trackball button.

The window “zooms” to a size that shows all the items in
the window.
4. Click the zoom box again.
The window zooms back to its previous size (the size that you
chose in step 2).
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Move the hidden contents of a window into view

2. Point to the File menu title in the menu bar.

As you work with your computer, you’ll encounter windows
containing more than you can view on the screen at one time. You
can view contents that are out of sight, as described in the
following steps.

3. Press to pull down the File menu.

1. Check that the Macintosh HD window is active, then
click the System Folder to select it.

4. Drag to the Open command so it becomes highlighted,
and then release the trackball button.
When you choose the Open command, the System Folder
icon opens into a window (the System Folder window).
You should now have three windows on your Macintosh
desktop: the Macintosh HD window, the Trash window, and
the System Folder window. (One or more of these windows
may be covered by the others.) The System Folder window is
the active window because you opened the System Folder
most recently.
5. Point to the size box in the lower-right corner of the
System Folder window.

Make sure that the icon is highlighted, which means that
it’s selected.
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6. Drag the size box diagonally (up and to the left) to
make the window about half its current size, and then
release the trackball button.

7. Press the scroll arrow at the right end of the horizontal
scroll bar.

Scroll arrow

The contents of the window scroll past, bringing into view the
icons that were out of sight on the right.
Vertical
scroll bar

8. Press the scroll arrow at the left end of the horizontal
scroll bar.
The contents of the window scroll past, bringing back into
view the icons that were out of sight on the left.

Horizontal scroll bar
continues .

The bars across the bottom and along the right side of the
System Folder window should now be gray, indicating that the
window has contents that are not currently visible. The gray
bars are called scroll bars.

Chapter 2: Working on the Desktop 39

9. Drag the scroll box toward the middle of the horizontal
scroll bar, and then release the trackball button.

Close a window
When you no longer need to see the contents of a window,
you can close it by clicking the close box.

Scroll box

1. In the (active) System Folder window, point to the close
box near the left end of the title bar.
Close box

Now you see the icons near the middle of the window.
The vertical scroll bar, scroll box, and scroll arrows work the same
way. Try them.

2. Click the close box.
The window closes, and the System Folder icon no longer has
a pattern of dots in it.
There are now two windows on the desktop: the Macintosh
HD window and the Trash window. (One may be hidden by
the other.)
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Move a window
You can move a window anywhere on the screen by dragging its
title bar. By changing the position and size of windows, you can
arrange your Macintosh desktop in whatever way is best for you.

Notice how the Macintosh HD window, because it is the active
window, stays on top of the Trash window if and when the two
windows overlap.

1. Point to the title bar of the (active) Macintosh HD
window.
Position the pointer anywhere on the title bar except over the
close box or the zoom box.
Title bar

3. Close the Macintosh HD window by clicking the close
box near the left end of the window’s title bar.
If you can’t see the close box, drag the window until you can.

2. Drag in any direction, and then release the trackball
button.
When you drag, an outline of the window follows the pointer
on the screen. When you release the trackball button, the
window moves to the position you’ve chosen.
continues .
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The window closes, and the Macintosh HD icon reappears in
its previous form.
The Trash window (the remaining window on the Macintosh
desktop) becomes the active window.
4. Close the Trash window by choosing Close Window
from the File menu.

What’s on the desktop?
Just as a desk’s large flat surface is its work space, the Macintosh
“desktop” is the work space on your computer. The desktop
metaphor gives you a familiar way of thinking about how to use
the PowerBook.
Aside from the field of gray that represents the “surface” of your
work space, the Macintosh desktop has icons, windows, and
menus.
n

Icons represent containers.

n

Windows let you view what’s inside the containers.

n

You choose Close Window by pointing to the File menu
title, pressing to pull down the menu, dragging to the Close
Window command, and, with the command highlighted,
releasing the trackball button.
Of course, you can also close the window by clicking its
close box.
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Menus list actions that you can apply to selected containers
or their contents.

Icons represent containers
Icons can contain other icons, or they can contain information.
For example, the startup hard disk icon contains the System
Folder icon. The System Folder icon contains the programs (also
represented by icons) that in turn contain the information the
PowerBook needs to start itself up and work properly.

Different types of icons represent different types of containers.
Hard disks and floppy disks are like filing cabinets. You use disks
to store files—your programs and the documents you create
with them.

Folders are like folders in a file drawer. You use folders to
organize your files.

Programs are files containing instructions to the computer that
let you do certain types of work.
Shared disks are like filing cabinets containing office supplies or
information that you share with others in your work group. Your
PowerBook needs to be connected to a network before you can
use shared disks.
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Documents are files containing words, pictures, numbers,
sounds—whatever you create with your programs.

Windows let you see what’s inside containers
Windows let you see what’s inside all these containers.
When you open a disk icon, the window that appears shows you
what’s on the disk. When you open the document icon
representing a memo, the window that appears shows you
the memo.
Changing the size of a window or viewing its contents does
not change the contents. The contents remain the same; only
your view changes.

Menus offer you choices
The Trash is a container for files that you no longer want.
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Like the menus in a restaurant, Macintosh menus let you
choose. You choose among different actions that the computer
can perform on containers (icons), or on their contents (such as
words in a memo).

Using the keyboard

Arrow keys

You use the keyboard to type text and numbers, just as you
would on a typewriter. (For touch typists, your keyboard has
raised dots in the middle of the D key and the K key to help
position your fingers on the home row.)

All Macintosh keyboards have four arrow keys: Up Arrow, Down
Arrow, Left Arrow, and Right Arrow.
Many programs let you use the arrow keys as well as the
trackball to move the pointer on the screen.

Depending on the program you’re using, you can use special
keys on the keyboard to give commands to the computer and to
modify certain things that you do with the trackball. PowerBook
computer keyboards have two types of special keys: modifier
keys and arrow keys.
shift

Modifier keys

ctrl

shift
option

All Macintosh keyboards have four modifier keys: Shift,
x (Command), Option, and Control.
Pressed by itself, a modifier key does nothing. You need to press
it in combination with another key (or while using the trackball).
The modifier key causes the other key or trackball to give a
different (“modified”) result.

Modifier keys

Arrow keys

You type a capital letter, for example, by pressing the Shift key
with a letter key. Most programs let you choose commands by
pressing the x key with certain letter keys.
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Chapter 3

Creating and Changing
a Document
In this chapter

n

What “keyboard shortcuts” are and how to use them

n

How to quit a program

n

How to make a copy of a document

n

How to change the name of a document

n

How to use the Trash

n

How to open a program

n

How to use a program to create a document

Before you begin

n

Why it’s important to save your work, and how to save it

Make sure that your computer is on.

n

How to switch between programs

n

How programs and system software differ from each other

n

How to close a document

n

How to open a document

n

How to change a document
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Open a program
Your computer comes with a simple word-processing program
called TeachText. You’re going to use this program to create a
document.
1. Open the Macintosh HD (or PowerBook HD) icon.
(Click the icon to select it, and then choose Open from the
File menu.)
The Macintosh HD window appears, showing you the
contents of your hard disk. The contents include the
TeachText program.

When you open the TeachText program, there is one dramatic
change on your desktop:
n

A window called “Untitled” appears.

There are also two subtle changes:
n

n

The menu bar shows the menu names for the TeachText
program.
The Application menu icon in the right corner of the menu
bar becomes the TeachText icon.
TeachText menus

TeachText icon

2. Open the TeachText icon.
If you can’t find the TeachText icon, use the scroll bars to bring
it into view.

To open the icon, click the icon to select it, and then choose
Open from the File menu.
The untitled window is empty because you haven’t put anything
in it. In the next few sections, you’re going to write a short
document, save it, and give it a name.
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Create a document

Save your work

The untitled window is like a blank sheet of paper. In the
upper-left corner of the empty document is a blinking vertical
line (9). This line is called the insertion point, because it marks
the place where the text you type will be inserted.

Work that you do in a program exists only in the computer’s
memory until you save it onto a disk. Since work that exists only
in memory is lost when you shut down the computer, you need
to save your work so you can come back to it later. If you don’t
save your work, it disappears—like thoughts that are lost unless
you write them down.

As you type, use your computer keyboard as you would a
typewriter keyboard, except:
n

n

If you make a mistake, press the Delete key to backspace
over it.

1. Choose Save from the File menu.

Don’t press the Return key when you get to the end of a line.
Keep typing, and words will move to the next line
automatically.

Type the following text:
All people are born free and equal.
Endowed with reason and conscience, they
should act towards each other in a spirit
of togetherness.

You will be changing this text later in this chapter.
The box that appears (called a dialog box) lets you name the
document and save it on your hard disk.
continues .
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2. Type “Opening Lines”.

Switch programs
You can have several programs open on your Macintosh desktop
at one time (how many depends on how much memory your
computer has and how much memory the programs use). But
only one program at a time can be the active program. The active
program is the one that’s “on top of ” other open programs—in
the same way that the active window is on top of other windows.
The Opening Lines window is now the active window, and
TeachText is the active program. But TeachText is not the only
program that’s open.

Because the word “Untitled” is selected (highlighted) when
the dialog box appears, all you have to do to name your
document is start typing. Whatever you type replaces the
selected text.
3. Click Save.

Since you turned on your computer, you’ve been working with
the Finder program. The Finder displays the Macintosh desktop.
The Finder is always open when your PowerBook is on, so right
now it is open but not active.
1. If the Opening Lines window covers most of your
screen, make the window smaller by dragging its size
box up and to the left, and then release the trackball
button.
After you resize the window, you should be able to see your
hard disk icon in the upper-right corner of the desktop.

The window is now titled “Opening Lines” and the document
has been stored on your hard disk.
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2. Make the Finder the active program by clicking the
Macintosh HD icon, or clicking anywhere on the
desktop outside the Opening Lines window.
The Finder becomes the active program. Notice:
n

n

n

The Macintosh HD window appears on top of the
Opening Lines window.
The menu bar shows the Finder’s menu titles.
The Application menu icon at the right end of the
menu bar becomes the Finder icon.

3. Make the Opening Lines window active by clicking
anywhere inside it.
(Part of the window may be hidden by the Macintosh HD
window.)
When you click, the Opening Lines window comes back to the
top. It’s now the active window again, and TeachText is the
active program.
You make a window active by clicking any visible part of it.
The program that “owns” the window becomes active when
the window becomes active.
Here is another way to make a program active:
4. Make the Finder the active program by choosing Finder
from the Application menu at the right end of the
menu bar.

You may also notice the Opening Lines icon in the
Macintosh HD window, representing the document you
just created and saved.

continues .
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You choose Finder by pointing to the Application menu icon,
pressing to pull down the menu, dragging to highlight the
name Finder, and then releasing the trackball button.
The Finder becomes the active program, and the
Macintosh HD window becomes the active window.
5. Make TeachText the active program by choosing
TeachText from the Application menu.

Close a document
When you close a document, you do not close the program that
you used to create it. (Closing a program is called quitting.) The
program remains open and active until you quit the program or
make another program active.
1. If the Opening Lines window is not the active window,
click anywhere inside it to make it active.
2. Close the Opening Lines window.
You can either click the close box near the left end of the title
bar, or choose Close from the File menu.
The Opening Lines window closes but TeachText is still the active
program. Notice:
n

n

TeachText becomes the active program, and the Opening
Lines window becomes the active window.
All open programs are listed in the Application menu. You can
use the Application menu to choose which program to make
active. The icon in the menu bar is always the icon of the
currently active program.
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The menu bar still shows the TeachText menu titles.
The Application menu icon at the right end of the menu bar
is still the TeachText icon.

Two types of programs
Programs that you use to do your work on the computer are
called application programs, or applications, because they’re
ways of applying computer technology to the work that you do.
Word-processing programs, for example, are applications that
enable you to write memos, novels, or whatever you need to
write. And if your work involves creating illustrations,
designing buildings, composing music, or keeping track of
large amounts of data, there are application programs for
those kinds of work, too.
Because most Macintosh programs work in similar ways,
you can transfer much of what you learn in one application to
other applications.
Programs that the computer uses to do its work (in contrast to
your work) are called system software, or sometimes the
operating system.

Open a document
When you open a document, the program you used to create that
document becomes the active program.
1. If you closed the Macintosh HD window, open the
Macintosh HD icon now.
(Click the icon to select it, and then choose Open from the
File menu.)
The Macintosh HD window appears, showing you the
contents of your hard disk. The contents include the
TeachText program and the TeachText document you created
called Opening Lines.
The next step describes a different way to open an icon.
continues .

Between you and the system software is a program called the
Finder, which displays the Macintosh desktop. It’s called the
Finder because, like the view finder in a camera, it gives you a
view of all the objects— disks, programs, folders, and
documents—on your desktop.
You use the Finder to tell the system software what you want it
to do for you: which disks you want to use, which documents
and programs you want to open, and where you want files to be
stored.
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2. Open the Opening Lines icon by double-clicking it.

Change a document
The Opening Lines window shows you the text you typed. In this
section you’ll make some changes to the text using techniques
that work in most Macintosh programs.
Keep two things in mind:
n

To double-click an icon, you click it twice in rapid succession
without moving the pointer. (Use the trackball to position the
pointer over the icon, and then click one of the trackball
buttons twice.) Double-clicking an icon has the same effect as
selecting the icon and then choosing the Open command.
When you open Opening Lines, TeachText becomes the active
program. Notice that:
n

the Opening Lines window appears

n

the menu bar shows the TeachText menu titles

n

the Application icon at the right end of the menu bar is the
TeachText icon
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n

The insertion point—the blinking vertical line—marks the
place where text will appear.
A pointer called an I-beam (it looks like this: 9) replaces the
arrow pointer (8) when you’re working with text. You control
the I-beam pointer with the trackball in the same way that you
control the arrow pointer.

1. Locate the insertion point. It should be in the upperleft corner of the document.
2. Locate the I-beam pointer (9). If you don’t see it, roll
the trackball slightly. The pointer moves as the
trackball moves.
Now you’re ready to change the text.

3. Move the I-beam pointer to the immediate left of the
word “people” (after “All”).

6. Move the I-beam pointer between the word “equal” and
the period (to the immediate left of the period).

4. Drag horizontally, selecting the word “people”, and
then release the trackball button.

7. Click the trackball button once.
To drag, hold the trackball button down while you roll the
trackball. The selected word is highlighted (surrounded by
black).
If you select more or less than you intended to, go back to
step 3 and try again.

Clicking moves the insertion point to the spot where you
positioned the I-beam. Whatever you type next is inserted
at that point.
8. Press the space bar once, and then type the words “in
dignity and rights”.

5. With “people” selected, type the words “human beings”.
The words you type replace the word you selected. (Press the
Delete key to backspace over any typing errors.)
continues .
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Now you’ll rearrange some text.
9. Move the I-beam pointer to the immediate left of the
word “they” (after “conscience,”).

12. Move the I-beam pointer to the immediate left of the
word “Endowed”.

10. Drag horizontally, selecting the word “they”, and then
release the trackball button.

13. Click to place the insertion point.
14. Choose Paste from the Edit menu.
11. With “they” selected, choose Cut from the Edit menu.
Choosing Cut removes the selected material from the
document and stores it in a temporary file called the
Clipboard.

When you choose Paste, your computer takes whatever’s in
the Clipboard and puts it into the document at the location of
the insertion point.
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15. Press the space bar once, type “are”, and then press the
space bar once again.

Save your work so far
The changes you’ve made so far are not part of Opening Lines
until you save them. You save them by telling the computer to
record them in the Opening Lines document that’s stored on your
hard disk.

16. Move the I-beam pointer between the letters t and h in
the word “they”.

It’s important to remember that no change is “official” until
you save it onto a disk. Your work could be lost if power to
the computer were interrupted or if a problem caused the
computer to stop working properly.
Choose Save from the File menu.
Save regularly, and save often.

17. Click the trackball button to place the insertion point.
18. Press the Delete key once and then type a capital T.
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Taking a shortcut
You can choose some menu commands by using the
keyboard instead of the trackball. A keyboard shortcut is a
combination of keys that you press at the same time to get
the same result as choosing a command from a menu. One of
the keys you press is always the x key or another modifier
key.

Make more changes
The changes you’ve made so far are now part of the document
that’s stored on your hard disk.
1. Move the I-beam pointer (9) between the letters E and
n in the word “Endowed”.

For example, instead of choosing Save from the File menu,
you can hold down the x (Command) key on the keyboard
while you press the S key. Pressing x-S is a keyboard shortcut
equivalent to choosing Save from the File menu.
You can see the available keyboard shortcuts by pressing a
menu title and looking at the commands in the menu. The
keyboard shortcuts are listed next to the commands.
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2. Click once to place the insertion point.
3. Press the Delete key once and then type a lowercase e.
4. Move the I-beam pointer to the immediate right of the
comma after the word “conscience”.

5. Press the Delete key once, press the space bar once,
and then type “and”.

8. Move the I-beam pointer to the immediate right of the
“each other”. Do not drag. Do not click the trackball
button yet.
9. Hold down the Shift key on your keyboard and click to
select the words “each other”.

6. Move the I-beam pointer to the immediate left of “each
other”.
Holding down the Shift key while you click selects the text
between the insertion point and wherever you click.
10. With “each other” selected, type “one another”.
7. Click the trackball button once.
Clicking moves the insertion point to the place where you
positioned the I-beam.
continues .
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11. Select the word “togetherness” by double-clicking it.

Quit a program
Quitting a program closes the program as well as any open
documents that were created using that program. (Simply closing
a document leaves the program open and active.)
1. Make sure that the Opening Lines window is active.

To select a word by double-clicking it, position the I-beam
pointer over the word and then click twice in rapid
succession, without moving the pointer.

2. Quit the TeachText program.
You can either choose Quit from the File menu, or press
the x key and the Q key together.

12. With “togetherness” selected, type “brotherhood”.
You may now have extra spaces or no spaces between words.
If so, position the I-beam pointer where you need to delete or
add a space, click to place the insertion point, and press the
Delete key or the Space bar as necessary.

13. Choose Save from the File menu.

If a message asks whether you want to save any changes, click
Save.
The Opening Lines document and the TeachText program are
closed, and the Finder becomes the active program.
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Opening and closing documents and programs
Doing this

Also causes this

Opening a document

Opens the program that created
that document

Making a document
window active

Makes the program that “owns”
that document active

Closing a document

Simply closes that document; does
not close the program that created
that document (the program continues
to use memory)

Quitting a program

Prompts you to save your work,
then closes the program that created
the active document (memory becomes
available for other programs)

Make a copy of a document
You’ll often want to make a copy of a document so you can
preserve the original and modify the copy. To practice making a
copy of a document, you’ll use the “Opening Lines” document
you created.
1. If you closed the Macintosh HD window, open the
Macintosh HD icon now.
(Click the icon to select it, and then choose Open from the
File menu.)
The Macintosh HD window appears, showing you the
contents of your hard disk. The contents include the
TeachText program and the TeachText document you created
called Opening Lines.
2. Click the Opening Lines icon to select it.

continues .
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3. Choose Duplicate from the File menu.

Change the name of an icon
You can change the name of any icon, using any characters except
a colon (:). If you change an icon’s name and then open it, you’ll
see that the name of its window has also changed.
1. Drag the “Opening Lines copy” icon away from the
original icon so that the two icons do not overlap.
2. Click the name (not the icon) “Opening Lines copy.”
Do this even if the icon is already selected.
When the name is selected, it is highlighted and a box appears
around it. Notice that when you point to the selected name,
the arrow pointer becomes an I-beam.

A new icon, labeled “Opening Lines copy”, appears in the hard
disk window. Notice that the icon is selected.

Other ways to make a copy of a file are outlined in the summary
chapter in the reference section of this book.
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3. With the name selected, type “Article 1”.
Whatever you type replaces the selected text.
4. Press the Return key.
Pressing Return saves the new name.

Use the Trash
When you no longer need a file or a folder, you can throw it away
by dragging its icon to the Trash. Practice using the Trash by
throwing away the “Article 1” document, which you created when
you made a copy of the “Opening Lines” document.
1. If you closed the Macintosh HD window, open the
Macintosh HD icon now.
(Click the icon to select it, and then choose Open from the
File menu.)

Now you have two identical documents with different names.
You can revise one without changing the other.

The Macintosh HD window appears, showing you the
contents of your hard disk. The contents include the
TeachText program and two documents, one called Opening
Lines and the other called Article 1 (you may have to use the
window’s scroll bars to see them).
continues .
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2. Drag the Article 1 icon to the Trash icon until both
icons are highlighted, and then release the trackball
button.
If the Macintosh HD window is blocking the Trash icon, move
the window by dragging its title bar.
Both icons are highlighted when the tip of the arrow pointer
reaches the Trash icon.

3. Open the Trash icon.
(Click to select the icon, and then choose Open from the File
menu, or click the Trash twice in quick succession.)
The Trash window appears. Anything you drag to the Trash
stays there until you empty the Trash.
You can retrieve items from the Trash by clicking to select
them and then choosing Put Away from the File menu.
(Or you can drag the items back to where they were.)
4. Choose Empty Trash from the Special menu.
A message appears asking you to confirm that you want to
permanently remove the contents of the Trash.
5. Click OK.
Clicking OK empties the Trash—in other words, its contents
are erased from the disk.
Notice that the Trash icon no longer bulges, indicating that
it is empty.
6. Close the Trash window by clicking its close box.

When you release the trackball button, the Article 1 icon
“disappears” into the Trash. When you put an object in the
Trash, the Trash icon bulges to indicate that it is no longer
empty.
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Chapter 4

Learning More
About Your PowerBook
In this chapter
n

How to open the Battery desk accessory

n

How to open the PowerBook control panel

n

How to use the Balloon Help system

n

How to use floppy disks

n

Before you begin
Make sure that your computer is on.
This short chapter introduces you to the Battery desk accessory
and the PowerBook control panel, with which you can monitor
and control your computer’s power consumption.
This chapter also tells you about floppy disks and where to find
answers to other questions you may have about your computer.

Where to look for information about your computer and
its software
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Open the Battery desk accessory

Open the PowerBook control panel

The Battery desk accessory tells you approximately how much
power is left in the battery as you use the computer.

The PowerBook control panel lets you control the balance
between power consumption and system performance (it also lets
you control other PowerBook features).

To open the Battery desk accessory:
n

Choose Battery from the Apple (K) menu.

To open the PowerBook control panel:
1. Choose Control Panels from the Apple (K) menu.

You can leave the Battery desk accessory open to keep track of
the battery charge while you work. The desk accessory works like
a fuel gauge (the solid bars indicate how much power is left).

For more information on how to use the Battery desk accessory,
go to the power management chapter in Part III of this book.
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2. Open the PowerBook icon.

Use Balloon Help
Balloon Help explains icons, menus, commands, and other
objects on your PowerBook’s screen, using balloons similar to
those in comic strips. Each balloon points to the object it explains.
Many Macintosh programs also have Balloon Help.

(Click the icon once to select it, then choose Open from the
File menu. Or double-click the icon.)
The PowerBook control panel appears in Easy View. You drag the
slider to the right to improve performance (battery power is used
up more quickly) or to the left to conserve power (the computer
may not respond as quickly).

You can also set custom settings for battery management by using
the Custom View in the PowerBook control panel. For more
information on how to use the PowerBook control panel, go to
the power management chapter in Part III of this book.

Turn on Balloon Help
1. Point to the Help icon near the right end of the
menu bar.
2. Press to pull down the Help menu.
3. Drag to highlight the Show Balloons command,
then release the trackball button.

When Balloon Help is turned on, balloons containing
explanatory text appear next to objects that you point to
on the screen.
continues .
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4. To show a balloon describing your startup hard disk,
point to the hard disk icon.
A balloon appears next to the icon. Balloons do not affect how
you work with your computer. You still select icons, choose
commands, and so on.

Turn off Balloon Help
Balloons can block items on the screen as you work, so you may
wish to turn them off when you’re finished reading.
m Choose Hide Balloons from the Help menu.

5. Click your hard disk icon to select it.
You can select the icon even with the balloon showing.
6. Point to the File menu.
A balloon appears next to the menu title.
7. Press to pull down the File menu.
The balloon disappears when you pull down the menu.
8. Slowly drag to highlight the Open command, and then
release the trackball button.
Notice that a balloon appears next to a command if you pause
briefly as you drag past it.
The hard disk window becomes the active window. To see
more balloons, you can point to different parts of the window
and to different icons in the window.
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(Point to the Help icon in the menu bar, press to pull down
the Help menu, drag to highlight the Hide Balloons
command, and then release the trackball button.)

Using floppy disks
Your computer does not have a floppy disk drive built in, but you
can connect it to a floppy disk drive. (For instructions, go to the
chapter on expanding your computer system.)
When you connect your computer to a floppy disk drive, you can
use two types of 3.5-inch (89-millimeter) floppy disks:
n

n

Taking care of floppy disks
Follow the care instructions that came with your disks, and
remember three key points:
n

high-density disks (marked with the icon Ó), which can hold
up to 1.4 megabytes (MB) of information
double-sided disks, which can hold up to 800 kilobytes (K)
of information

n

n

(The next page explains kilobytes and megabytes.)
Double-sided (800K) disk

Keep floppy disks away from magnets. Because
information is stored on the disk in the form of magnetic
signals, a magnetic field can destroy that information.
Televisions and monitors, telephones, loudspeakers, and
certain kinds of lighting fixtures all contain magnets.
Protect disks from extremes of temperature and humidity.
Do not open the disk’s metal shutter. Touching the disk
inside the shutter could damage it.

High-density (1.4 MB) disk
Second hole
High-density
disk symbol
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Floppy disks and hard disks

10,000 pages

Both floppy disks and hard disks function like filing cabinets:
you use them to store information. You can store much more on
a hard disk than on a floppy disk, however, and the computer
can retrieve information from a hard disk much faster.

5,000 pages

Floppy disks and hard disks are represented by different icons.

300 pages
1 page
4K

The disk whose icon is closest to the upper-right corner of your
desktop is the startup disk, which contains the information the
PowerBook uses to operate.
Your hard disk is sealed into the hard disk drive inside your
computer. Floppy disks, in contrast, can be taken in and out of
floppy disk drives so you can easily transfer information from
one computer to another.
A floppy disk is made of thin, flexible material with a magnetic
coating. To protect it and make it easier to handle, the floppy
disk itself is enclosed in a rigid plastic case, which gives the
floppy disk its “non-floppy” character. Floppy disks are
sometimes called diskettes.
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200 pages

800K
1.4 MB
Floppy disks

20 MB
40 MB
Hard disks

Even the smallest hard disks can hold the equivalent of a few
thousand pages of information. High-density floppy disks can
hold 1.4 megabytes (MB) of information—about 300 typewritten
pages. Double-sided floppy disks can hold 800 kilobytes (K) of
information—about 200 typewritten pages. (A megabyte is about
1,000 kilobytes.)

Inserting a floppy disk

What next?

1. Hold the disk with your thumb on the label and the
metal shutter pointing away from you.

Congratulations. If you’ve gone through the Macintosh Basics
tour and Parts I and II of this book, you’ve seen and practiced all
the basic skills you need to use your computer productively.

2. Push the disk into the floppy disk drive, label side up
and metal shutter first.
For instructions on preparing a disk for use (called initializing)
and more information on disks, go to the chapter on using disks.

Use Part III of this book

At this point, you could
n

n

n

Part III of this book, PowerBook Reference, contains all the
information you need to use your computer’s hardware and
system software. Unlike Parts I and II, which are meant to be read
from beginning to end, Part III is meant to be used like an
encyclopedia: you turn to it when you need to look up some
information, and read only that information.

check your battery power and recharge it if necessary (see the
power management chapter for more information)
start learning how to use your application programs
turn to Part III and find out how to organize your files or how
to adapt your computer to your own use

n

turn to any other topic in Part III that interests you

n

take a break

To help you find the information you need, this book has a
table of contents and an index. The back of the book also has
a summary of commonly used skills, and a troubleshooting
section.
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Chapter 5

Setting Up Your Programs

If your PowerBook cannot find a startup disk, it displays this icon
in the middle of the screen:

In this chapter
m Installing or updating system software
m Installing your programs
m Working with several programs at a time
m Using the Scrapbook
m Using a RAM disk

Installing or updating system software
System software is the set of programs and other files that your
computer uses to start itself up, keep track of your files, and run
the application programs you use. When you turn on your
computer, it looks for a disk that contains the system software,
which is always in a folder called the System Folder. Any disk that
contains a System Folder with system software inside it is a startup
disk. The startup disk is usually the hard disk that’s inside your
computer, though another hard disk or a floppy disk can also be a
startup disk.

If you see this icon, you need to install system software on your
computer’s internal hard disk or you need to attach it to an
external hard disk that contains the system software.
v If your hard disk already has system software on it and you
see this icon: Your hard disk or system software may be
damaged, and you may need to reinstall the system software.
See the section on testing and repairing disks in the chapter
on disks. v
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Before you install

Installing system software

You use the Installer program to install, reinstall, or update system
software on a startup disk.

If you have access to the system software on a network, open the
Installer program and then follow this procedure, beginning with
step 4. To install system software from another hard disk or a
desktop Macintosh, see the chapter on expanding your computer
system.

S Important: Before you install a new version of system
software, make a backup copy of your current System Folder
on another disk in case you need it later (to use a program
that is incompatible with the new system software,
for example). S

Make sure the system software you’re using is the correct version
for your computer.
1. Shut down your computer.

The Installer lets you update your system software without losing
special files (fonts, sounds, and so on) you may have installed.
Before you install, reinstall, or update system software:
m Your hard disk must be initialized, a process that prepares
the disk to store information. (All Apple computers have their
hard disks initialized at the factory.)
m You need the system software disks that came with your
computer or your system software upgrade kit, or you need
access to the system software over a network, on another
hard disk, or (if your computer can be used in SCSI disk
mode) on a desktop Macintosh.
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2. Insert the Install Me First disk into the floppy disk
drive.
3. Turn on your computer.
The Installer program opens automatically.

4. Click OK.

5. Make sure that the hard disk named in the box is the
one you want to install system software on.

The Easy Install dialog box appears.
Parts of system software
to be installed

Click to install on a
different disk.

If it isn’t, click the Switch Disk button until the correct disk
name appears.
6. Click Install.
7. Follow the instructions that appear on the screen.
If you are installing from floppy disks, you see messages
asking you to insert different disks.
8. When you see a message reporting that the installation
was successful, click Quit.
If a message reports that installation was not successful, try
installing again. (Follow the instructions on the screen.)
9. Restart your PowerBook.

Disk on which system
software will be installed

Click to install
customized software.

Make a backup copy of the System Folder on floppy disks (or on
another hard disk).
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Installing customized system software
Custom installation allows you to select a combination of system
files for your specific needs. You can also use custom installation
to install or update a single file, or to save space on your hard disk
by installing only the files you want.
To install from floppy disks, begin with step 1; to install over a
network, open the Installer program and begin with step 4.
Make sure the system software you’re using is compatible with
your computer.
1. Shut down your PowerBook.
2. Insert the Install Me First disk into the floppy disk
drive.
3. Turn on your PowerBook.
The Installer program opens automatically.
4. Click OK.
The Easy Install dialog box appears.
5. Make sure that the hard disk named in the box is the
one you want to install system software on.
If it isn’t, click the Switch Disk button until the correct disk
name appears.
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6. Click the Customize button.
The custom installation dialog box appears. All available
components of the system software are listed.
7. Scroll through the list of items and hold down the Shift
key as you click the items you want to install.
If you want to conserve space on your hard disk, select the
“minimal software” option for your PowerBook.

S Important: Be sure to install the files that your PowerBook
uses to communicate with the printer, network, and other
equipment it is connected to. S
8. Click Install.
9. Follow the instructions that appear on the screen.
If you are installing from floppy disks, you may see messages
asking you to insert different disks.
10. When you see a message reporting that the installation
was successful, click Quit.
If a message reports that installation was not successful, try
installing again. (Follow the instructions on the screen.)

11. Restart your PowerBook.
Make a backup copy of the System Folder on floppy disks (or on
another hard disk).
s Warning: Your startup disk must have only one System
Folder. Multiple System Folders on a disk can cause
malfunctions and data loss. You can use the Find command
(in the Finder’s File menu) to see if there is more than one
System Folder on your hard disk. Drag any extra System
Folders to the Trash. s

Starting up with a floppy disk
If you’re unable to use your hard disk and you have a floppy disk
drive, you can start up your computer by inserting the Disk Tools
disk into the floppy disk drive and then turning on the computer.
This disk contains programs you can use to initialize, test, and
repair disks.
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Installing your programs
Most application programs come on floppy disks, and you install
them by simply copying them from the floppy disks to your hard
disk. Some programs need to be installed in a particular way. If
your program came with specific instructions, follow them.
To use your programs most effectively:
m Put only one copy of each program on your hard disk. Having
more than one copy can lead to problems when you’re using
the program.
m Whenever you copy the contents of a program disk to your
hard disk, be careful not to copy an extra System Folder.
Always check to see what you’ve copied, and drag any extra
System Folders to the Trash.
m Keep the original program disk in a safe place. If the program
on your hard disk malfunctions, you can replace it with a fresh
copy from the original disk.
m If a program malfunctions consistently, and installing a fresh
copy does not correct the problem, find out from the software
manufacturer whether your version of the program is
compatible with the system software you’re using.
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m Put frequently used programs (or aliases for those programs)
in the Apple menu so you can open the programs more
conveniently. See the chapter on adapting your computer to
your own use.
m If you want your computer to open a program automatically
each time it starts up, you can put the program (or its alias)
into the Startup Items folder. See the chapter on adapting
your computer to your own use.

Installing programs without a floppy disk drive
There are other ways to copy programs onto your hard disk:
m If you have access to a network, you can connect your
computer to the network and copy programs from a shared
disk. See the chapter on networks.
m If your computer can be used in SCSI disk mode and you have
access to a desktop Macintosh, you can connect the two
computers and copy programs directly from the desktop
Macintosh. See the chapter on building an enhanced
computer system.
Remember that the software license agreement for a given
program may limit the number of copies you’re allowed to make.

Checking for computer viruses
Viruses—programs that damage files or erase disks—can be
introduced into your computer from a floppy disk, from a shared
disk on a network, or from an electronic bulletin board service.
Programs that detect and eliminate viruses are available from user
groups, bulletin boards, and dealers.
You should check for viruses frequently if you exchange disks
or data with other users. Some programs check for viruses
automatically.
m Check all disks—even those in new, unopened commercial
software packages—for viruses before using them or copying
anything from them to your hard disk.

m Since new viruses appear regularly, make sure you have the
latest version of your virus-detection software.
m To avoid compatibility problems, be sure to use only one
virus-detection program at a time.
m If your computer is on a network or if you use a modem,
check for viruses each time you copy information from
an outside source.
m If you give information to other computer users on disks
or send information electronically, make certain that there are
no viruses on your computer system before distributing the
information.

m Check your hard disk regularly with a virus-detection program
and correct any problems the program finds.
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Working with several programs at a time

Switching programs

You can open as many programs and desk accessories as your
computer’s memory allows.

You can switch to another open program or desk accessory
by choosing its name from the Application menu.

All open programs are listed in the Application menu at the right
end of the menu bar. The name of the active program (the one
you’re using right now) has a checkmark next to it, and its icon
appears in the menu bar.

If a program’s icon is dimmed in the menu, that means its
windows are hidden. Choosing the program from the Application
menu displays its windows.

The Finder icon
Commands to hide or
display open windows
Open programs
Checkmark indicates
the active program.

Finding out what programs are open
If you have several programs and windows open, you can find out
which program is active and what other programs are open by
pulling down the Application menu.
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You can also switch to another program by clicking in a window
that belongs to an open program, or by double-clicking a program
icon (or the icon of a document that was created with the
program).

Hiding and showing windows on the desktop
You can hide all windows except those of the active program by
choosing the Hide Others command from the Application menu.
The other programs remain open even though the windows are
hidden. When you switch to another program, its windows are
displayed.
If you want to see all the open windows, choose Show All from
the Application menu.

Changing the amount of memory a program uses
Each program you open sets aside the amount of memory it
needs. (If you don’t have enough memory to open a program, you
need to quit one of the programs already open to free up some
memory.)

If you want to be able to open more programs, decrease the
minimum size. If you type a size smaller than “Suggested size,”
the program may work more slowly, show other performance
problems, or not work at all.

On occasion you may want to increase or decrease the amount of
memory a program uses. You increase the amount so you can
open more or larger documents in that program, and you
decrease the amount so you can open more programs at the same
time. You adjust the program’s memory size in its Info window.
1. Quit the program if it’s open, and then click the
program’s icon to select it.
2. Choose Get Info from the File menu.

The amount of memory the
program needs to open

3. Drag across the box containing the number you want to
change (either “Minimum size” or “Preferred size”).
“Preferred size” must always be larger than “Minimum size.”
4. Type the number of kilobytes (K) of memory that you
want the program to use.
If the program frequently runs out of memory, increase both
the preferred size and the minimum size.

The amount of memory the
program will use if enough
memory is available

5. Close the Info window.
If you make the memory size smaller than suggested, you’ll
see a message asking you to confirm your decision. Click
Cancel to avoid problems with the program.
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4. Choose Paste from the Edit menu.

Using the Scrapbook
You can use the Scrapbook to store text, graphics, sounds, and
other elements that you frequently include in your documents.

The new element is pasted ahead of the one previously
displayed.

Storing items in the Scrapbook:

Copying items from the Scrapbook:

1. In your document, select the text or other element that
you want to store in the Scrapbook.

1. Choose Scrapbook from the Apple (K) menu.

2. Choose Copy from the Edit menu.

2. Use the scroll bar to display the item you want to use in
a document.

3. Choose Scrapbook from the Apple (K) menu.

3. Choose Copy from the Edit menu.

The Scrapbook opens. You can use the scroll bar to see the
different text, graphic, and other elements it contains.

4. Open the document you want to use the item in.
5. Decide where you want to place the element.
6. Choose Paste from the Edit menu.

Deleting items from the Scrapbook:
1. Choose Scrapbook from the Apple (K) menu.
2. Use the scroll bar to display the item you want to
delete.
3. Choose Clear from the Edit menu.

The second of seven items
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The type of
item of
information
displayed

Using a RAM disk

Creating a RAM disk

A RAM disk is a portion of your computer’s memory that you set
aside for use as a temporary storage device. Using a RAM disk
conserves power because the computer uses less energy to access
RAM than to access a hard disk or a floppy disk.

1. Choose Control Panels from the Apple (K) menu.

To use a RAM disk, you should have at least 4 MB of RAM in your
computer because memory assigned to a RAM disk is not available
for opening programs.

2. Open the Memory control panel.
The RAM disk portion of this control panel is at the bottom
of the window. If your computer has less than 3 MB of RAM,
this portion does not appear.

Choosing Sleep or restarting the computer does not affect a RAM
disk—but if your computer has a built-in floppy disk drive,
choosing Shut Down erases the contents of the RAM disk (but
does not remove the RAM disk itself ).
Remember a few precautions if you use a RAM disk:
m Before using a program on a RAM disk, test the program on
your hard disk or a floppy disk to make sure that it works
properly with your computer.
m Don’t store your only copy of a file on a RAM disk. Keep a
backup copy on your hard disk or a floppy disk.

3. Click the On button below the words “RAM disk.”
4. Drag the slider to choose the percentage of available
memory you want to use for your RAM disk.
Choose a size just large enough to accommodate the
programs and documents you want to put on the RAM disk.
Don’t choose a larger size than you need because memory set
aside for the RAM disk won’t be available for opening
programs.
The size of the RAM disk you select appears in the “RAM Disk
Size” box.
continues .
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5. Choose Restart from the Special menu.
A RAM disk icon appears on the desktop when the computer
restarts.
6. Drag the items you want to the RAM disk icon.

Resizing or removing a RAM disk
1. Copy any programs or documents that you want to save
onto the internal hard disk or a floppy disk.
If you want to resize a RAM disk, you need to remove its
contents and then restore them.

Erasing a RAM disk

2. Drag everything in the RAM disk to the Trash.

There are two ways to erase the contents of a RAM disk. They do
not remove the RAM disk itself or make more memory available
for opening programs.

3. Choose Empty Trash from the Special menu.

m Select the RAM disk icon and choose Erase Disk from
the Special menu.

5. Open the Memory control panel.

m Drag everything on the RAM disk to the Trash and
choose Empty Trash from the Special menu.

4. Choose Control Panels from the Apple (K) menu.

6. Drag the slider to choose the percentage of available
memory you want to use for your RAM disk.
Drag the slider to 0% if you want to remove the RAM disk.
7. Choose Restart from the Special menu.
If you resized your RAM disk, a new RAM disk icon appears on
the desktop when the computer restarts. If you removed your
RAM disk, no icon appears.
8. If you resized the RAM disk, copy any items you want
back to it.
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Making a RAM disk the startup disk
If you have 6 MB or more of memory, you can make a RAM disk
your startup disk.

The RAM disk is now your startup disk. Be sure to keep a System
Folder on your hard disk as well, in case the contents of the RAM
disk are erased. Also, keep a copy of the RAM disk contents on
another disk. (Don’t keep two System Folders on a single disk.)

1. Create a RAM disk.
2. Locate and open the Installer program on the Install
Me First disk.

S Important: If your computer has a built-in floppy disk drive,
the contents of the RAM disk are erased when you choose
Shut Down, though the RAM disk itself is not removed. S

3. Install a minimal System Folder on the RAM disk.
See the instructions on installing customized system software
in this chapter.
4. Choose Control Panels from the Apple (K) menu.
5. Open the Startup Disk control panel.
6. Select the RAM disk as your startup disk.
7. Choose Restart from the Special menu.
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Chapter 6

Power Management
In this chapter
n

Checking the battery level

n

Responding to low-power messages

n

Recharging the battery

n

Removing or replacing the battery

n

Maximizing battery life

n

Getting the most work time out of the battery

Power sources
Your computer can draw its operating power from two different
sources. You choose which power source to use.
n

n

Main battery: Your computer’s main power source is a
nickel-metal-hydride battery. The battery provides power for
up to 6 hours of work (depending on the battery conservation
features you choose).
AC power: You can run your computer from any standard
electrical outlet by plugging in the power adapter.

Your computer also has backup batteries that maintain the
contents of RAM while you replace the main battery. The backup
batteries do not provide enough power to run the computer.
These power sources are described in more detail in the following
sections.
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Monitoring the battery charge level
The main battery provides power for up to 6 hours of work (the
exact time depends on how often you use the hard disk, how
bright the screen is, and other factors). Use the Battery desk
accessory to monitor the charge level of the battery so you can
recharge it when necessary.

Using the Battery desk accessory
To open the Battery desk accessory, choose Battery from the
Apple menu.
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The Battery desk accessory appears.

Lightning bolt icon

The line of rectangles is the battery gauge. Black rectangles
indicate the charge level. You can see the level decrease while the
battery is in use, and increase while the battery is recharging in
the computer.
A lightning bolt icon appears when the power adapter is plugged
in and the battery is recharging in the computer. The lightning
bolt icon disappears when the battery is fully charged.

When you click the lever to the right of the battery gauge, a Sleep
button appears.
Lever

Responding to low-power messages
When the battery charge drops to about 15%, the computer
displays three messages telling you that your computer is running
on low battery power. You have about 10–30 minutes of work
time remaining after you see the first message, so you have time
to finish what you’re doing before recharging.

What you should do
You may sometimes find it convenient to put the computer to
sleep by clicking this button, instead of choosing the Sleep
command.

When you see a low-power message, do either of the following:
n

Plug in the power adapter, or

n

Save your work and put the computer to sleep.

What you should know
The first low-power message is a reminder that the battery will
soon run out. Right after this message appears, the screen
brightness dims automatically to save power.
If you continue to work without plugging in the power adapter or
changing the battery, the computer displays a second low-power
message.
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The second message is followed by a third and final message
indicating that the computer is about to put itself to sleep. When
time is up, the computer goes to sleep automatically to protect
the contents of RAM. Some functions (such as modem
connections) are interrupted when the computer goes to sleep.
It’s a good idea to save your work when you see the first two lowpower messages to make sure you don’t lose data.
If you continue working until the computer goes to sleep
automatically, you can wake it again as soon as you plug in the
power adapter or replace the battery with a fully-charged battery.
If you can’t plug in the power adapter, the contents of RAM are
retained in sleep for about a day. If you leave the battery in the
computer and recharge it within a day, you should be able to wake
the computer and resume work where you left off.
S Important: A depleted battery can be left uncharged in the
computer for a month or two if the computer is stored at
room temperature or below. Don’t store the computer or its
battery in a hot location (such as the trunk of a car). Heat may
damage the battery so that it can’t be recharged. If this
happens, you need to replace the battery. S

90 Chapter 6: Power Management

Recharging the battery
There are two ways to recharge:
n

n

Plug in the power adapter to recharge the battery without
removing it from the computer, or
Remove the battery and recharge it in the (optional)
recharger.

Recharge a battery just before you plan to use it. The battery does
not retain its charge in storage.

Recharging in the computer
Plug in the power adapter as shown.
s Warning: Use only the power adapter that came with your
computer. Adapters for other electronic devices (including
other portable computers) may look similar, but they may
damage your computer. s

Recharging in a recharger
A battery recharger and additional batteries are available as
options for your computer. If you purchase a recharger and an
extra battery, you can charge one battery while you use the other,
so you always have a fully charged battery on hand.
The recharger can accommodate two batteries. The battery slots
work independently, so you can put batteries in or take them out
at different times.
The recharger must be plugged into an electrical outlet to charge
a battery. You can plug it in using the power adapter that came
with your computer, or you can purchase an additional (identical)
power adapter from your Apple-authorized dealer.
You can continue to use the computer while the battery is
recharging. Using the computer does not affect the amount of
time it takes the battery to recharge.
If you recharge a fully depleted battery with the computer in sleep
or shut down, it usually takes a little over 2 hours to bring the
battery charge to 100%, but the time may vary depending on the
PowerBook you have and the battery you are recharging.

s Warning: Do not use any other type of power adapter with
the recharger. Doing so may damage the recharger, the power
adapter, or both. s
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To recharge a battery, follow these steps.
1. Place the recharger on a level surface.
2. Connect the recharger and the power adapter as shown
in the illustration.

S Important: To preserve a battery’s charge, don’t leave it
in the recharger if the power adapter is not plugged into
an electrical outlet. S
The lights on the recharger indicate the following:
n

No light: The recharger is not plugged in, or the battery is
defective. (If the light goes off during recharging, there is a
problem with the battery.)

n

Yellow: The battery is charging.

n

Green: The battery is fully charged.

n

Red: The charge does not recognize the type of battery
inserted. If you are charging a replacement battery, follow the
instructions that came with it.

The table shows approximate recharging times for fully
depleted batteries. Times may vary depending on the PowerBook
you have and the type of battery you are recharging.
Time to 100% charge

3. Place the battery in the recharger as shown.
Recharging begins immediately. You can remove a battery
from the recharger at any time.
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In the recharger:
1 battery
2 batteries

2+ hours
41⁄2 hours

In the computer (in sleep or shut down):

2+ hours

Recharging in both the computer and a recharger
You can use a single power adapter to run both the
PowerBook Duo and the battery recharger at the same time.

If the PowerBook is on and contains a battery that is not fully
charged, the computer charges the internal battery first. The
external battery does not begin charging until the internal battery
is fully charged. If you are still using the computer at that point, it
takes a little over 2 hours for a fully depleted external battery to
charge.
If the PowerBook is in sleep or shut down, internal and external
batteries charge simultaneously. If both batteries are fully
depleted, it takes about 41⁄2 hours to charge both. If the internal
battery is fully charged or absent, the external battery takes a little
over 2 hours to charge.
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Removing or replacing the battery
n

n

If the power adapter is plugged in: You can use the
computer indefinitely without a battery as long as the power
adapter is plugged in.

3. Open the battery door by pressing the small button and
sliding the door in the direction indicated by the arrow.
The door is physically attached to the battery.

If the power adapter is not plugged in: The backup
batteries in your computer protect the contents of main
memory—any programs and documents that are open on
your desktop—for about 4 minutes while you remove a
depleted main battery to replace it with a charged one.
(The backup batteries maintain other kinds of information,
including control panel settings such as the clock time, for up
to 2 weeks after the main battery is discharged or removed.)

To remove or replace the main battery, follow these steps.

4. Carefully pull the battery out of its compartment.

1. Save your work, and then choose Sleep from the
Special menu.

5. If you are inserting another battery, slide it into the
battery compartment.

You can choose Shut Down instead of Sleep if you feel more
comfortable working without the 4-minute time limit.
2. Close the display.
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Replacement batteries come with a door attached.

6. Close the battery door by pushing it back into place.

Maximizing battery life and work time

S Important: Check to make sure the battery is properly
inserted (the battery should be aligned with the computer
and the battery door completely closed). If a battery is not
inserted correctly, you may have performance problems. S

To maximize battery life, discharge and then recharge the battery
completely once every 30 days. You should also do this any time
you notice that the amount of work time the battery provides is
decreasing.

7. If possible, plug in the power adapter in case the
battery is not fully charged.

If you have a PowerBook Duo 270c, go to the section called
“Reconditioning the battery” later in this chapter.

s Warning: Damaged nickel-metal-hydride batteries may leak
small amounts of sodium hydroxide. This substance can cause
severe burns to the skin and eyes. If you touch a damaged
battery, immediately wash your hands and any other affected
areas with water for at least five minutes. Do not use soap. s

If you have a PowerBook Duo 210, 230, or 250, just use the
computer as you normally would, but ignore the low-power
messages that appear on the screen. (Make sure to save your
work, however.) When the computer goes to sleep automatically,
recharge the battery completely before using that battery again.
You can do this in either of two ways:

s Warning: See the section “Important Care and Safety
Information” for more about how to work safely with
batteries. s

n

n

Leave the battery in the computer, plug in the power adapter,
and let the battery recharge overnight, or
Remove the battery from the computer and recharge it in a
recharger for a little over 2 hours (if you are recharging just
one battery) or 41⁄2 hours (if you are recharging two).

With proper care you can expect your battery to last for at least a
year. If you notice that the battery no longer holds a charge for as
long as it should, even after discharging and recharging it as
described above, you may need to replace it.
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Disposing of dead batteries
S Important: Nickel-metal-hydride batteries contain metals
that can be reclaimed and reused. Instead of throwing away
dead batteries, please dispose of them as described here.
In the United States: Return dead batteries to your Appleauthorized service provider, who will make sure they are
included in Apple’s battery recycling program.
Elsewhere: Many countries have government- or Applesponsored collection and/or recycling programs for dead
batteries. Dispose of dead batteries in accordance with the
mandatory or voluntary battery collection schemes in your
country. Contact your Apple-authorized service provider for
information about the recommended battery disposal
procedures in your location. If there is no government- or
Apple-sponsored return program, you can dispose of the
batteries with your regular trash, taking care not to break
them open or incinerate them. S
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Replacing the backup batteries
In addition to its main battery, your computer has two small
backup batteries that maintain the contents of RAM while you
replace the main battery.
The backup batteries usually last for several years. You may need
to have them replaced if you notice that some of your system
settings changed after you removed or replaced the main battery.
( You may notice, for example, that the clock time is different.) By
replacing the backup batteries you can preserve the contents of
RAM the next time you change the main battery.
Your computer’s backup batteries must be replaced by an Appleauthorized service provider.

Reconditioning the battery
If you have a PowerBook Duo 270c, you can extend your battery’s
life by reconditioning your battery once every 30 days using
Battery Reconditioning, which is on the system software disk
labeled Disk Tools.

A message appears on the screen describing battery
reconditioning. If you don’t have your PowerBook plugged
in, a message appears telling you to plug it in.
4. Read the message on the screen and click OK.
The following appears:

S Important: The Battery Reconditioning application takes 2
hours to use. During this time, the battery is reconditioned,
and you cannot use your PowerBook. When you want to
recondition your battery, plan a time when you won‘t need
your PowerBook for at least 2 hours. S
v Note: You can’t use the Battery Reconditioning application if
you have a PowerBook Duo 210, 230, or 250. See the section
on maximizing your battery life and work time earlier in this
chapter for hints on extending your battery’s performance. v
To recondition a battery, follow these steps.
1. Plug in your PowerBook using your AC power adapter.
2. Insert Disk Tools in the floppy disk drive and turn on
your PowerBook.
3. Locate the Battery Reconditioning icon and open it.

The date you last reconditioned your battery
appears here. A warning appears below the
date if it has been less than 30 days since the
last recondition.

5. Click Recondition if it has been more than 30 days
since the last time you reconditioned the battery.
continues .
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If 30 days have not passed since the last time you
reconditioned, the following appears on the screen.

You can quit the Battery Reconditioning application at any
time by pressing the period key and the x (Command) key
at the same time. Also, if you unplug your PowerBook during
reconditioning, it quits. Your battery is not reconditioned if
you quit in the middle of the reconditioning cycle.
Click Quit to exit the Battery Reconditioning application.
If more than 30 days have passed since your last
reconditioning, the following message appears:

When the reconditioning is complete, the following appears
on the screen for one minute:

7. Click OK.
6. Click OK.
Remember that it takes 2 hours to recondition the battery.
Make sure you do not need to use your PowerBook for 2
hours.
While the reconditioning cycle it taking place, the following
icon appears on the screen.
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The battery is reconditioned. Allow time to recharge the
battery by leaving the PowerBook plugged in for 2 hours.
Follow these steps again in 30 days to optimize the battery.

Maximizing work time
Your PowerBook’s battery can provide from 2 to 6 hours of work
time before you need to recharge it. The actual work time
available depends on what equipment you’re using with your
computer and what steps you take to conserve power while you
work.

n

n

n

Ways to conserve battery power
The more of these steps you take, the longer you can use your
battery before recharging it.
n

n

n

Turn down the screen brightness whenever possible. At its
brightest level, the screen consumes about a third of the
power your computer is using.
Keep screen dimming turned on in the PowerBook control
panel. This feature dims your screen automatically if you
haven’t used the computer for a few minutes.
Adjust the battery conservation settings in the PowerBook
control panel for maximum conservation.

n

n

n

n

Keep processor cycling turned on in the PowerBook control
panel; set the computer’s microprocessor to run at a reduced
speed; and keep the automatic power conservation settings
turned on. The rest of this section describes these settings in
detail.
Keep virtual memory turned off in the Memory control panel.
If your computer has 6 MB of memory or more, use a RAM
disk as your startup disk to minimize hard disk use.
Quit any program that uses a modem unless you’re using the
program for telecommunication. As long as the program is
open, your modem is consuming power.
If you’re working near an electrical outlet, plug in the power
adapter.
If you aren’t using the computer, put it to sleep and plug in
the power adapter.
If you have a PowerBook Duo 270c, use the Battery
Reconditioning application every 30 days.
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Adjusting the battery conservation settings
The PowerBook control panel gives you several ways to regulate
your computer’s power consumption.

The easiest approach
Just use the Battery Conservation slider to choose the setting you
prefer.
1. Choose Control Panels from the Apple (K) menu, and
open the PowerBook control panel.
The PowerBook control panels opens in Easy View. You can
also choose Custom View for more detailed options. For a
description of Custom view, see the next page.
2. Drag the slider to the setting you want.

You can think of the battery conservation setting as an automatic
sleep setting. If you don’t use the computer for several minutes
(how many depends on which setting you choose), it goes to
sleep without any action on your part. A computer in sleep has a
darkened screen and appears to be off, though it is still drawing
battery power at a low level.
To put the computer to sleep before the automatic sleep setting
takes effect, choose Sleep from the Special menu or close the
display.
To wake the computer from sleep, press the Power On key or any
key on the keyboard (except Caps Lock).
Automatic sleep does not take effect under any of the following
circumstances:
n

n

n

There are five settings along the scale. If you’re trying to meet
a deadline, Better Performance allows you to work with the
fewest interruptions. If you don’t have a power adapter with
you, Better Conservation gives you the longest work time.
3. Close the PowerBook control panel.
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You are using your computer in the Duo Dock.
You connected to the Duo MiniDock with an external monitor
attached.
The AppleTalk software is turned on in the Chooser and the
power adapter is plugged in. (Automatic sleep does take effect
if the power adapter is not plugged in.)

n

Your computer is connected to a shared disk on the network.

n

Your computer’s printer/modem port is in use.

More about automatic sleep and screen dimming

Using the Custom options

The Battery Conservation slider controls three different power
conservation features: system sleep, hard disk sleep and screen
dimming.

The PowerBook control panel includes a switch labeled
Easy/Custom. Slide the switch to Custom for more options that
affect your computer’s power consumption.

n

n

n

System sleep is a state in which your computer uses only the
power it needs to maintain the contents of RAM. (The
contents of RAM include any open programs and documents,
and various control panel settings.) If system sleep is in effect,
so is hard disk sleep.
Hard disk sleep stops your computer’s internal hard disk from
spinning when it isn’t being used.
Screen dimming automatically dims the backlight in your
PowerBook’s screen to conserve power (the screen’s
backlight is the single biggest consumer of your computer’s
battery power).

Slide this
switch to
Custom
view.
Custom view
adds these
conservation
options.

The table indicates how the battery conservation settings
correspond to sleep/backlight dimming times.
Minutes before sleep/backlight dimming if you choose:
Conservation
1
2
System
Hard disk
Backlight Dimming

2
1
1

3
2
2

3

4

6
3
3

8
6
4

Performance
5
15
8
5
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Battery Conservation settings

Processor cycling

You can set the battery conservation slider between better
conservation and better performance just as you did in the
PowerBook control panel’s Easy view. In Custom view, three
sliders controlling the times before the system sleep, the backlight
dims and the hard disk spins down appear. Notice as you drag the
main battery conservation slider, the three time sliders change.

If the computer is not doing anything for a few seconds, it
reduces the power consumption of its microprocessor. The
microprocessor comes back up to speed instantaneously when
you resume work. This feature is called processor cycling.
Processor cycling is a way of conserving battery power and it is
highly recommended that you always work with processor cycling
on. But if you notice that a program performs very slowly, you
might want to turn off processor cycling temporarily. To turn off
processor cycling, follow these steps.
1. Choose Control Panels from the Apple (K) menu, and
open the PowerBook control panel.
2. Click the Custom button.

To set the time sliders:

3. Click the “Allow processor cycling” checkbox to
deselect it.

1. Choose Control Panels from the Apple (K) menu, and
open the PowerBook control panel.
2. Click the Custom button.
3. Drag the slider for the time you want to change.
You can change one, two, or all three of the times. Notice the
main battery conservation slider changes to reflect the
changes you make to each individual time slider.
4. Close the PowerBook control panel.
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4. Close the PowerBook control panel.
To turn processor cycling back on, click the “Allow processor
cycling” checkbox to select it.

You may notice other effects of processor cycling. For example,
if you have open programs doing something in the background,
processor cycling may slow those programs down. You may also
notice that the Alarm Clock is updated irregularly or that the
wristwatch pointer appears more often. These changes do not
indicate a problem with your computer.
S Important: To conserve battery power, turn processor
cycling off only when using programs that it interferes with.
Turn processor cycling back on again as soon as possible. S

Processor speed
The processor speed feature allows you to slow the computer’s
microprocessor speed (from 33 or 25 MHz to 16 MHz). Some
programs may work more slowly, but you may gain up to 10–15
minutes of work time before you need to recharge the battery.
(The amount of time you gain depends on how you are using the
computer.)
To slow the processor speed, follow these steps.
1. Choose Control Panels from the Apple (K) menu, and
open the PowerBook control panel.
2. Click the Custom button.
3. Click the “Reduce processor speed” checkbox to
select it.

4. Choose Restart from the Special menu.
The computer runs at the lower microprocessor speed until you
uncheck the “Reduce processor speed” box to deselect it and
restart the computer.

Chapter 6: Power Management 103

Power Conservation

To adjust the power conservation settings, follow these steps.

Your PowerBook keeps track of what power source you are using
and can change the settings to maximize battery conservation and
performance depending on whether you are using a battery or a
power adapter. If you unplug your PowerBook and are running
using the battery, the power conservation settings change to
conserve battery power.

1. Choose Control Panels from the Apple (K) menu, and
open the PowerBook control panel.

Power conservation is set to automatically change when you
change power sources. To turn automatic power conservation off,
follow these steps:
1. Choose Control Panels from the Apple (K) menu, and
open the PowerBook control panel.
2. Click the Custom button.
3. Click Manual under Power Conservation.

2. Click the Custom button.
3. Select the power source whose power conservation
settings you want to change in the pop-up menu.
The power source you are using is most likely the one that
appears in the pop-up menu. This is called the “active set”
because the power management settings are the ones your
PowerBook is currently using.
4. Drag the slider of the times you want to change.
See the section on Battery Conservation settings for
more help.
Any changes you make the sliders are made to the active set.
5. Close the PowerBook control panel.
To turn the power conservation settings back to the default
settings, click Default.

4. Close the PowerBook control panel.
To turn power conservation back to automatic, click Auto.
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Chapter 7

Using Disks
In this chapter

Preparing a new disk for use
Before you can use a new disk, you need to prepare it so the
computer knows where to store information on the disk. This
preparation is called initializing (or formatting) the disk.

n

Preparing a new disk for use

n

Erasing a disk

n

Choosing a startup disk

n

Protecting the information on a disk

Initializing a hard disk

n

If you can’t save files on a floppy disk

n

Ejecting a disk

n

Caring for disks

n

Testing and repairing disks

Occasionally a hard disk may become damaged in such a way that
you have to reinitialize it. (The key symptom of such damage is
that the hard disk’s icon does not appear on the desktop when
you start up the computer using another disk.) You lose all the
information on a damaged disk when you reinitialize it.

The hard disk inside your computer is initialized at the factory,
but you need to initialize new 3.5-inch (89-millimeter) floppy
disks that you want to use in a floppy disk drive.

If your hard disk’s icon does not appear on the desktop, first try
to repair it as described later in this chapter. If you can’t repair the
disk, use the Apple HD SC Setup program to reinitialize the disk.
The program is on the system software disk called Disk Tools.
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1. Insert Disk Tools and turn on your computer.
2. Locate the Apple HD SC Setup icon and open it.

You cannot initialize the disk that you used to start up your
computer or the disk that contains the Apple HD SC Setup
program.
4. Click Initialize.
5. Click Init to initialize the hard disk.
6. If a message appears asking you to name the disk,
type a name and then click OK.

The name of the hard disk currently selected is shown as the
“volume name.” The SCSI ID number of the selected hard
disk is displayed above the Drive button. (The ID number of
an internal hard disk is 0.)
3. Click Drive until the disk you want to initialize appears.

The hard disk’s
SCSI ID number

The hard disk’s
name
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7. Click Quit when you see a message reporting that
initialization was successful.
If a message reports that initialization failed, try again.
If initialization fails a second time, take the disk to your Appleauthorized service provider for repair.

Initializing a floppy disk
Initializing a new floppy disk prepares the disk to store
information.
1. Insert a new floppy disk into your floppy disk drive.
If you inserted a high-density disk (1.4 MB), this message
appears:

2. If you inserted a high-density disk, click Initialize.
If you inserted a double-sided disk, click Two-Sided.
A message alerts you that you’re about to erase any
information that may be on the floppy disk. A new floppy disk
has no information on it.
3. Click Erase.
A third message asks you to name the disk.

If you inserted a double-sided (800K) disk, this message
appears:

4. Type a name for the disk.
If you don’t name the disk, the computer gives it the name
“Untitled.”
5. Click OK.
The computer takes about a minute to initialize the disk.
When initialization is finished, the icon of the floppy disk
appears on the desktop.
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Erasing a floppy disk

Designating a startup disk

Erasing a disk actually reinitializes it.

If you use more than one hard disk with your computer, you can
specify which hard disk you want the computer to use as the
startup disk. (A startup disk must have a System Folder on it that
contains the correct version of the system software.)

s Warning: When you erase a disk, you lose any information
that was on the disk. s
1. Click the icon of the disk you want to erase.
2. Choose Erase Disk from the Special menu.
A message appears.
3. Depending on the type of disk you’re erasing, click
Initialize or Two-Sided.

If you don’t specify a startup disk, your computer uses its internal
hard disk as the startup disk (if it has a System Folder).
1. Choose Control Panels from the Apple (K) menu.
2. Open the Startup Disk control panel.
3. Click the icon of the disk you want to use as the startup
disk.

The computer takes about a minute to erase the disk.

4. Close the Startup Disk control panel.
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Scanning order for startup disks

Protecting the information on a disk

When you turn on your computer, it looks for a startup disk
(a disk containing a System Folder) in the following sequence:

The information on a locked floppy disk or in a locked file can be
opened or copied but cannot be changed.

1. internal floppy disk drive (if any)
2. external floppy disk drive (if any)
3. disk (or RAM disk) selected in the Startup Disk control panel
4. internal hard disk
5. external hard disk (if there is more than one, it looks first at
the hard disk with the highest SCSI ID number)

Locking a floppy disk
n

Slide the tab on the back side of the disk so that the square
hole is open.
Use your thumbnail, a push pin, or a similar object to move
the tab.

6. internal hard disk (the computer returns to this drive and
waits another few seconds)
If the computer does not find a startup disk, it displays a blinking
question mark in the middle of the screen.
To bypass the internal hard disk in the scanning sequence, press
x-Option-Shift-Delete while the computer starts up.
S Important: If you use an external hard disk, turn it on and
wait a few seconds before you turn on your PowerBook, or
the computer may not recognize the disk. S

Locked

Unlocked

To unlock the disk, slide the tab back so that it covers the
square hole.
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Locking a file

4. Close the Info window.

You use the Get Info command to lock a document or a program.
Locking a program may affect its operation.

To unlock the file, click the Locked box again (so the X
disappears).

1. Click the icon of the file you want to lock.

You can’t lock a folder, but you can lock items in a folder.

2. Choose Get Info from the File menu.

Locking an alias does not lock the original file. Locking an alias
merely protects it from being thrown away.

3. In the Info window, click the Locked box in the
lower-left corner.
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Backing up your files

If you can’t save files on a floppy disk

Making backup copies of important files is good protection
against possible damage to the originals.

If you can’t save files on a floppy disk, the disk may be locked, full,
or damaged, or the disk drive may not be working properly. Try
the following:

n

n

n

n

n

You can back up files stored on your hard disk by copying
them onto floppy disks.
You can back up an entire floppy disk by copying it to another
floppy disk, or to a hard disk.
You can use a commercial backup program to copy new and
changed files from a hard disk to another hard disk, to a tape
drive, or to a series of floppy disks.

n

n

n

If your computer is on a network, you can back up files by
copying them to a shared disk on the network.
If your computer can be used in SCSI disk mode and you have
access to a desktop Macintosh, you can connect the two
computers and back up files by copying them from one
computer to the other. (See the chapter on expanding your
computer system for more information.)

n

n

Make sure the tab on the back of the disk is in the unlocked
position (the square hole should be closed).
If you see a message reporting that the disk is full, erase
unneeded files from that disk, or save on another disk.
If you see a message that the disk is not initialized, and you
know that it has been initialized, eject the disk and carefully
insert it again. If the same message appears, the disk is
probably damaged. You may be able to recover its information
with Disk First Aid or another disk-recovery program. (See the
section on testing and repairing disks in this chapter.)
Check the disk for obvious damage to the plastic case or the
sliding metal shutter.
Insert a different disk and try saving again. If you can’t save on
the second disk, the disk drive may be damaged. Take the disk
drive to your Apple-authorized service provider for repair.
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Ejecting a disk

If you can’t eject a floppy disk

You can eject a floppy disk by doing any of the following:

If you can’t eject a floppy disk in the usual way, try the following in
order:

n

Click the disk icon to select it and choose Put Away from the
File menu.
The disk is ejected and its icon disappears from the desktop.

n

Drag the disk icon to the Trash.
The disk is ejected and its icon disappears from the desktop.
(Dragging a disk to the Trash does not erase the disk’s
contents.)

n

Click the disk icon to select it and choose Eject Disk from the
Special menu.
The disk is ejected and its dimmed icon remains on
the desktop.

1. Hold down the x and Shift keys and press the number 1 key
on your keyboard to eject a disk in an internal disk drive;
press x-Shift-2 to eject a disk in an external disk drive.
2. Turn off the PowerBook. If the disk isn’t ejected, then hold
down the trackball button while you turn the computer on
again.
3. Locate the small hole near the disk drive’s opening, and
carefully insert the end of a large straightened paper clip into
it. Push gently until the disk is ejected. Do not use excessive
force.

You can use the first two methods to remove a hard disk icon
from the Macintosh desktop (provided that it’s not your startup
disk), or to disconnect from a shared disk on the network.
All three methods also work with CD-ROM discs.

4. If nothing works, take the computer or disk drive to your
Apple-authorized service provider to have the disk removed.
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Caring for disks

Testing and repairing disks

For information on floppy disk care, see the section on working
with disks in Part II of this book, or consult the instructions that
came with your floppy disks.

Both floppy disks and hard disks can become damaged by
repeated use and handling. If you see a message reporting that
a disk is damaged or unreadable, you can use Disk First Aid or
Apple HD SC Setup to try to diagnose and correct the problem.
Both programs are on the disk called Disk Tools that came with
your computer.

Hard disk precautions
Hard disk drives are delicate mechanisms and should be handled
with care.
n

n

n

Do not bump, jar, or move your computer while the hard disk
is in use. If you need to move the computer, wait until the
hard disk stops spinning.
Do not spill any liquids on or near the hard disk.
Do not expose the hard disk to hazardous vapors, such as
those from cleaning solvents.

If your computer can be used in SCSI disk mode, you may be able
to correct a problem with your hard disk by connecting your
computer to a desktop Macintosh and then reinstalling the system
software on your computer from the desktop computer. (See the
chapter on enhancing your computer system for more
information.)

If a hard disk icon doesn’t appear
If you can’t start up from a hard disk or don’t see its icon on the
desktop, try the following:
n

n

If the hard disk is internal, shut down your PowerBook, wait at
least 10 seconds, and then turn it on again.
If the hard disk is your startup disk, start up with a different
disk. If the hard disk’s icon appears on your desktop, reinstall
system software on the hard disk (use your backup copy or
use the Installer program and the original system software).
continues .
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n

n

If the hard disk is external, make sure it is turned on and its
cable is connected firmly; then restart the PowerBook.
Check the ID numbers of all SCSI equipment connected to
your computer. Each device must have a unique ID number
(the computer itself has the ID number 7, and the internal
hard disk has the number 0). Also check that the chain of
devices is terminated properly. (See the chapter on enhancing
your computer system for information about setting SCSI ID
numbers and checking termination.)
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Using Disk First Aid
You can use the Disk First Aid program to test floppy disks
and hard disks that may have been damaged. Disk First Aid
also repairs some types of disk damage. Disk First Aid is on the
system software disk labeled Disk Tools.
1. Insert Disk Tools and start up your computer.
2. Open the Disk First Aid icon.

3. Click the Drive button until the name of the disk you
want to test appears. Click the Eject button if you want
to insert a different floppy disk.
4. Click Open.
5. Choose Repair Automatically from the Options menu.

6. Click the Start button to begin testing the disk.
7. When testing and repair are finished, choose Quit from
the File menu.
If you want to test another disk, choose Close from the File menu,
then select and open another disk (repeat steps 3–7).
If Disk First Aid cannot correct the problem:
n

n

n

n

Try repairing the disk again. Sometimes repeating the process
corrects the problem.
Use another disk repair or recovery program. Some disk
repair programs let you recover information from a damaged
disk.
Consult a specialist for help.
Once you have recovered all the information you can, erase
(reinitialize) the disk. If initialization doesn’t work, discard the
damaged floppy disk, or take the hard disk to your Appleauthorized service provider for repair.
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Testing a hard disk

4. Click Test.

You can test a hard disk with the Apple HD SC Setup program,
which is on the system software disk labeled Disk Tools.

5. When a message tells you that testing is complete, click
Quit.

1. Insert Disk Tools in the floppy disk drive and start up
your computer.
2. Open the Apple HD SC Setup icon.

3. Click the Drive button until the disk you want appears.

The hard disk’s
SCSI ID number

The hard disk’s
name
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If the test reveals a problem, you may be able to correct it
by using Disk First Aid or another disk repair program, or you
may have to reinitialize the disk. Consult a specialist
for assistance if necessary.

Chapter 8

Organizing Your Files

Straightening up your files

In this chapter

To accomplish this . . .

Do this . . .

m Straightening up your files

Straighten up all icons in
the active window

Choose the Clean Up Desktop command
from the Special menu

Straighten up selected
icons only

Hold down the Shift key
while choosing Clean Up Desktop

m Using folders to organize your files
m Filing documents when you save them
m Making items easier to find
m Finding an item
m Creating a template or stationery
m Getting information about your files

Arrange icons alphabetically Hold down the Option key
by name, or by the
while choosing Clean Up Desktop
list view displayed most
recently in that window
Line up icons near the right Click the desktop, then hold down the
edge of the desktop
Option key while choosing Clean Up Desktop

m Assigning a label to a file
m Tips on transferring files
You can also have icons arrange themselves in a staggered grid
when you choose Clean Up. See the chapter on adapting your
computer to your own use.
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Using folders to organize your files

Creating and naming folders

Macintosh folders, like the paper folders in a file cabinet, can be
used to store and organize your work. You can place one folder
inside another to create a hierarchy of files.

You can create a new folder whenever the Finder is the active
program.

A new folder appears in the active window (or on the desktop
if no window is active). The name is already selected.

Hard disk

Budgets

1. Choose New Folder from the File menu.

Proposals

2. Type a name for the folder and press Return.
Feasibility
studies

Résumés

Issues
list

If this doesn’t work, click the folder’s name to select it, and
try again.
You move, copy, and remove folders in the same way that you do
other icons.

Comments

Draft 1

Draft 2
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Draft 3

Many programs also let you create and name a new folder in the
dialog box that appears when you save a document.

Filing documents when you save them
The first time you save a document (or whenever you choose Save
As to create another version of that document), a directory dialog
box appears. A directory is the list of files and folders contained in
a folder or on a disk.

You use this box to name your document and indicate where
to store it. Directory dialog boxes vary slightly from program
to program, but all share certain features.

Use this pop-up menu to see the
directory of a higher-level folder
or disk.

This directory lists the
contents of the folder or
disk named above it.
Double-click a folder to see
its contents.

Type a name for your
document here.

The disk that contains the directory
that’s currently displayed.

Click to see the items on the Macintosh
desktop, including other disks.
Click to create a new folder in the
directory that’s currently displayed.

Click to save your document
in the directory that’s currently
displayed.
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Making items easier to find

Uses for aliases

Your PowerBook provides several ways to make a file, folder,
or other item easy to find and open. You can

Alias for

Location

Purpose

Any item that
could be stored
in several places

Everywhere the
item belongs

You can get access to an
item from several places.

Apple Menu
Items folder

On the desktop

You can easily add or
remove Apple menu items.

Creating an alias

A program that
must stay with
certain files

On the desktop;
in the Apple
menu

You can start the program
without opening the folder
or disk where it is stored.

An alias represents and points to a file, folder, disk, or other item
(even a shared item on a network). You can make as many aliases
for an item as you want.

A document or
folder stored on
a separate disk

Anywhere on
your work disk

When opened, the alias
asks for the disk by name,
then opens the original
when the disk is inserted.

An item on a
shared disk

Anywhere on
your work disk

When opened, the alias
automatically connects to
the shared disk and opens
the item.

m create aliases for the item and put the aliases in convenient
locations
m install the item (or its alias) in the Apple (K) menu
m move the item (or its alias) to the desktop

1. Click to select the item you want to make an alias for.
2. Choose Make Alias from the File menu.
The name of the alias appears in italics and ends with “alias.”
3. If you wish, type a new name for the alias (the name is
already selected), and then move it to a new location.

v Trouble? If you open an alias and nothing happens, or if
you see a message that the original file isn’t available, then
the original has been deleted or the alias is damaged. You
can open the alias’s Info window to find out where the
original is. v
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Locating the original of an alias

Installing an item in the Apple menu

An alias’s Info window shows the location of the original.

You can install any item in the Apple menu, and then open the
item by choosing it from the menu.

1. Select the alias whose original you want to find.
2. Choose Get Info from the File menu.

1. Open the System Folder icon and locate the Apple
Menu Items folder.
2. Drag the item you want to install (or its alias) into the
Apple Menu Items folder.
The item appears immediately in the Apple menu.

Location of the
original—includes
folder levels and
disk name (if the
original is on a
different disk)

3. Click the Find Original button.

You remove an item from the Apple menu by opening the Apple
Menu Items folder and dragging its icon out of the folder.
v Trouble? If the Apple menu does not contain the items
it should, make sure that the Apple Menu Items folder is
in the System Folder of your startup disk. If it is, open the
folder to check that all the items you want in the menu appear
there. v

Moving an item to the desktop

The window containing the original item opens. The icon is
selected. (If the original is on another disk, you’re asked to
insert the disk.)

You can make an item easy to find by dragging its icon to the
desktop. The icon stays there until you remove the disk on which
the item is stored.

If you deleted the original, or if it is on a shared disk that’s not
available, you’ll see a message that the original can’t be found.
Aliases are not deleted when the original is deleted (and vice
versa).

If you’ve placed an icon on the desktop, you can put it back in its
original location by selecting the item and choosing Put Away
from the File menu.
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2. Type the name (or part of the name) of the item you
want to find.

Finding an item
When the Finder is the active program, you can use the Find
command in the File menu to find any item on any disk
connected to your computer. (The Find command cannot locate
items inside the System file. You need to open the System file to
see its contents.)

Finding an item by name
1. Choose Find from the File menu.
The dialog box that appears lets you find an item by name.
Type the name (or
partial name) you
want to find.
Click to start a search.
Click to choose additional
search criteria.

If the dialog box you see has more items than shown here,
click the Fewer Choices button in the lower-left corner.
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Capitalization does not have to match.
3. Click the Find button.
The first item that matches the name you typed is shown
highlighted in a Finder window. If an item is found on the
desktop, you see a message. If no item matches, you hear an
alert sound.
4. To see the next matching item, choose Find Again from
the File menu.
If no more items are found, you hear an alert sound.

Finding an item using other criteria

The content of the middle pop-up menu and the text area
vary according to the item selected in the left pop-up menu.

You can use the Find command to find items by size, label, date,
or other characteristics.

3. Choose an item from the left pop-up menu.

1. Choose Find from the File menu.

4. Choose an item from the middle pop-up menu.

2. If you see a button labeled More Choices, click the
button.

5. Adjust the date, choose an item, or type text in the
upper-right area of the dialog box.

The dialog box that appears lets you select search
characteristics using pop-up menus.
Pop-up menus
of search
characteristics

Type text or set
a date here.

Click a number to select it;
click the up or down
arrow to change it.

Click to show search
results all at once (instead
of one at a time).

continues .
Click to display the
smaller dialog box
that searches for
names only.

Pop-up menu of
search locations

Click to start a
search.
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6. Choose a search location from the pop-up menu
labeled Search.

8. Click the Find button when you’ve finished selecting
options.
The first matching item is shown highlighted in a Finder
window. To see the next matching item, choose Find Again
from the File menu. If the item is found on the desktop, a
message appears. If no item is found, you hear an alert sound.
When you display items all at once, they are shown
highlighted in an outline view.

Location for the search

7. If you want all items displayed at once, click the
checkbox labeled “all at once.”
A list view, Indentation means that an item
in outline
is located inside a folder.
form, shows
the contents
of folders.

124 Chapter 8: Organizing Your Files

Finding items that meet two criteria

Ways to use the Find command

You can locate items that meet two sets of criteria, such as all
items created before a certain date and larger than a certain size.

The Find command can help you locate files quickly, organize
documents, and develop an efficient system for backing up and
archiving your work.

1. Choose the first criterion.
2. Click the “all at once” box so that an X appears.

This characteristic

Can be used to locate

Name

1. Files whose names you can’t recall exactly
2. All items for which you use a standard name,
such as status reports or expense reports

Kind

1. All application programs
2. All aliases

Size

Large files, to make space available on a disk

5. Choose the second criterion.

Label

6. Choose “the selected items” in the pop-up menu
labeled Search.

All the files to which you added the same
label (such as “top secret”)

Lock

Locked files, to unlock them for editing

7. Click Find to begin the second stage of your search.

Modification date

All files changed since a certain date,
to back up new and changed files

Creation date

All files created before a certain date,
to archive or erase outdated material

3. Click the Find button.
The items found are shown highlighted in an outline view.
4. Choose the Find command again, before you click or
take any other action.
You choose Find immediately so that the items located in the
first stage of the search remain highlighted.

The items meeting both criteria are highlighted.
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Creating a template or stationery
Most documents can be saved as or converted into a stationery
pad, which is a template form of the document. The template
retains its format and content, and you can use it repeatedly as a
master for similar documents with different content.
Many programs let you save a document as a stationery pad when
you choose Save or Save As. Click the stationery pad option to
save your document as a template.

Stationery pad icon

Regular
document icon
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Click here to save the
document as a stationery
pad.

If the program you’re using does not offer a stationery pad
option, you can use a document’s Info window to create a
stationery pad.
1. Click the document icon to select it.
2. Choose Get Info from the File menu.
3. Click “Stationery pad” near the lower-right corner
so that an X appears in the checkbox.

4. Close the Info window.
The document icon now appears as a stationery pad icon.
When you open a stationery pad, an untitled window appears
showing the contents of the stationery, or a dialog box appears
asking you to name the new document.

Using the Info window
The Get Info command displays information about a
selected item.
1. Click to select the item you want information about.
2. Choose Get Info from the File menu.

If you want to change the stationery pad itself you must first turn
it back into a regular document. You can do this by opening the
stationery pad’s Info window and clicking “Stationery pad” to
remove the X.

Getting information about your files
When the Finder is the active program, you can obtain
information about your files in two places:
m in the file’s Info window
m in the View menu
You can type comments in the Info window and use the
Find command to search for them later.
3. Close the window.
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Using the View menu

Assigning a label to a file

You can use the View menu to display the contents of a window
by icon or small icon, or you can list items according to various
characteristics such as name, size, or kind. (You can use the Views
control panel to change how files are listed and what information
is included in the list. See the chapter on adapting your computer
to your own use.)

You can add a label and its associated color (or shade of gray) to a
file. Labels provide a way to group related files (choose By Label
from the View menu). If you have a color or gray-scale monitor,
you can identify related icons by assigning a label and color to
each group.

Windows are preset to show icons. You can also display items in a
list by choosing a command from the View menu. For example,
listing items by the date and time of their most recent
modification makes it easy to back up files you have changed
recently.
The type of list displayed is underlined.

When the contents of a window are displayed as a list, you can
click any column heading (such as Size or Last Modified) to
rearrange the list according to that characteristic.
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The label is visible only when the contents of a window are
displayed as a list. The color is visible whenever your computer is
set to display colors or grays.
To assign a label and color to an icon, click the icon to select it and
then choose the label and color that you want from the Label
menu. If your monitor is not set to display colors or grays, no
colors appear in the Label menu.

Tips on transferring files
You can transfer files from your computer’s internal hard disk in
the following ways:
m Over a network
You can connect your computer to a network and transfer files
over the network. For information, see the networking
chapter.
m Over telephone lines
If your computer is connected to a modem or has a modem
installed, you can transfer files over telephone lines using an
appropriate communications program. For more information,
see the chapter on expanding your computer system.

m On floppy disks
If your computer has a built-in floppy disk drive or is
connected to an external floppy disk drive, you can transfer
files from your computer’s internal hard disk to a floppy disk.
(If your computer does not have a built-in floppy disk drive,
see the chapter on expanding your computer system for
instructions on connecting a disk drive.)
m On another hard disk
If your computer is connected to another hard disk, you can
transfer files from your computer’s internal hard disk to
another hard disk. For instructions on connecting a hard disk,
see the chapter on expanding your computer system.
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Chapter 9

Sound, Color, and Video
In this chapter
m Setting the beep sound

Setting the beep sound
Many programs have the computer make a sound when your
attention is required or when you’re attempting an action that the
computer cannot perform at that time.

m Installing a sound

You can choose the type of beep sound that you want your
computer to make. You can also set the sound’s volume.

m Removing a sound

1. Choose Control Panels from the Apple (K) menu.

m Recording sounds

2. Open the Sound control panel.

m Displaying colors or grays
m Changing the highlight color
m Changing the color of window borders
m Changing the background pattern
m Assigning a color to an icon
m Changing the colors or grays in the Labels menu
m Using more than one monitor

The Sound control panel appears. The beep that your
computer is currently using is already selected.
continues .

m Controlling automatic screen dimming
m Magnifying the screen image
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3. Click the beep sound that you want your computer to
use.

Installing a sound
Your computer comes with several beep sounds. You can get
additional sounds from various sources.
m To install a sound, you drag its icon to the System
Folder icon (not the System Folder window). The sound
is automatically installed in the System file, where it
belongs.

When you click a sound to select it, it’s played at the current
volume setting.
4. Drag the slider up or down to set the volume.
If you set the volume to zero, instead of hearing a beep, you’ll
see the menu bar flash.
5. Close the Sound control panel.
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Once you add a sound to the System file, it is listed in the Sound
control panel.

Removing a sound

Recording sounds

You can remove sounds in the Sound control panel. Make sure
you have a backup copy of the sounds on floppy disk. (To copy a
sound, you can open the System file to see its icon.)

If your computer has a built-in microphone, or a sound input port
(X), you can record a sound and add it to the Sound control
panel. (See the chapter on expanding your computer system for
information on connecting a microphone or other audio source.)

1. Choose Control Panels from the Apple (K) menu.

3. Click to select the sound you want to remove.

1. If your computer does not have a built-in microphone,
connect a microphone or another audio source to your
computer.

4. Choose Cut from the Edit menu.

2. Choose Control Panels from the Apple (K) menu.

2. Open the Sound control panel.

If you selected the wrong sound, you can choose Paste to
restore the sound.
5. Close the Sound control panel.
You can also remove a sound by opening the System file and
dragging the sound’s icon out of the System file and out of the
System Folder.

3. Open the Sound control panel.
The Sound control panel appears. The icons of the available
sound input devices appear near the bottom of the window.
4. Click the icon of the sound input device you want to
use.

continues .
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5. Click the Add button.

10. Type a name for the sound, and click OK.

6. Get ready to record, then click the Record button.
Recording begins immediately. You have ten seconds to
record your sound. There is no volume control.

The new sound appears in the Sound control panel. Its icon also
appears in the System file.

7. Click Stop to stop recording.
8. To listen to the sound you recorded, click Play.
9. To save the sound you recorded, click Save.
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Displaying colors or grays
You can designate how many colors or shades of gray you want
your monitor to display. (How many colors or grays your
computer can display depends on the video capability it has. See
the technical specifications of your computer for more
information.)
You set the number of colors or grays in the Monitors control
panel.
1. Choose Control Panels from the Apple (K) menu.
2. Open the Monitors control panel.

3. If you have more than one monitor, click the icon of
the monitor you are adjusting.
A dark border appears around the icon to show that it is
selected.
4. Click the Grays or the Colors button.
5. Click the number of colors or grays you want displayed
on the selected monitor (or click Black & White).
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Changing the highlight color or gray
You can change the color or shade of gray your computer uses to
highlight selected text on the screen. You make this adjustment in
the Color control panel.

1. Choose Control Panels from the Apple (K) menu and
open the Color control panel.
2. Press the “Highlight color” pop-up menu to open it and
drag to choose a color or choose Other.
The selected color appears in the “Sample text” box.
If you choose Other, a dialog box appears.
New color is in top half,
current color is in bottom half

Circle
indicates
selected
color.
Brightness
control

You can also use the Color control panel to change the color of
window borders.

Numbers correspond
to the selected color
on the wheel.
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Wheel shows colors available.
(When four colors are selected,
letters appear in the wheel
indicating color values.)

3. To change the brightness of the color wheel, drag the
scroll box up or down.

Changing the color of window borders

4. Click a color on the color wheel to select it.

You can change the color of window borders. You make this
adjustment in the Color control panel.

The new color is displayed in the top half of the square. The
current color remains in the bottom half of the square for
comparison; you can click there to go back to it.

1. Choose Control Panels from the Apple (K) menu and
open the Color control panel.

5. To experiment with other colors, drag the pointer
around the wheel or click at another point on the
wheel.
6. Click OK when you have selected the color or shade of
gray you want.
The new highlight color is displayed in the “Sample text” box
in the Color control panel.

Pop-up menu of
highlight colors
Pop-up menu of
window colors

2. Press the “Window color” pop-up menu and drag to
choose a new color.
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Changing the background pattern
You can change the background pattern that appears on your
computer screen in the General Controls panel.

You can choose from a variety of patterns provided, or you
can create your own design by editing one of the patterns
supplied. You can also use the colors or grays you want in the
pattern.

1. Choose Control Panels from the Apple (K) menu and
open the General Controls panel.
Color bar appears if
your monitor is set to
display colors or grays.

2. To see the patterns available, click either of the small
triangles above the sample pattern.
3. Click the sample pattern to see the new pattern on
your desktop.
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4. To edit a pattern, click in the pattern editing area to the
left of the sample pattern.
Each dot in the square changes color when you click it. Your
changes are displayed in the sample pattern.
Pattern editing area
(magnified view of pattern)
Sample pattern
Color bar for selecting colors or grays

Assigning a color to an icon
You can assign a color (or shade of gray) and its associated label to
an icon. Labels and colors are a way to group related files (choose
By Label from the View menu). On a monitor set to display colors
or grays, you can identify groups of icons by assigning a color and
its label to each group.
To assign a color and its label to an icon, click the icon to select it
and then choose the color and the label from the Label menu.
Instructions on changing the colors in the Label menu are in this
chapter.

5. To use another color, click it in the color bar, then click
the dots you want to change.
The color bar appears if your monitor is set to display colors
or grays. You can choose a new color by double-clicking a
color in the color bar and using the color wheel that appears.
6. When you’ve finished creating your new pattern, click
the sample pattern to display it on your desktop.
7. To save the new pattern, double-click the sample
pattern.
If you don’t save the pattern, you lose it when you click one of
the small triangles to display another pattern.
8. Close the control panel.
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Changing the colors in the Label menu
You can change the colors or shades of gray (as well as the labels)
in the Label menu. You make these changes in the Labels control
panel.
1. Choose Control Panels from the Apple menu (K) and
open the Labels control panel.

2. Click the color you want to change.
A dialog box appears.
New color is in top half,
current color is in bottom half

Circle
indicates
selected
color.
Brightness
control

Numbers correspond
to the selected color
on the wheel.
To change a color, click it.
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Wheel shows colors available.
(When four colors are selected,
letters appear in the wheel
indicating color values.)

3. Click a color on the color wheel to select it.
The new color is displayed in the top half of the square. The
current color remains in the bottom half of the square for
comparison; you can click there to go back to it.

1. Choose Control Panels from the Apple (K) menu and
open the Monitors control panel.

4. To experiment with other colors, drag the pointer
around the wheel or click at another point on the
wheel.
5. Click OK when you have selected the color or shade of
gray you want.

Click to see the video card used
by the selected monitor.

6. Close the Labels control panel.
Drag this bar to the monitor where
you want the menu bar.

Using more than one monitor
If you use more than one monitor with your computer, you need
to set the monitors’ positions and designate one as the main
monitor (the one that displays the menu bar). For instructions on
connecting an additional monitor to your computer, see the
chapter on expanding your computer system.
You make these adjustments in the Monitors control panel.

The dark line indicates the
selected monitor.
Click to display each monitor’s
number.
Indicates the range
of colors or grays
selected

Icons for the monitors connected to the PowerBook,
showing ID numbers and relative positions

continues .
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2. Check the ID numbers of your monitors by clicking the
Identify button.
A large number appears in the center of each monitor’s
screen; it corresponds to the number of the icon in the
control panel. The ID numbers help you identify which icon
represents which monitor.
3. Decide which monitor is your main monitor and drag
the menu bar to the top of that monitor icon.

Using a second monitor for presentations
You can use a second monitor connected to your computer to
show whatever is displayed on your built-in monitor. This
capability is useful when you’re making a presentation to a group.
You turn this capability on or off in the PowerBook Display control
panel.
1. Choose Control Panels from the Apple (K) menu and
open the PowerBook Display control panel.

You may want to make the largest one the main monitor
because some programs limit their window size to the size of
the main monitor, or you may want to make your color
monitor the main monitor.
4. Drag the icons to approximate the positions of your
monitors.
The pointer can move from one screen to another where the
monitors’ icons touch in the control panel.

2. Click the On or Off button under Video Mirroring.

5. Choose Restart from the Special menu.

3. Restart your computer.
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Magnifying the
screen image
The CloseView control panel lets you magnify
the image on your computer screen up to
sixteen times. It is supplied as part of your
system software.
CloseView is not automatically installed by
the Installer program when you install system
software.
To install CloseView:
1. Locate the CloseView control panel.

2. Drag the CloseView icon to the
System Folder icon (not the System
Folder window) on your startup
disk.
3. Choose Restart from the Special
menu.
To turn CloseView on or off, press
x–Option–O.
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To turn the magnification on or off, press
x–Option–X. (When CloseView is on and
the magnification is off, a rectangle on
the screen indicates which area will be
magnified. You can move the rectangle by
moving the pointer.)
To increase or decrease magnification, press
x–Option–Up Arrow or x–Option–Down
Arrow.
You can set additional options in the
CloseView control panel. Choose Control
Panels from the Apple (K) menu and open
the CloseView control panel.
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Turns
CloseView on

Turns
magnification
on or off
Keyboard
shortcuts
Arrows
change
magnification
power
Inverts
screen
image

Turns shortcuts on
or off

Chapter 10

Adapting Your Computer
to Your Own Use
In this chapter
n

n

Adjusting the way the trackball or mouse works

n

Adjusting the way the keyboard works

n

Making keyboard shortcuts easier to type

n

Adjusting the keyboard for very slow typing

n

Adjusting the blinking of a menu item

n

Adjusting the blinking of the insertion point

n

Changing the way the contents of windows appear

n

Changing an icon

n

Turning off the Empty Trash warning

n

Managing memory

Specifying which items you want opened at startup
Installing an item in the Apple menu

n

Installing files in the System Folder

n

Changing the labels in the Label menu

n

n

Setting the time and date

n

Setting a time for the Alarm Clock to go off

n

Turning the alarm off

n

Changing time and date formats

n

Changing number and currency formats
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Specifying which items you want opened
at startup
To have a program or a document open automatically when
you start up your computer, drag its icon or its alias to the Startup
Items folder, which is inside the System Folder. Programs or
documents that you put in the Startup Items folder are opened
when you start up your computer. You can open as many files as
your computer’s memory allows.
If you no longer want a file to open automatically when you start
up your computer, remove the icon or alias from the Startup
Items folder.

Installing an item in the Apple menu
To have an item’s name appear in the Apple (K) menu, drag its
icon or its alias to the Apple Menu Items folder, which is inside
the System Folder.
You remove an item from the Apple menu by opening the Apple
Menu Items folder and dragging the item out of the folder.
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Installing files in the System Folder
Certain files need to be installed in the System Folder so your
computer can use them as part of the system software. These files
include
n

system extensions and control panels

n

preferences for application programs

n

software that controls printers, scanners, and other
equipment

n

sounds

n

fonts

Usually, you install these files by dragging their icons to the
System Folder icon (not the System Folder window). Sometimes
these files need to be installed by a program that comes with the
files. Check the instructions that came with the files for any
specific installation procedure.

Most special files are stored in folders inside the System Folder.
When you drag a file’s icon to the System Folder icon, your
computer recognizes which type of file it is and stores the file in
the appropriate folder.
This folder holds networking
and printing software and
files that extend your
computer’s capabilities.

The System file holds sounds,
and keyboard files.

Removing files from the System Folder
You remove a file from the System Folder by dragging its icon out
of the System Folder.
Depending on the equipment you use, whether or not you’re on a
network, and how you use your computer, you can remove the
following items from your System Folder if you want to conserve
space on your startup disk:
n

This program
manages the
Macintosh
desktop.

n

n

This folder holds settings
for application programs.

This file holds items you
put in the Scrapbook.
n

If you drag an item to the System Folder window instead of the
System Folder icon, the file is not stored in the appropriate folder
automatically, and it may not work properly.

software for printers or other devices you don’t use (for
example, the AppleTalk ImageWriter driver)
networking software, if you are not on a network (and don’t
plan to be) and don’t use AppleTalk Remote Access
Apple menu items you don’t use (you need the control
panels, but you may not need the Calculator or the Puzzle, for
example)
fonts, sounds, or keyboard files you don’t use

Be sure you have backup copies of the files on floppy disks before
you remove them from your System Folder.

Items you want in the Apple Menu Items folder or the Startup
Items folder need to be dragged to either folder directly. (This
chapter has instructions for installing Apple menu items and
specifying the items you want opened at startup.)
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Changing the items in the Label menu

Setting the time and date

You can change the labels (as well as the colors) in the Label
menu. You make these changes in the Labels control panel.

Your computer has a clock that keeps track of the time and date (a
battery keeps it running when the computer is turned off ).

1. Choose Control Panels from the Apple (K) menu and
open the Labels control panel.

Many programs rely on the clock to automatically enter times and
dates in documents you create or print, and the Finder uses it to
keep track of when files are created or changed.
m Choose Control Panels from the Apple (K) menu and open
the Date & Time control panel.

Labels

Colors

2. To change a label, drag across it to select it and then
type your new label.
To change a color, double-click it and choose a new color. For
more instructions, see the chapter on sound and color.
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Setting a time for the Alarm Clock to go off
You can set the Alarm Clock to alert you when it’s time for an
appointment or a meeting.
1. Choose Alarm Clock from the Apple (K) menu.
To set the date, click the month, date, or year to
select it, then click the up or down arrow (or type
the new number).

To set the time, click the
hours, minutes, or seconds
to select them, then click
the up or down arrow (or
type the number).

2. Click the upward-pointing lever near the upper-right
corner to expand the Alarm Clock.

The lever points downward, and the Alarm Clock expands to
its full size.

You can also set the time and date using the General Controls
panel or the Alarm Clock.

continues .
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3. Click the alarm clock icon in the lower-right corner to
select it.
The alarm clock icon becomes highlighted when you select it.
The time that appears in the middle section is the current
alarm clock setting.

Button in the upper position
indicates that the alarm is on.

Icon showing ringing alarm

8. Click the close box to close the Alarm Clock.
The alarm will not go off unless you close the Alarm Clock,
click the lever to make the Alarm Clock smaller, or make
another window active.
4. Click the hours, minutes, or seconds in the alarm clock
setting to select them.
Up and down arrows appear to the right of the time display.
5. Click the up or down arrows repeatedly until the
number you want appears.
6. Repeat steps 4 and 5 as necessary.
7. Click the button to the left of the alarm clock setting to
turn the alarm on.
The button and the alarm clock icon change to indicate that
the alarm is turned on. (Clicking again turns the alarm off.)
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Turning the alarm off
When the system clock reaches the time set for the alarm, the
alert sound plays twice and an alarm clock icon blinks over the
Apple icon at the left end of the menu bar.
To turn off the alarm, choose Alarm Clock from the Apple (K)
menu and click the button to the left of the alarm clock setting.

Changing time and date formats
You can change how times and dates appear based on personal
preference or local custom.

Changing the date format
1. Choose Control Panels from the Apple (K) menu and
open the Date & Time control panel.
2. In the Date & Time control panel, click Date Formats.

3. In the dialog box that appears, make the changes you
want.
A sample of the format you choose appears at the bottom of
the dialog box.
4. Click OK to close the control panel.

Choose standard formats
from this pop-up menu.
Type prefix and separators
in these boxes.
Use this pop-up menu to set the
order of elements in the date.
Use these pop-up menus to set the
order of elements in the date.

Type the separator between
date elements here.

Click here to add
a zero before
a single-digit number.
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3. Make the changes you want.

Changing the time format

A sample of the format you choose appears at the bottom of
the dialog box.

1. Choose Control Panels from the Apple (K) menu and
open the Date & Time control panel.
2. In the Date & Time control panel, click Time Formats.

4. Click OK to close the control panel.

Choose standard formats
from this pop-up menu.

When you choose the
12-hour clock, you can
also choose either 0:00
or 12:00 to represent
noon and midnight.
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Type the text that identifies
before and after noon here.
Type the separator between hours,
minutes, and seconds here.

Changing number and currency formats

2. Make the changes that you want.

You can choose among several formats for displaying numbers
and currency.

3. Close the control panel.

1. Choose Control Panels from the Apple (K) menu and
open the Numbers control panel.

Choose standard formats
from this pop-up menu.

Type the decimal separator
here or choose a separator
from the pop-up menu.

Type the thousands
separator here or
choose a separator from
the pop-up menu.

Type the currency symbol here.
To place the currency
symbol before or after the
number, click a button.
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Adjusting the way the trackball or
mouse works
You can adjust two aspects of trackball or mouse operation in the
Mouse control panel: tracking, which is the relation between
trackball or mouse movement and pointer movement on the
screen, and double-clicking speed.
1. Choose Control Panels from the Apple (K) menu and
open the Mouse control panel.

2. Click the tracking speed you want.
The Very Slow option is useful for drawing or for a graphics
tablet because the pointer moves at a constant speed relative
to trackball or mouse movement.
3. Click the double-clicking speed you want.
Adjust the double-clicking speed if your computer often
interprets two clicks as a double click, or a double click as two
single clicks.
The space between arrows
corresponds to the time
between clicks.
Mouse button highlights twice
at the interval selected.

4. Close the control panel.
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Adjusting the way the keyboard works

2. To adjust the rate at which a key repeats when it is held
down, click the button for the rate you want.

You can adjust the rate at which a character repeats when its key is
held down as well as the delay before the character begins
repeating. You can also change the keyboard layout if you have
additional keyboard layouts installed.

3. To adjust the delay before keys repeat, click the button
for the delay you want.

1. Choose Control Panels from the Apple (K) menu and
open the Keyboard control panel.

If the keys repeat when you don’t want them to, set a longer
delay before a character begins repeating. (If you click the Off
button, the keys don’t repeat at all.)
4. To change the keyboard layout, click the name of the
keyboard layout you want to use.
You may have a choice of more than one keyboard layout.
(Additional keyboard layouts are available from various
sources. You install them by dragging them to the System
Folder icon.)

Options for the speed at
which a character repeats

5. Close the Keyboard control panel.
Options for delay
before a key repeats
Options for keyboard
layout (if more than one
is installed)
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Making keyboard shortcuts easier to type

Adjusting the keyboard for very slow typing

With the system software feature called Sticky Keys, you can type
keyboard shortcuts (such as x-S for the Save command) without
actually pressing the keys simultaneously.

The system software feature called Slow Keys lets you type very
slowly and ignores accidental keystrokes by delaying the
acceptance of the next keystroke.

n

To turn Sticky Keys on or off, press the Shift key five
times without moving the mouse.

With Sticky Keys on, you can type a keyboard shortcut by first
pressing the modifier key (x, Option, Control, or Shift) and then
pressing the character key. An icon in the right end of the menu
bar (to the right of the Application menu icon) changes to
indicate whether Sticky Keys is on and whether a modifier key has
been pressed or locked.

Sticky Keys
is on.

A modifier
key has been
pressed.

A modifier key is locked
(pressing the key again
unlocks it).

You can have Sticky Keys beep when a modifier key is pressed.
You set this option in the Easy Access control panel. Choose
Control Panels from the Apple (K) menu and open Easy Access.
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n

To turn Slow Keys on or off, hold down the Return key
for about four seconds. A beep signals when the feature
has been turned on or off.

You can adjust how long you want Slow Keys to delay acceptance
of the next keystroke. You can also set Slow Keys to make an
audible click each time a keystroke is accepted. You make these
adjustments in the Easy Access control panel. Choose Control
Panels from the Apple (K) menu and open Easy Access.

Adjusting the blinking of a menu item

Adjusting the blinking of the insertion point

You can change the number of times a menu item blinks when it’s
chosen. You make this adjustment in the General Controls panel.

You can adjust how quickly the insertion point blinks (the
insertion point indicates where any text you type will appear). You
make this adjustment in the General Controls panel.

1. Choose Control Panels from the Apple (K) menu and
open the General Controls panel.
2. Click the button for the number of times you want the
menu item to blink.

1. Choose Control Panels from the Apple (K) menu and
open the General Controls panel.
2. Click the button for the blinking rate you want.

Clicking the Off button prevents a menu item from blinking.

The insertion point in the control panel blinks at the rate you
selected.
3. Close the control panel.
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Changing the way the contents
of windows appear

Options for clean-up
of icons

Pop-up menu of fonts for icon
names and list views
Pop-up menu of font
sizes for icon names
and list views

You can change the way the contents of Finder windows are
displayed, and you can change the items in the View menu. You
make these changes in the Views control panel. Choose Control
Panels from the Apple (K) menu and open the Views control
panel.

Option to snap icons
to an invisible grid
whenever they are
moved
Checked items
appear in the
View menu.
Options for the size
of icons displayed in
list views

Options for information
displayed in list views

Use the Views control panel to change
n

the font and font size used in all views (press to open the
pop-up menu, then drag to choose a font or a size)

n

the arrangement of icons or small icons

n

the size of icons used in list views

n

what information is included in list views, including folder
sizes and the amount of available space on disk
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See the summary and shortcuts section near the end of this book
for more information about using windows and list views.

Changing an icon

2. Copy the picture by choosing Copy from the Edit menu.

You can change an icon by creating or copying a picture you want
and then pasting it into an icon’s Info window.

3. Switch to the Finder, then click to select an icon you
want to change.

Some icons can’t be changed, including those for control panels
and other parts of the system software. Every icon fits inside a
small square.

4. Choose Get Info from the File menu.

1. Select the picture you want to use for the icon.

5. Click the icon at the upper-left corner of the Info
window to select it.
A box appears around the icon when it’s selected. If no box
appears when you click, the icon can’t be changed.

continues .
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6. Choose Paste from the Edit menu.
The picture you copied replaces the selected icon in the Info
window. If the picture is bigger than the icon, it automatically
shrinks to fit.

Turning off the Empty Trash warning
When you choose Empty Trash from the Special menu, a message
warns you that you will not be able to recover the contents of the
Trash once it’s emptied. (The warning helps you avoid throwing
away items unintentionally.)
You can turn off this warning in the Trash’s Info box.
1. Click the Trash icon to select it.
2. Choose Get Info from the File menu.

7. Close the Info window.
You can restore the original icon by clicking the picture in the
upper-left corner of the Info window and choosing Cut from the
Edit menu.

3. Click the checkbox labeled “Warn before emptying” to
remove the X.
To turn the warning back on, click the checkbox so that an X
appears.
You can also override the warning by holding down the Option
key when you choose the Empty Trash command.
Until you choose Empty Trash, items in the Trash continue to
occupy space on your disk.
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Managing memory

Making the most of your memory

Occasionally you may need to make adjustments in how your
PowerBook uses its random-access memory (RAM) in order to
work efficiently with large programs or with several programs at
once.

Remember the following tips on memory management:

Checking memory use

n

n

You can find out how much memory your computer has, how
much of it is available, and how much memory is being used by
each program you have open. You find this information by making
the Finder the active program and choosing About This Macintosh
from the Apple menu.

n

Total memory available
The largest program
(including virtual memory) you can open now
n

n

Open
programs

Memory
allocated for
each program

Closing a document window does not quit the program. The
program remains open and uses memory until you choose
Quit from the File menu. (The Application menu, at the right
end of the menu bar, shows which programs are open.)
If you have opened and quit several programs, your
computer’s memory may be fragmented and you may not be
able to open a program that requires a lot of memory. To
solve this problem, you can restart your computer.
If you’re not using network services (such as electronic mail
or a shared printer), you can make more memory available by
turning off AppleTalk in the Chooser and restarting your
computer.
If you’re not sharing files over a network, you can make more
memory available by turning off file sharing. (See the chapter
on networking for more information.)
Removing system extensions you don’t need makes memory
available (for example, you don’t need the AppleShare
extension if your computer will never be on a network and
you don't use AppleTalk Remote Access).

The bar indicates how much memory a
program reserves for its own use. The dark
portion is the amount it is actually using.
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n

n

Reducing the size of the disk cache makes more memory
available. (See the disk cache section in this chapter.)
Reducing the amount of memory a program uses may allow
you to open more programs at once (see the chapter on
setting up your programs).

You set the size of the disk cache in the Memory control panel.
1. Choose Control Panels from the Apple (K) menu and
open the Memory control panel.

Adjusting the disk cache
The disk cache is memory set aside to help programs work more
quickly and efficiently. But the memory in the disk cache is not
available for opening programs or documents. If you often want
to open more programs than memory allows, you can set the disk
cache to a smaller size.

2. Click the up or down arrows next to the Cache Size
box.

Arrows adjust cache in
preset amounts.

3. Choose Restart from the Special menu.
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Using hard disk space as memory

2. Click the On button to turn on virtual memory.

Your computer can use space on a hard disk to increase the
memory available for opening programs. The disk space, called
virtual memory, is not available for storing files.

3. Press the pop-up menu and drag to choose a hard disk
to use for virtual memory.

Your computer should contain enough built-in memory for your
regular needs—that is, for the programs you frequently have open
simultaneously. You can use virtual memory when you want to
open additional programs or work with extremely large
documents.
Virtual memory is most effective when you are using several small
programs simultaneously. It slows the computer’s performance if
you’re using one very large program.
You adjust the use of virtual memory in the Memory control
panel.
1. Choose Control Panels from the Apple (K) menu and
open the Memory control panel.

4. Click the up and down arrows to set the amount of disk
space to be used as virtual memory.

Pop-up menu of hard disks in use
Space available on the disk
Macintosh HD
Total memory (includes
virtual memory)

The preset amount is equal to the amount of RAM installed in
your computer. Choosing a larger amount of virtual memory is
likely to slow the computer’s performance, so it is
recommended that you accept the preset size.
continues .
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5. Choose Restart from the Special menu.

Turning on 32-bit addressing

After you restart, your computer’s total memory includes the
virtual memory you set aside on the hard disk. Choose About This
Macintosh from the Apple (K) menu to see memory use
information.

Your computer can use very large amounts of memory (more than
8 megabytes) by taking advantage of a feature called 32-bit
addressing—the use of very long (32-digit) binary numbers to
control the way data is manipulated.

S Important: When you turn on virtual memory, the system
software creates a file named VM Storage in your System
Folder (if the startup disk is used for virtual memory) or
on the desktop (if another hard disk is used for virtual
memory). This file is large—the size of the computer’s RAM
and the selected amount of virtual memory combined. For
example, if your computer has 4 MB of RAM and you add
2 MB of virtual memory, the VM Storage file will occupy 6 MB
of space on your startup disk. S

You can turn 32-bit addressing on or off in the Memory control
panel.
1. Choose Control Panels from the Apple (K) menu and
open the Memory control panel.

2. Click the appropriate buttons in the control panel.

3. Choose Restart from the Special menu.
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Chapter 11

Printing
In this chapter
n

Before you print

n

Printing your work

n

Controlling background printing

n

Working with fonts

Before you print
Before you can print, your computer must be connected to a
printer, either directly or over a network. See the information that
came with your printer for instructions on how to connect it, or
check with your network adminstrator.

Choosing a printer
Once your printer is connected, you must tell your computer
which printer to use by choosing that printer. You need to do this
even if only one printer is connected to your computer. You
choose a printer when you’re using it for the first time and
whenever you change printers.
You choose the printer in a program called the Chooser. How you
use the Chooser depends on whether your printer is connected
directly or over a network.
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If your printer is connected directly to your computer
Make sure you’ve connected the printer according to the
instructions that came with it.
1. Choose Chooser from the Apple (K) menu.

If you have a Personal LaserWriter SC, you’re finished. Close
the Chooser now.
3. Click the icon of the port to which your printer is
connected.
If your printer is connected to the computer’s modem
port (marked with the icon W), you’re finished. Close the
Chooser now.

2. Click the icon of your printer to select it.

If your printer is connected to the computer’s printer
port (marked with the icon [), continue with step 4.
4. Click the Inactive button next to the word “AppleTalk.”
If Inactive wasn’t already selected, a message appears.
Click OK.
5. Close the Chooser window.

If your printer is connected over a network
Ask your network administrator or the person who set up your
computer to tell you
v If your printer’s icon does not appear in the Chooser:
The printer software is not in your System Folder. Close the
Chooser and install the software you need. If you have an
Apple printer, you can use the Installer to add the printer
software. If your printer is not an Apple printer, see the
information that came with it for instructions on installing its
software. v
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n

which printer you can use

n

which zone it’s in (if the network has zones)

n

what its name is (every printer on a network has its own
name)

1. Choose Chooser from the Apple (K) menu.

3. Click the icon of the printer you want to use.

2. Click the Active button next to the word “AppleTalk.”

v If your printer’s icon does not appear in the Chooser:
The printer software is not in your System Folder. Close
the Chooser and install the software you need. If you have an
Apple printer, you can use the Installer to add the printer
software. If your printer is not an Apple printer, see the
information that came with it for instructions on installing
its software, or check with the network adminstrator. v

If Active wasn’t already selected, a message appears. Click OK.
Types of devices available

Names of individual printers

4. If the Chooser lists AppleTalk zones, click the zone
where the printer is located.
Zones are listed alphabetically. If you know the name of the
zone, you can type the name to select it.
5. Click the name of the printer you want to use (even if
only one name appears).

Network zones (these appear only if
your computer is connected to a
network that has zones)

AppleTalk must be active
to use any network devices,
including network printers.

6. If you want to continue using your computer while
your documents are being printed, click the On button
next to Background Printing.
Background printing is not available with all printers. If it’s not
available, these buttons do not appear.
7. Close the Chooser.
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Selecting Page Setup options
You use the Page Setup dialog box when you’ve selected a new
printer in the Chooser, or when you want to use a different paper
size or printing options.
n

When an ImageWriter printer is selected, this Page Setup dialog
box appears:

Choose Page Setup from the File menu and select the options
you want.

When a LaserWriter printer is selected, this or a similar Page Setup
dialog box appears:
Pop-up menu of
special paper sizes

Printed copy as a
percentage of the
original’s size
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Click to open a dialog box where
you can select enhancements
to the printed image.

Each type of printer offers different options. Some programs
provide additional options. You can choose Show Balloons from
the Help menu and then point to options to see descriptions, or
check your printer or program manual for details.

Updating printer software on networked computers
All computers that share printers on a network must have the
same version of the printer software. The printer restarts itself
each time a different version is used (which takes time and clears
any fonts from its temporary memory).
S Important: All computers on a network must have the same
printer software versions in the System Folder. S
You or your network administrator should update the printer
software on all Macintosh computers on the network. You do not
have to update any files other than the printer software.
To update printer software, use the Installer program and the
accompanying Printer Update document (both files are on one of
the system software disks that came with your computer, or they
may be on a shared disk on the network).

1. Locate the Installer and Printer Update files, and then
open the Installer icon.
2. Click OK.
The Easy Install dialog box appears.
3. Make sure that the hard disk indicated is the
correct one.
Click the Switch Disk button until the correct disk name
appears.
4. If you want to install software for additional printers,
click the Customize button, and then select the names
of the printers you want to install software for.
continues .
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If you want to update the printer software that is already
installed on your disk, go to step 5.
When you click Customize, the custom installation dialog box
shows a list of printer software.
Printer software available

Printing your work
You can print a document while it’s open and its window is active;
you can also print documents while the Finder is active.
1. Make sure that the document you want to print is in
the active window.
If you’re printing in the Finder, select the documents you
want to print.
2. Choose Print from the File menu.
The printing options that appear depend on the selected
printer and the program in which the document was created.

Paper-feed
method

5. Click Install.
6. When you see a message reporting that installation was
successful, click Restart.
If a message reports that installation was not successful,
try again.
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Page range (clicking All prints the entire
document; entering page numbers in the From
and To boxes prints those pages only)

v Printing color or gray-scale documents: You can print color
or gray-scale documents on any color printer that can use the
LaserWriter printer software. If you print a color document on
a black-and-white printer, the document is produced as a
halftone (that is, it is composed of patterns of dots). v
Some programs offer additional printing options. See the
manuals that came with your programs for more information
on their printing features.
3. Click Print.
A status message appears. If background printing is turned on,
the message disappears after a few seconds, and you can do
other work while printing continues. Instructions on
controlling background printing are in this chapter.

Printing the contents of a window or the desktop
You can print a list of the contents of the active window when
you’re working in the Finder.
1. Make sure that the window whose contents you want to
print is active.
2. Choose Print Window from the File menu.
3. Select the options you want.
4. Click Print.
The window’s contents are printed, including items not visible
on the screen.
When no window is active, you can print the items on the desktop
by choosing Print Desktop from the File menu.
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Solutions to common printing problems
If nothing happens or if you see an error message when you try
to print, try the following:
n

Make sure that the printer is turned on and warmed up.

n

Check the cable connections to the printer.

n

n

n

n

n

If your printer is an ImageWriter, make sure that the Select
light is on. (If not, press the Select button.)
Make sure that the printer has paper and that the paper is
feeding properly.
Make sure that a printer (and its name or port) is selected in
the Chooser.
If you’re on a network, make sure that you are using the same
version of the printer software as everyone else.
If an error message states that the printer could not print your
document, turn off the printer for at least 10 seconds. Then
turn it on again, wait for the printer to warm up, and try to
print again.
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If fonts printed on a laser printer look jagged or if lines or letters
are missing, your computer may not have enough memory
available to print your document properly, the font may not be
available in your printer, or the font substitution option may be
turned off in the Page Setup dialog box. Try the following:
n

n

n

n

Make sure font substitution is turned on in the Page Setup
dialog box.
With background printing turned on, quit the program you’re
using immediately after you choose the Print command.
Transfer the fonts you need to your printer (see the section
on transferring fonts in this chapter).
Make use of fewer fonts and sizes in your document.

Controlling background printing

You can use PrintMonitor to

If you are using a LaserWriter or StyleWriter printer and the
background printing option is turned on in the Chooser, you can
continue to work while your documents are printing.

n

check the printing of your document

n

cancel a document that’s printing or waiting to print

n

You don’t need to do anything once background printing is
turned on. But if you wish, you can control background printing
with PrintMonitor, a program that’s part of system software.

n

A few moments after printing begins, PrintMonitor opens
automatically and its name appears in the Application menu.
n

Documents to be
printed next (a
selected item can
be removed from
the list)

check the paper supply
PrintMonitor’s icon blinks at the right end of the menu
bar when the printer is out of paper. You can change this
alert signal with the Preferences command in the File
menu.

1. After you have started printing a document, choose
PrintMonitor from the Application menu.

Name of the
document being
printed and
printer in use

set the date and time you want a document to print or
postpone printing indefinitely

check when to feed paper manually
PrintMonitor’s icon blinks at the right end of the menu
bar to signal that you must confirm manual printing. You
can change this alert signal with the Preferences
command in the File menu.

2. Select the options you want, and then close the
PrintMonitor window.

Click to set a
print time.
Click to stop printing the
current document.

Description and status of the
current printing job appear here.
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Working with fonts
A font is a collection of letters, numbers, and symbols in a
distinctive typographic design.
Several fonts come with your computer’s system software. They
are stored in the Fonts folder (inside the System Folder on your
startup disk). You can install additional fonts and remove fonts.
Additional fonts are supplied on one of the system software disks.
Fonts are also available from independent manufacturers, user
groups, and electronic bulletin board services.

Outline fonts and bitmap fonts
The PowerBook uses two types of fonts:
n

outline fonts

n

bitmap fonts

Both types of fonts are installed in your System file when you
install system software.
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Outline fonts (also called scalable or variable-size fonts) can
appear at any size, because each character is described as a
mathematical formula that adjusts according to the size you want.

RR

RR
R

RR

Your computer needs only a single outline font in a particular
typeface (such as Courier) to display or print that typeface in any
size. The outline fonts supplied with Macintosh system software
are called TrueType fonts.

Bitmap fonts (also called fixed-size fonts) appear only in certain
sizes, because each character is a grid of black-and-white dots
(called a bitmap), which is a rendering of the character’s shape in
a specific size.

Installing fonts
1. Quit all open programs.
2. Locate the font you want to install, and drag it to the
System Folder icon (not the System Folder window) on
your startup disk.
Fonts are supplied either as individual files (for individual
fonts) or in suitcases (for font families). To install an entire
font familiy, drag its suitcase to the System Folder. If you want
to install an individual font within a family, open the
appropriate suitcase to see the individual font files.

For the best type quality when using bitmap fonts, your computer
needs a separate bitmap font in each size you want to display or
print, such as 12-point Times® or 9-point Monaco.

A message lets you know that the font will be stored in the
Fonts folder.
3. Click OK.
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Removing fonts

Transferring fonts to a LaserWriter printer

1. Quit all open programs.

If you’re using a LaserWriter printer equipped with PostScript and
you want to print with PostScript fonts that are not built into your
printer, you can transfer, or download, those fonts from your
System Folder to the printer. Downloading fonts saves printing
time if you plan to print several documents that use those fonts.

2. Open the System folder on your startup disk.
3. Locate the Fonts folder and open it.
The Fonts folder contains font files (for individual fonts) and
font suitcases (for font families). If you want to remove an
individual font within a family, open the appropriate suitcase
to see the individual font files.
4. Locate the font you want to remove, and drag it out of
the Fonts folder window and out of the System Folder
window.
5. Close the Fonts folder window and the System Folder
window.
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When you download a font, it’s stored in the printer’s memory or
on a hard disk attached to the printer. You can download as many
fonts as the printer’s memory and hard disk space allow.
You download fonts with the LaserWriter Font Utility, which is
supplied on one of the system software disks.
1. Locate and open the LaserWriter Font Utility icon.

2. Choose Download Fonts from the File menu.
3. If the font you want to download is not listed, click the
Add button to add fonts to the list.

4. In the directory dialog box, locate your font, click its
name, and then click Add.

Fonts available
for downloading
Click to remove
selected fonts
from the list.
Click to download
all listed fonts
to the printer.
Click to display a directory dialog box for
locating and selecting additional fonts.

Use the directory dialog box that appears to locate the fonts
you want.

5. When you’ve added all the fonts you want to download,
click Done.
The fonts you added are listed in the Font Utility dialog box.
6. Click Download to send all the fonts in the list to the
printer or its hard disk.
7. Click OK when downloading is finished.
8. Choose Quit from the File menu.
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Finding out about available fonts

Other ways to use the LaserWriter Font Utility

Many programs have a Font menu that lists the fonts installed in
your system, though some programs do not list them all. You can
open the Fonts folder, inside the System Folder, to see all the
fonts stored there. You can also see available fonts with the Key
Caps desk accessory in the Apple (K) menu.

You can also use the LaserWriter Font Utility program to

The LaserWriter Font Utility program (supplied with the system
software disks) provides three ways to see the fonts available for
printing on a LaserWriter: you can display a list of fonts on the
screen, print a font catalog, or print a set of font samples.

n

initialize a hard disk attached to a printer

n

control whether a start page is printed

n

restart a printer

n

send PostScript files to a printer

Initializing a hard disk attached to a printer
You can attach a hard disk to some printers. A hard disk allows
you to store more fonts. See the manual that came with your
printer for information about connecting a hard disk.

Displays a list
of all fonts
available to the
printer

1. Make sure the correct printer is selected in the Chooser.
2. Open the LaserWriter Font Utility icon.

Prints a list of the
fonts available to
the printer

3. Choose Initialize Printer’s Disk from the File menu.

Prints a sample of
each font available
to the printer

4. Click the Drive button until you see the name of the
hard disk you want to initialize.
5. Click Initialize.
Initializing erases any information that was on the hard disk.
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Restarting a LaserWriter printer

Turning the printer’s start page on or off

Restarting the printer clears its memory, removing the fonts
stored there.

The LaserWriter can print a start page each time it is turned on or
restarted.

1. Open the LaserWriter Font Utility icon.

1. Open the LaserWriter Font Utility icon.

2. Choose Restart Printer from the Utilities menu.

2. Choose Start Page Options from the Utilities menu.

3. Click Restart.

3. Click the On or Off button.

4. Click OK.

Chapter 11: Printing 179

Transferring a PostScript file to a LaserWriter

4. Type a name for the log, and then click Save.

You can use the LaserWriter Font Utility to send a file in PostScript
format to a LaserWriter printer.

The file is sent to the printer and a record of the PostScript
activity is saved in the log.

1. Open the LaserWriter Font Utility icon.

You can open the log to see the sequence of PostScript
commands when the file was sent.

2. Choose Download PostScript File from the Utilities
menu.
3. Click the name of the file you want to download to the
printer, and then click Open.
A dialog box asks you to save a file that will contain a record of
the PostScript activity.

The name of a log that
records PostScript activity
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Chapter 12

Using Your Computer
on a Network

What networking offers
When your computer is connected to a network, you can:
n

Gain access to information on other computers.

n

Allow others access to information on your own computer.

In this chapter
n

What networking offers

n

Setting up your PowerBook on a network

n

Gaining access to files on shared disks

n

Working with files and folders on other computers

n

Sharing your own files

n

Using access privileges

n

Linking programs
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You can designate specific folders and hard disks on your
computer as “shared files” that other people can gain access to.
n

Print documents on network printers.

n

Update files over the network automatically.

1.
…
2.
…

n

Link your programs to programs on other computers.

You can automatically update documents created in programs that
use the Macintosh system software’s publish-and-subscribe
feature. (See the instructions that came with your programs for
information about publish-and-subscribe.)

Setting up your computer on a network
Before you can use your computer on a network, you need to
physically connect your computer to the network and install
networking software.
If a network administrator manages the network to which you’ll
be connecting your computer, ask that person for advice or help.
You can link your programs in order to share features between
those programs.
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Connecting to a network

Turning on AppleTalk

Your computer has built-in AppleTalk networking software. This
software directly supports the LocalTalk cables you need to
connect your computer to the network. (If your computer has the
appropriate port or expansion card, AppleTalk also supports
Ethernet and Token Ring cables.)

The first time you turn on your computer after you have
connected it to a network, you need to make sure that
AppleTalk is turned on.

1. Choose Shut Down from the Special menu.

1. Choose Chooser from the Apple (K) menu.
2. Click the Active button to turn on AppleTalk.

2. Connect the LocalTalk cable to the printer port ([) on
the back of your computer.
If your computer has a combined printer/modem port,
connect the LocalTalk cable to that port.
See your network administrator or the documentation that
came with your cables if you need more information.

Printer port

Icon

AppleTalk must be
active before you can use
a network.

continues .
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3. Close the Chooser.
When AppleTalk is active, PowerBook computers go to sleep
automatically only when they run out of battery power, or when
the power adapter is plugged in and the PowerBook is not
connected to any shared disks on the network.

2. Type your name in the box labeled Owner Name and
press Tab.

Naming your computer and its owner
Before you use the network, you should give your computer a
name and name yourself as its owner.
1. Choose Control Panels from the Apple (K) menu and
open the Sharing Setup icon.

3. Type your password in the box labeled Owner Password
and press Tab.
Your password can be up to eight characters long. Remember
the capitalization you use. After you press Tab, your password
is replaced by bullets (•) so no one can read it.
4. Type a name for your computer in the box labeled
Macintosh Name.

v If you can’t find or can’t open the Sharing Setup icon: Check
whether the Sharing Setup icon is in the Control Panels folder
and the File Sharing and Network icons are in the Extensions
folder inside the System Folder. If not, or if you still have
problems, use the Installer to install the AppleTalk software.
See the chapter on setting up your programs for more
information. v
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This is the name others will see when they access your
computer on the network.
5. Close the Sharing Setup control panel.

Gaining access to files on shared disks

Connecting to a shared disk

You can retrieve and store information on other computers
connected to your network. For example, a colleague can
place some files for you on a shared disk called a file server—
a computer dedicated to storing shared files. Individually owned
computers on your network might also have shared disks.

1. Choose Chooser from the Apple (K) menu.

Before you begin

2. Make sure that AppleTalk is active.
3. Click the AppleShare icon in the upper-left section
of the Chooser window.
AppleShare icon

Before you store or retrieve information on the network, do the
following:
n

n

n

Find out the name of the shared disk you want to access and
the name of the computer that it’s on.
If your network has zones, find out the name of the zone that
computer is in.
Find out if you are registered on the computer or if it allows
guest access.
A computer owner or network administrator can limit access
to files on a shared disk. Ask the owner or network
administrator what type of access you have to the files.

n

If you’re a registered user, find out the name and password
you need to use.

File servers and other
computers with shared disks

continues .

Find out exactly how your name and password are spelled,
including capitalization.
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v If the AppleShare icon does not appear: Make sure that
AppleTalk is active in the Chooser. Make sure that the
AppleShare file is in the Extensions folder in your System
Folder, and restart your computer. If that doesn’t work, use
the Installer to install the AppleTalk software. v

7. Click Guest or Registered User.

Click here if
you are not
registered on
the computer
that you’re
connecting to.

4. If you see a box labeled AppleTalk Zones, click the zone
the computer is in.
Computers with shared disks are listed as file servers on the
network.
5. Click the name of the computer you want to use.
If the name you want isn’t listed, make sure you have selected
the correct zone (if your network has zones), and make sure
the other computer is turned on.
6. Click OK.

If you are a guest, click Guest and go to step 10. If the Guest
option is dimmed, guests do not have access to this computer.
8. If you are a registered user, make sure the name in the
box is correct.
Capitalization does not need to match.
9. Type your password.
Capitalization does need to match.
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10. Click OK.

Disconnecting from a shared disk

If your password is not accepted: Make sure that Caps Lock is
not on. Type your password again, taking care not to make
typing errors. If it’s still not accepted, ask the computer’s
owner for help.
11. Click the name of a shared disk to select it.

When you’re finished using a shared disk, close any open files
or programs on the shared disk and then disconnect in one of the
following ways:
m Select the shared disk icon and choose Put Away from the File
menu.
m Drag the shared disk icon to the Trash.
m Choose Shut Down from the Special menu. Shutting down
automatically disconnects from the shared disk.

Shared disks
and folders

Dimmed items are not available to you,
or you’re already connected to them.

12. Click OK.
The icon of the shared disk appears on your desktop.
13. Close the Chooser.
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Connecting quickly to a shared disk

Connecting automatically when you start up

By making an alias for a shared disk, you can connect to that disk
by simply opening the alias.

You can connect automatically to one or more shared disks
whenever you turn on your computer.

1. Connect to a shared disk.

1. Connect to the computer that has the shared disk you
want to open.

See the section on connecting to a shared disk in this chapter.
2. Select the shared disk icon.
3. Choose Make Alias from the File menu.
4. Put the alias in a convenient location and rename it if
you wish.
5. Next time you want to connect to the shared disk, open
the alias you created in step 3.
6. If you originally connected to the shared disk as a
registered user, a message appears. Type your password.

See the section on connecting to a shared disk in this chapter.
2. Click the checkbox next to the name of the shared disk.
Click one
of these
buttons to
indicate
whether
you want to
enter your
password
at startup.

If you connected to the shared disk as a guest, this message
does not appear.
The shared disk icon appears on your desktop.
If the shared disk is on a computer that is turned off, or if
there is a problem with the network, you’ll see a message.
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Click a box to connect
automatically when you start
up your computer.

3. If you’re connecting as a registered user, click the
button that indicates whether you want to save your
name only, or both your name and your password.
For more security, click “Save My Name Only.” When you start
up your computer, you’ll need to enter your password to
connect to the shared disk.

2. If you want to reconnect to shared disks only when you
wake the computer from sleep, click the After Sleep
button.
If you always want to reconnect (that is, after you
restart the computer as well as after sleep), click the
Always button.

4. Click OK.
5. Close the Chooser.

Reconnecting a PowerBook to shared disks
Your computer disconnects from any shared disks it’s connected
to when you turn it off or restart it. If you have a PowerBook
computer, you can reconnect to those shared disks when you turn
your computer back on (or wake it from sleep) by using the
AutoRemounter control panel.
1. Choose Control Panels from the Apple (K) menu and
open the AutoRemounter control panel.

Click here to reconnect when you
wake your computer.
Click here to reconnect when you
start up, restart, or wake your
computer.
Click here to reconnect without
entering passwords.

3. If you do not want to enter your password when you
reconnect to shared disks, click “Automatically
Remounting.” Otherwise, click “Always Entering
Passwords.”
Having your computer ask for your password better protects
your privacy and the security of shared disks.
4. Close the AutoRemounter control panel.
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Working with files and folders
on other computers
Once you are connected to a shared disk, you can use the files
and folders on it as if they were on your own computer.
You may not be able to open some items on a shared disk if the
owner has restricted access to those items. For information on
how to check your access privileges, see “Working With Privileges
That Others Have Set” later in this chapter.

Changing your password
If you are a registered user, you may be able to change the
password you use to connect to a shared disk. ( Your network
administrator can restrict this capability.)
1. Connect to the computer that has the shared disk
you want.
2. Click the Set Password button.

Creating a new folder on another computer
You can create a new folder on a shared disk (as long as you have
the correct access privileges). If you are a registered user, you
become the owner of any folder that you create. If you are
connected as a guest, you share ownership of the folder with all
guests and registered users.
The icons of folders that you own on another disk have a
darkened tab.
Click here to change
your password.

When you own a folder, you can determine who can use it and
in what way. See “Using Access Privileges” later in this chapter for
more information.
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If a message tells you that you cannot change your password,
your network administrator has turned off this feature.

3. Type your current password. Then press Tab and type a
new password.
A bullet (•) appears for each letter you type.

Giving folder ownership to someone else
You can give away ownership of any folder you own. Once you do
so, however, the new owner can restrict your access to that folder.
Make sure you have copies of any files you may need before you
give ownership of a folder to someone else.
1. Connect to a shared disk.
2. Click a folder that you own to select it.
3. Choose Sharing from the File menu.

4. Click OK.

4. Type the name of a registered user or group in the box
labeled Owner.

5. Click OK in the dialog box that appears.

5. Close the Sharing window.

6. Retype your new password and click OK.
Your new password is now in effect.

A message asks you to confirm that you want to change the
owner of the folder.
6. Click OK.
The user or group that you named assumes ownership
immediately.
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Sharing your own files

Turning file sharing on

You can share files stored on your computer with others on
the network. For example, members of your work group can
connect to your computer and open a file from their own
computers. (They do not have to be using System 7.) Or, if you
have both a desktop Macintosh and a PowerBook computer, you
can transfer files from one computer to the other without using
floppy disks.

1. Choose Control Panels from the Apple (K) menu and
open the Sharing Setup icon.

You control what you share and with whom you share it:
n

n

n

You share only the items you specify.
You share only with the people you specify—one person,
a group of people, or everyone on the network.

Make sure the boxes in the Network Identity section of the
control panel are filled in.
2. In the section labeled File Sharing, click the
Start button.

You can see everything on your own computer from another
computer on the network.

How file sharing works
There are three steps to sharing a folder or disk:
1. Turn on file sharing.
2. Select a folder or disk to share.
3. Decide whom to share it with.
The folder or disk you share is not accessible to anyone but you
until you choose whom to share it with.

192 Chapter 12: Using Your Computer on a Network

Click here to start file sharing.

3. Close the Sharing Setup control panel.
If you want to give everyone on the network access to the items
you share, continue with the next section, “Turning On Guest
Access.”

Turning on guest access

3. Click the box under File Sharing labeled “Allow guests
to connect” to place an X in it.

To allow guests to connect to
your computer, click here so
that an X appears in the box.

If you want all users connected to the network to have access to
your shared folders and disks, you need to turn on guest access.
1. Choose Control Panels from the Apple (K) menu and
open the Users & Groups control panel.

4. Close the window and click Save in the box that
appears.
You can still restrict access to any folder or disk you share, as
described in the section “Using Access Privileges,” later in this
chapter.
Continue with the next section to select a folder or disk to share.

2. Open the <Guest> icon.
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Selecting a folder or disk to share
You can share any folder, hard disk, or CD-ROM disc connected to
your computer. ( You cannot share floppy disks.) You can share up
to ten folders or disks at a time. (This number does not include
folders within the folders or disks you share.)
1. Make sure file sharing is turned on.
2. Select a folder or disk to share.
3. Choose Sharing from the File menu.
4. Click the box labeled “Share this item and its contents”
to place an X in it.

5. Close the window and click Save in the dialog box.
At this point, only you have access to the item you shared and
the files inside it, unless you turned on guest access and some
or all of the boxes next to “Everyone” are checked.
If you haven’t turned on guest access, continue with the
section “Naming a Registered User” if you want to name the
specific people you want to share the item with. (Even if the
checkboxes next to Everyone are selected, you cannot give
access to everyone unless you’ve turned on guest access, as
described in the previous section.)
If you shared a folder, its icon appears with a darkened tab
and network cables:

Click here to share the
item you’ve selected.

When people on the network are connected to your shared
folder, its icon appears with faces in the center:

For information about the other checkboxes in this window,
see “Using Access Privileges,” later in this chapter.
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S Important: Before you put programs inside shared folders
or disks, remember that copyright laws may prevent those
programs from being shared. Check the applicable licensing
agreements and follow their specifications. S

Naming a registered user
You can register as many as 100 people and groups combined, but
for best network performance you should name no more than 50.
1. Choose Control Panels from the Apple (K) menu and
open the Users & Groups icon.

Taking back a shared folder or disk
Any shared folder or disk can be made private again.
1. Select the shared disk icon.
2. Choose Sharing from the File menu.
3. Click the box labeled “Share this item and its contents”
to remove the X.
If people are connected to your computer, you see a message
asking you to confirm your decision.

2. Choose New User from the File menu.
An icon labeled New User appears. Its name is selected
for editing.
v If you can’t find the New User command: Make sure the
Users & Groups window is active. v
continues .
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3. Type the name of a person you want to register.
Make sure you notify the person of the name you type.
(Capitalization does not have to match.)

Setting a registered user’s password
You can assign passwords for registered users to verify their
identities when they want to gain access to your computer.
1. Open a user icon in the Users & Groups control panel.

Type the user’s
password here.

4. To register more users, repeat steps 2 and 3.
To assign passwords or to name groups of users, continue
with the next two sections. If you want to start sharing
immediately, go to “Selecting a User or Group to Share a
Folder or Disk,” later in this chapter.
2. Type a password in the User Password box, then
press Tab.
The password can be up to eight characters long. When you
press Tab, the password is replaced by bullets. Make sure to
inform the user of the exact password, including
capitalization.
3. Close the window, and then click Save in the dialog
box.
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Naming a group of users

3. Drag user icons to the new group icon.
The icons are not moved inside the group icon, as they would
be if it were a folder. Instead, member icons are created inside
the group icon. You don’t need to drag your own icon to the
group icon because you (as the owner) have access to the
entire contents of your computer (unless you specify
otherwise).

You can name several registered users as a registered group.
1. Open the Users & Groups control panel and choose
New Group from the File menu.
An icon labeled New Group appears. The name is selected for
editing.

You don’t need to include the <Guest> icon in any group.
To allow this group access to a shared folder or disk, go to the
section “Selecting a User or Group to Share a Folder or Disk.”

Seeing who’s in a group
n

To see the names of all group members, open the group
icon.

2. Type a name for the group.

You can open any member icon to see or change the settings
you’ve made for that user.
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n

To see all the groups that a user belongs to, open the
user’s member icon or user icon.

Selecting a user or group to share a folder or disk
You can give one registered user or group exclusive access to a
shared folder or disk on your computer.
1. Select a folder or disk to share.
2. Choose Sharing from the File menu.
3. Click the box labeled “Share this item and its contents”
so an X appears.

The groups the user
belongs to are listed here.
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4. Choose a user or group from the User/Group
pop-up menu.

5. To share the item with only the user or group you’ve
chosen, click the bottom row of checkboxes (next to
Everyone) to remove the X from each box.

Preventing specific users or guests from accessing
your computer
To prevent all network access to your computer, you can turn file
sharing and program linking off, as described elsewhere in this
chapter.
1. Choose Control Panels from the Apple (K) menu and
open the Users & Groups icon.

Remove the X marks in
this row.

6. Close the window and click Save in the dialog box.

continues .
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2. To deny access to a specific user, open the user icon.

3. If an X appears in the “Allow to connect” checkbox,
click to remove the X (to deny access).
4. Close the window and click Save in the dialog box.
If you deny access to a user who is currently connected, he or
she is disconnected immediately. That user is no longer a
member of any group, and can connect only as a guest.
If you deny access to guests, any guests currently connected
are disconnected immediately. Only registered users and
groups that you’ve specified will have access to your
computer.

To deny access to guests, open the <Guest> icon.
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Removing a user from a group
1. In the Users & Groups control panel, open the
group icon.
2. Drag the member icon for that user to the Trash.
3. Choose Empty Trash from the Special menu.

Removing a user or group from your list of
registered users
You can remove a registered user or group at any time. When you
remove a user, he or she will no longer be a member of any
registered group.
1. Open the Users & Groups control panel.

Giving away ownership of a folder or disk on
your computer
You can give away ownership of a shared folder or disk on your
computer to a registered user or group.
Because you are the owner of your computer, the new owner of a
folder or disk on your computer cannot restrict your access to it.
However, the new owner can change the access privileges
that other people have to the item. If you give away ownership of
a folder or disk, make sure to remove any folders or documents
that you don’t want others to see or change.
1. Select a shared folder or disk.
2. Choose Sharing from the File menu.
3. Choose a name in the Owner pop-up menu.

2. Drag the user icon or group icon to the Trash.
3. Choose Empty Trash from the Special menu.
If the user is currently connected, he or she is disconnected
immediately.
You cannot throw away the <Guest> icon or the owner icon.

continues .

Chapter 12: Using Your Computer on a Network 201

If you select <Any User>, then anyone on the network can
change the access privileges or ownership of the item.
4. Close the window and click Save in the dialog box.
5. Click OK to confirm that you want to change
ownership.

2. In the section labeled File Sharing, click the Stop
button.
A dialog box appears in which you can specify a delay before
file sharing is turned off. If you specify a delay, users who are
connected to your computer are warned to save their work
and disconnect.

Turning file sharing off
You can turn file sharing off at any time. When file sharing is off,
people on the network cannot access folders or disks on your
computer, and you cannot access your computer from another
computer on the network.
When you turn file sharing back on, the items you shared before
are available again automatically.
1. Choose Control Panels from the Apple (K) menu and
open the Sharing Setup icon.

3. Type the number of minutes you want to elapse before
file sharing is turned off.
To turn file sharing off immediately, type the number 0.
4. Click OK.
If someone is using files on your PowerBook when file sharing is
turned off, any changes he or she has not saved will be lost.
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Monitoring file-sharing activity
When file sharing is on, you can see who is connected to your
computer and what folders or disks you’ve shared.
n

Choose Control Panels from the Apple (K) menu and
open the File Sharing Monitor icon.

Disconnecting someone who is connected to
your computer
You can disconnect users who are currently connected to your
computer in the File Sharing Monitor control panel.
1. Select the user or users you want to disconnect.
2. Click Disconnect.
3. Type the number of minutes that you want to elapse
before users are disconnected.

If you specify a delay, users are warned to save their work and
disconnect. To disconnect a user immediately, type 0.
continues .
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4. Click OK.
A message remains on the screen until the time is up. You can
switch to any program you already have open so you can
continue working.

3. Open the owner icon (the one with the bold outline).
4. Click the boxes labeled “Allow user to connect” and
“Allow user to see entire disk” to place an X in them.

5. When the designated amount of time has elapsed, close
the File Sharing Monitor.

Gaining access to your computer
from another computer
You can connect to your own computer from another computer
on the network and access everything on the disks attached to
your computer.
1. Make sure that file sharing is turned on.
2. Choose Control Panels from the Apple (K) menu and
open the Users & Groups icon.

When these boxes are checked, you can see and use
everything on your disks while you’re using another
computer.
To restrict your access, click a checkbox to remove the X.
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5. Close the window and the Users & Groups
control panel.

2. Type a new password in the box labeled Owner
Password and press Tab.

6. Leave your computer turned on.
To gain access to your computer, connect to it as a registered
user. Type your owner name and password as they appear in the
Sharing Setup control panel of your computer. Then connect as
you normally would.
v If you are unable to connect to your computer: Make sure
that your computer is turned on, that your computer has file
sharing turned on, and that you have the correct access
privileges. Make sure that you type your password exactly as it
is entered in the Sharing Setup control panel, including
capitalization. v

Changing your password

Remember the capitalization. Your password is replaced by
bullets to keep it private.
3. Close the Sharing Setup control panel.
Your new password is now in effect.

You can change the password you use to gain access to your own
computer from another computer.
1. Choose Control Panels from the Apple (K) menu and
open the Sharing Setup icon.
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Using access privileges

There are three types of access to shared items:

Access privileges let you control what other people can do with
the information you share on a network. For example, you might
want to let people see a file but prevent them from changing it.

n

See Folders: allows people to see, open, and copy folders.

n

See Files: allows people to see, open, and copy files.

n

Understanding access privileges
You can set access privileges for any shared folders on your own
computer and any folders you create on another Macintosh.
Owners of other computers can set access privileges that restrict
what you can do with their shared disks.
Three categories of people can have access privileges to shared
disks and folders:
n

n

n

The owner: The owner of a folder can change the access
privileges to that folder. You become the owner of a folder
automatically when you create it and you are the owner of any
folder on your computer. You can keep ownership or give it
away.
A registered user or group: A registered user has special
access to shared disks over the network. A registered group is
a group of registered users.
Everyone: This category includes the owner, registered
users, and guests.
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Make Changes: allows people to copy, delete, or change the
contents of a folder or disk, or to add items to a folder or disk.

The table indicates which privileges you need to see folders, see
files, or make changes to items in a shared folder or disk.
Action
Copy or move files to a folder
Copy a file from a folder
Copy a folder from a folder
Create a folder in a folder
Delete a file from a folder
Delete a folder from a folder
Open and use a file in a folder
Save changes to a file in a folder

See Folders

See Files

Make
Changes

Setting access privileges to folders and disks
You can set access privileges for shared items on your own
computer and for items that you own on other computers.
1. Select a folder or disk.
2. Choose Sharing from the File menu.
The dialog box you see may be slightly different from the one
pictured.

3. Choose a registered user or group to share the
item with.
Choose from the list of users and groups in the pop-up menu,
or type the name of a registered user or group in the box.
4. To set access privileges, click the appropriate checkbox.
n

n

n

n

n

n

If you’ve selected a folder inside a shared folder, the
checkbox at the top is labeled “Same as enclosing folder.”
If you’ve selected a folder on another computer, the
Owner and User/Group areas are text boxes, not
pop-up menus.

To set the same privileges for the folders within this folder
or disk, place an X in the box labeled “Make all currently
enclosed folders like this one.” If you’re working with an
item that contains a large number of folders, such as a CDROM disc, this action may take a few minutes to complete.
To prevent the folder from being changed, place an X
in the box labeled “Can’t be moved, renamed, or deleted.”
If you check this box, no one—not even you—can change
the folder. (The folder can still be viewed and copied.)
If you want the folder to have the same privileges that the
folder or disk enclosing it has, place an X in the checkbox
labeled “Same as enclosing folder.” This box only appears
for folders inside shared folders. When you move such a
folder to another folder, its access privileges change
automatically to reflect those of the enclosing folder.

5. When you’re finished setting access privileges, close
the Sharing dialog box and then click Save in the dialog
box.

If you’ve selected a folder you do not own, all the
checkboxes and their labels are dimmed.

Chapter 12: Using Your Computer on a Network 207

Access privilege strategies

n

Access privileges can be combined in several ways. A few common
and useful strategies are summarized here.
n

Keep a folder or disk private. To keep a folder or disk on
your own computer private, do not share it. To keep your
folder on another computer private, use these settings.

Allow everyone on the network all access privileges.
As long as you’ve turned on guest access, everyone on the
network can open, read, and change the files and folders.

n
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Allow access to one other person or group. This set of
privileges allows the owner of the item and one registered
user or group to use the item.

n

Keep a folder private but allow others to place files or
folders into it. People on the network can deposit files or
folders into this folder but only the owner can see, remove, or
change its contents. (This configuration is sometimes called a
drop box.)

Working with privileges that others have set
When you are using the By Icon or By Small Icon view, the
appearance of shared folders indicates the access you have.
Icon

Meaning
A darkened tab indicates that you own the folder
and can set its access privileges.
A plain tab indicates that you can open and use the folder.

n

Set up a folder as a bulletin board. People can open and
read the files in this folder but cannot change them. Only the
owner can add files.

A strap indicates that you cannot open and use the folder.

A strap with an arrow indicates that you can put files
or folders into the folder, but you cannot open it or
use any files or folders within it.
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Checking your access privileges

Linking programs

When you open a folder on another computer, icons under the
title bar indicate the privileges that you do not have.

Some programs can exchange information directly with other
programs. For example, one program might be able to instruct
another program to add a row to a spreadsheet or change the font
size of a paragraph.

You can’t
make changes
to files in this
folder.

You can’t
see files in
this folder.

You can’t
see folders
in this folder.

Programs implement linking in various ways and not all programs
have this capability. See the documentation that came with your
programs for more information.

Linking to a program on another computer
You can only link to programs that are shared.
1. Within your program, choose the menu command that
allows you to link programs.
The menu location and command name depend on the
program you’re using. You use a dialog box to find the
program that you want to link to.
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5. Click OK.
In most cases, you need to identify yourself as a guest or a
registered user.

2. If your network has zones, select a zone in the lowerleft section of the dialog box.
3. Select the Macintosh you want to connect to in the
upper-left section of the dialog box.
4. Select the program you want to link to.

6. Click Guest or Registered User.
If you are a guest, click Guest and go to step 9. If the Guest
option is dimmed, guests do not have access to this computer.
7. If you are a registered user, make sure that the name is
correct.
8. Type your password.
9. Click OK.
The two programs are now linked.
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Disconnecting a program link

Turning program linking on

To disconnect a link to a program on another computer, quit the
program you used to create the link.

Allowing other people to link to your programs

When you turn program linking on, your computer is visible to
others on the network whenever they attempt to link a program.
Before you turn program linking on, make sure that AppleTalk
is active and that you have named your PowerBook in the Sharing
Setup control panel.

You can allow people on the network to link to programs on your
computer.

1. Choose Control Panels from the Apple (K) menu and
open the Sharing Setup icon.

n

First you turn on program linking.

n

Then you make a program available for linking by sharing it.

n

n

2. In the section labeled Program Linking, click the
Start button.

Then you either allow guest access or allow specific people to
link.
Finally, you open the program.

These steps are outlined in the following sections.

Click here
to start
program linking.

3. Close the Sharing Setup control panel.
Once program linking is turned on, you must select programs
to share before network users can link to them, as described
in the next section.
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Selecting a program for linking

Allowing guests to link to your programs

Before a network user can link to your program, you need to
share it.

You can let everyone on the network link to your shared
programs.

1. Quit the program if it’s open, then click its icon to
select it.

1. Choose Control Panels from the Apple (K) menu and
open the Users & Groups icon.

2. Choose Sharing from the File menu.

2. Double-click the <Guest> icon.

3. Click the box labeled “Allow remote program linking”
to place an X in it.

3. Click the box labeled “Allow guests to link to programs
on this Macintosh” to place an X in it.

Click here to let guests link
to your shared programs.

Click here to share this program.

If the box is dimmed, the program does not support linking.
4. Close the window.
At this point, no one but you can link to the program until you
turn on guest access or name registered users, as described in
the following sections.

4. Close the window.
Guest users can now link to any of the programs you’re
sharing, as long as the programs are open.

5. Open the program.
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Naming specific users to link to your programs
You can identify the registered users and groups you want to link
to your programs.

3. Click the box labeled “Allow user to link to programs
on this Macintosh” to place an X in it.

1. Choose Control Panels from the Apple (K) menu and
open the Users & Groups icon.
2. Open the icon of a user.

Click here to let this user link to
your shared programs.

4. Close the window and click Save in the dialog box.
5. To give more registered users access to your programs,
repeat steps 2 through 4.
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Chapter 13

Building a PowerBook Duo
System
In this chapter
n

Using the Duo Dock

n

Using the Duo MiniDock

n

Using the Duo Floppy Adapter

n

Using SCSI devices

n

Connecting your computer as a SCSI disk

n

Connecting a modem

n

Connecting a printer

n

Connecting sound input and output devices

n

Adding memory to your computer

Using the PowerBook Duo Dock
The PowerBook Duo Dock is the most versatile expansion options
for the PowerBook Duo. A Duo Dock itself is not a computer—you
need a PowerBook Duo to use it. But the dock and the
PowerBook together provide the video, storage, and input/output
capabilities available on most desktop Macintosh computers.
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The drawing shows one of many possible PowerBook Duo
Systems. The Duo Dock can accommodate any Macintoshcompatible monitor, keyboard, mouse, printer, hard disk drive,
CD-ROM drive, scanner, or other device.

Duo Dock features
The Duo Dock comes with many features built in, and several
optional features are also available. These features include:
n

n

n

n

an internal 1.4 MB floppy disk drive
an optional internal SCSI hard disk drive (any available
capacity that meets Apple’s specifications; up to 1" high)
standard ports including SCSI (with an HDI-30 connector),
video, printer, modem, Apple Desktop Bus (ADB), sound in,
and sound out
a separate mouse and microphone

The following sections include information about
n

the features of the Duo Dock

n

how to set it up

n

how to use it with the PowerBook Duo

n

how to install a NuBus card in the Duo Dock
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Eject button

Manual eject hole
Key lock

n

n

n

n

n

n

built-in video support for the following monitors:
Macintosh 12" Monochrome Display
Macintosh 12" RGB Display
AppleColor High-Resolution RGB Monitor (13")
Macintosh Color Display (13")
Apple Macintosh Portrait Display (15")
Macintosh 16" Color Display
VGA monitors
slots for two NuBus cards (for Ethernet, Token Ring,
additional video, or other capabilities)
an FPU socket for an optional math coprocessor
a 512K VRAM SIMM expansion slot (for 16-bit color on Apple
13" and 16" monitors, and 8-bit grayscale on the Apple 15"
portrait monitor)

[ Printer
g SCSI

™ Video
V ADB port

≈ Sound in

I Power
button

Floppy
disk drive
Q Internal
Modem

NuBus slots
W External
Modem
Ç Security slot

- Sound out

an automatic insert/eject feature to ensure reliable docking
a key-operated lock to prevent theft of the docked
PowerBook Duo
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Setting up the Duo Dock
If you need to install a NuBus card inside the dock, do it before
following the steps below. See “Installing a NuBus Card” in this
guide for instructions.
1. Place the dock on a hard, flat surface.
While you set up, you’ll need access to the connectors on the
back panel.

s Important: Don’t attempt to use the dock on its side, or in

3. Put your monitor on top of the dock, and connect the
monitor’s video and power cables.
The dock can hold a monitor weighing up to 100 lbs. (45 kg).
If you installed a video card in the dock, connect the video
cable to the card. Otherwise, connect the video cable to the
dock’s video port (marked with the icon ™). If you are
connecting a VGA monitor, you need a 15-pin to 9-pin adapter.
Connect the monitor’s power cord to the power receptacle
on the back of the dock.

any position other than those pictured. Don’t block the
ventilation slots at the right rear side of the dock. s

2. Plug one end of the dock’s power cord into the power
receptacle (≤) on the back of the dock, and the other
end into an electrical outlet or power strip.

Video port

Video card connector
(if card is installed)
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4. Connect your mouse, keyboard, or other input device
to the Apple Desktop Bus (ADB) port.
You can chain devices together if you have more than one. For
example, you can connect a keyboard to the ADB port, and
then connect a mouse to the keyboard.

5. Now connect any other equipment you have, such as an
external hard disk drive or printer.
Follow the instructions that came with the equipment.
If you are connecting a SCSI device, you’ll need an HDI-30
SCSI System Cable to attach it to the dock. See the section on
using SCSI devices in this chapter for complete information
about connecting such equipment to your PowerBook Duo
System.
6. If you will be using network services, connect your
LocalTalk (or other network) cable.
Follow the instructions that came with the cable, or check
with your network administrator.
Once you have connected all your equipment, the Duo Dock is
ready to use.
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Inserting the PowerBook Duo into
the Duo Dock

Trouble?
n

The dock won’t accept the computer.
Power to the dock may be off. Make sure the dock is plugged
in. If it is plugged into a power strip, make sure the power
strip is turned on.

1. Shut down the PowerBook Duo by choosing Shut Down
from the Special menu.
2. Close the display.

The docking connector may not be accessible. Make sure you
have opened the connector door on the back panel of the
computer.

3. Open the door that covers the docking connector on
the back panel of the computer.
4. If the elevation feet are down, flip them up.

The dock may be locked. Unlock it by turning the key to the
horizontal (unlocked) position, and insert the computer
again.

5. Hold the computer with its latch toward you, and slide
it into the Duo Dock as shown.

You can use only the PowerBook Duo with the Duo Dock.
Other PowerBook models cannot be docked.

Don’t force the computer into the dock. When the computer
is in most of the way, the dock pulls it in the rest of the way.
n

The dock ejects the computer.
The computer may not be shut down. Open the display,
respond to any messages on the screen, and choose Shut
Down from the Special menu. Then wait a moment to make
sure the computer is really shut down, close the display, and
try again.
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Turning on the Powerbook Duo System

Trouble?

To turn on the docked computer, press the Power On key on your
external keyboard. On Apple keyboards, the key is marked with a
triangle pointing left.

n

Nothing happens when you press the Power On key.
Review the setup instructions and make sure everything is
plugged in correctly. Then try pressing the Power On key
again. If you still get no results, press the power button on the
back of the dock.
Power button

Once the computer is on, you have access to all equipment
connected to the Duo Dock.

n

You hear sounds that suggest the computer is working,
but you can’t see anything on the monitor.
Make sure the video cable is plugged in correctly.
Make sure the monitor is plugged in and make sure that its
power switch is on. Then adjust the brightness and contrast
controls as necessary.
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Working with a Powerbook Duo System

Battery recharging

This section summarizes

A docked PowerBook Duo draws power from the Duo Dock, not
from its own battery. The battery recharges while the computer is
in the dock.

n

n

how your PowerBook Duo behaves when it is docked, or
when it is moved from one Duo Dock to another
how to take advantage of the Duo Dock’s features

Your preferences
The PowerBook Duo uses your preferences—including desktop
pattern, window views, and so forth—when you dock it. This
means that your computer will be customized the way you like it
no matter where you work.
The PowerBook Duo can also remember certain selections that
apply only when you are docked (such as an Ethernet network
setting). Each time you dock, these settings take effect again
without any action on your part.
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You can remove the battery before docking if you want to
recharge it in a recharger. You can also remove the battery from
the computer while it is docked if you want to recharge a second
battery inside the computer.

Power conservation
A docked PowerBook Duo does not sleep. You cannot put the
PowerBook to sleep as long as it remains docked.
The microprocessor in a docked PowerBook Duo does not
cycle on and off, because there is no need to limit its power
consumption.

Hard disks

SCSI devices

The PowerBook Duo starts up from its internal hard disk
automatically. If you have a hard disk installed in or connected to
your Duo Dock, that disk’s icon also appears when you start up.

If you have a hard disk installed in your Duo Dock, you can chain
up to five additional SCSI devices to your Powerbook Duo System.
If you do not have a hard disk installed in your Duo Dock, you can
chain up to six devices.

You may prefer to start up from the Duo Dock’s hard disk when
the PowerBook Duo is docked. If so, use system software version
7.1 or later to install a System Folder on that disk, and select it in
the Startup Disk control panel. See the instructions on installing
system software in the chapter on setting up your programs in
your PowerBook Duo User’s Guide.
If you start up from the Duo Dock’s hard disk, the preferences
selected on that disk override those selected on your PowerBook
Duo. When you use the PowerBook away from the dock, the
computer uses the preferences associated with its own hard disk.
v Startup disk surprise?: If you select the hard disk in the Duo
Dock as your startup disk, your PowerBook Duo will also start
up from the internal hard disk of any other Duo Dock you
use. (This is because all Duo Dock internal hard disks have
the SCSI ID number 1.) v

Virtual memory
The PowerBook Duo can borrow space on a hard disk to increase
the memory available for using programs. The disk space is called
virtual memory.
You can set aside virtual memory space on the hard disk
belonging to either the PowerBook Duo or the Duo Dock.
If you set aside virtual memory space on the dock’s hard disk,
virtual memory will not be available when you use the PowerBook
outside the dock. The next time you dock, virtual memory is
turned back on automatically.
If you set aside virtual memory space on the PowerBook’s hard
disk, virtual memory is always available.
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Network

If you have system problems

If you installed the appropriate NuBus card in your Duo Dock,
then whenever your PowerBook Duo is docked you have access
to another network type—such as Ethernet or Token Ring—in
addition to your computer’s built-in LocalTalk. The first time you
use the other network, you must open the Network control panel
and select that network type.

If your docked computer crashes (the screen goes blank or fills
with gibberish) or freezes (the pointer doesn’t move and input
devices don’t work), press the power button on the back of the
dock once. Pressing once turns the computer off. Use the Power
On key on your external keyboard to turn the computer on again.

Once you have made a selection, the computer remembers it
whenever the PowerBook Duo is docked. Whenever the
computer is not docked, LocalTalk is the network type.

Modem
If you want to use an external modem with your Powerbook Duo
System, connect the modem cable to the Duo Dock port marked
with this icon: W
If your computer has an internal modem, select either Internal or
External Modem in the PowerBook control panel before opening
your telecommunications program.
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Pressing the power button erases any information you did not
save, but it allows you to restart the system and continue working.
See the troubleshooting section of your PowerBook Duo User’s
Guide for more information about handling system problems.

Each Duo Dock comes with two keys. If you lose both of them,
you can:

Using security features
The Duo Dock has a key-operated mechanical lock to prevent
theft of a docked PowerBook Duo. You can also lock computers
out of the dock—for example, to protect information on the
dock’s hard disk or to limit access to a network.

n

You can lock the dock when the computer is inside or outside the
dock.
n

You can lock the computer inside the dock when the computer is
on or off.
To lock or unlock the dock, turn the key as shown in the
illustration.

n

Contact the lock vendor for a replacement set of keys. Write to
Fort Lock Corporation, 3000 N. River Road, River Grove, IL
60171, USA, or call 708-456-1100 (in Illinois). Be prepared to
supply the code number printed on the tag that came with
the keys.
Have a locksmith make a replacement set of keys.
Have your authorized Apple service provider replace the
entire lock assembly. The new assembly comes with two new
keys.

All these procedures may be expensive and time-consuming. It’s a
good idea to take precautions not to lose the keys.
The Duo Dock also has a security slot in the back panel to which
you can connect an optional locking cable, to prevent theft of the
dock. See your authorized Apple dealer or representative for
more information.

Locked

Unlocked
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Ejecting the PowerBook Duo from
the Duo Dock
1. Shut down the PowerBook Duo by choosing Shut Down
from the Special menu.
If a system problem prevents you from using the menu, you
can shut down by pressing the power button on the back of
the dock (but you’ll lose work you haven’t saved).
2. Unlock the dock (if it is locked).

Eject button

Turn the key to the vertical (unlocked) position.
3. Press the eject button.
The dock ejects the computer far enough so you can pull
it out.

226 Chapter 13: Building a PowerBook Duo System

A useful shortcut
You can shut down the PowerBook Duo and eject it by simply
pressing the eject button (if the dock is not locked). When you do
this, the system will
n

remind you to save your work, if you haven’t done so

n

close any open programs

n

terminate your network or modem connections

n

shut down the system

n

eject the PowerBook from the dock

Trouble?
n

The dock doesn’t eject the computer.
The dock may be locked. Unlock it by turning the key to the
vertical (unlocked) position, and press the eject button again.
There may be no power to the dock. To eject the computer
manually, insert the dock’s key, a small screwdriver, or a
similar object into the square hole on the side of the dock and
press gently.

If you press the eject button while the dock is locked, a message
reminds you to unlock it.

Manual eject hole
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If you eject the computer manually while it is turned on, the
computer turns itself off. You will lose any information you did
not save.
When the dock is locked, you can’t use the square hole.

Installing a NuBus card
Installing a NuBus card in the Duo Dock is a technically
challenging procedure. We recommend that you attempt it only
if you are comfortable working with electronic equipment. You
should read all of the following instructions before you begin. If
the procedure sounds like something you don’t want to do
yourself, any authorized Apple service provider can install a
NuBus card for you.

Getting ready
You need the Duo Dock, a NuBus card, and a flat-blade
screwdriver.
v If your system is already set up: Turn off, disconnect, and
remove all equipment attached to the dock, but do not
unplug the power cord that connects the dock to an electrical
outlet or power strip. v
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Installing the card
1. Unlatch the top cover of the dock by pinching the
raised bumps just inside the front opening.

This

Not This

3. Touch the power supply case to discharge any static
electricity that might be on your clothes or body.

Power supply case

2. When the latches release, tilt the cover upward slightly
(to about a 30° angle) and then lift the angled cover
straight up to remove it.

continues .

Chapter 13: Building a PowerBook Duo System 229

4. Disconnect the power supply cable by pinching its
release clip and pulling straight up.
If there is a hard disk drive in your Duo Dock, you may need
to move its ribbon cable aside to reach the clip on the power
supply cable.

5. Loosen the two screws connecting the central part of
the dock to the base. (In the rest of these instructions,
the central part of the dock is called the subassembly.)
Turn the screws counterclockwise. The screws don’t come out
all the way, so you can’t remove them completely.

Pinch clip and then pull up.

Screws
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6. Pull the subassembly toward you until you feel it come
to a stop.

7. Lift the subassembly straight up to remove it.

It will move only a short distance. You’ll be able to feel a small
gap under the front ledge of the dock.
If the subassembly doesn’t seem to move, or if you can’t feel a
gap under the front ledge, the screws may not be loose
enough. Turn them a few more times and try again.

continues .

The subassembly is heavy, so before you continue with step 7,
make sure that you have enough room to put it down nearby after
you lift it off the base.
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8. Turn the subassembly over and put it down with the
disk drive(s) facing up.
Hard disk drive
Floppy disk drive

v About NuBus slots and cards: The two NuBus slots in the Duo
Dock are stacked vertically. The slots are identical, so you can
install your card in either one. If you install your card in the
upper slot (which is the lower slot when the dock is right side
up), you’ll have to remove it and reinstall it if you want to add
a second card later.
NuBus cards come in different shapes and sizes. All properly
designed cards will fit into the Duo Dock. You may find it
easier to install a large card in the upper slot rather than the
lower one. v
9. Remove the plastic NuBus card guide next to the floppy
disk drive by pulling it straight out.
NuBus card guide
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The next four steps describe how to insert the card.

s Important: Handle a NuBus card by its edges only, and be
careful not to touch the pins inside the connector.

s

10. Lower the card into the slot.

11. Adjust the card so its connector lines up with the
connector on the slot.
Don’t press the connectors together yet.
Align connectors

NuBus cards have all or most of their chips on one side. Hold
the card so its chips are facing up, and the connectors on the
card and the slot are aligned. You may need to tilt the card as
you lower it into the slot.
Connector

continues .
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12. Insert the two pins on the dock bracket into the slot
and hole on the card bracket.
Pin
Slot

Pin

13. Press together the connectors on the card and the slot.
You can push against the plastic part of the connector, as
shown, or against the top of the card. If you push against the
top of the card, make sure the connectors stay properly
aligned.

Hole

14. Repeat steps 10–13 to install a second NuBus card, if
you have one; otherwise go to step 15.
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15. Replace the NuBus card guide by sliding it back into
position.

16. Turn over the subassembly and carefully put it back
into the base of the dock.
17. Push the subassembly toward the back of the dock to
close the gap (the reverse of step 6).

Gap

Your card is now installed.

continues .
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18. Tighten the screws you loosened in step 5.
The screws are spring-loaded. You’ll need to exert strong
downward pressure while you turn them clockwise.
19. Reconnect the power supply cable you disconnected in
step 4.

20. Replace the dock cover.
Align the cover over the base, press down firmly on the rear
corners, and then press down on the front corners until the
latches click.

See the information that came with your NuBus card for
information about its accompanying software (if any) and use.
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Using the PowerBook Duo MiniDock
The Duo MiniDock is available as an option for the PowerBook
Duo. The minidock allows you to connect a wide variety of
devices to the PowerBook. A minidock system can have many of
the same capabilities as a desktop Macintosh.
A Duo MiniDock with peripheral devices connected to it is not a
computer—you need a PowerBook Duo to make the system work.

The drawing shows one possible PowerBook Duo system. You can
use any Macintosh-compatible monitor, keyboard, mouse, printer,
hard disk drive, CD-ROM drive, scanner, or other device.
The following sections include information about
n

the features of the Duo MiniDock

n

how to set it up

n

how to use it with the PowerBook Duo
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Duo MiniDock features

n

The Duo MiniDock allows you to use the following types of
equipment with your PowerBook Duo:
n

n

any one of these Apple monitors:
Macintosh 12" Monochrome Display
Macintosh 12" RGB Display
AppleColor High-Resolution RGB Monitor (13")
Macintosh Color Display (13")
Apple Macintosh Portrait Display (15")
Macintosh 16" Color Display

n

up to three Apple Desktop Bus (ADB) input devices, such as a
keyboard and mouse
an external 1.4 MB floppy disk drive
up to six SCSI devices including hard disk drives,
CD-ROM drives, and scanners

n

a printer

n

an external modem

n

a LocalTalk network

Ç Security slot
Q Internal
modem

≈ Sound in
_ Sound out
g SCSI
[ Printer

W External

I Power button

modem

™ Video V ADB

¯ Power adapter
H Floppy disk drive
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Setting up the Duo MiniDock
Your PowerBook Duo system may be simple or complex,
depending on the equipment you want to use with your
PowerBook Duo. As you work through these instructions, skip
any steps that don’t apply.
The setup procedure involves connecting your equipment to the
Duo MiniDock and then connecting the PowerBook Duo. If you
connect the PowerBook first and add equipment to the minidock
later, the computer may not be able to recognize the additional
equipment until you restart. Remember that the system is not a
computer at all unless the PowerBook Duo is attached to it.

2. If you are connecting an external monitor, SCSI
equipment, a printer, or an external modem, plug in
the power adapter.
The power adapter comes with your PowerBook Duo.
Plug the power adapter cable into the Duo MiniDock (marked
with the icon ¯), and then plug the adapter’s power cord or
wall mount plug into an electrical outlet or power strip.

1. Place your equipment where you’ll be using it.
While you set up, you’ll need access to the connectors on the
back of the Duo MiniDock.
If you are using an external monitor, make sure your work
surface can support its weight. You may want to use a monitor
stand so you can adjust the screen position.

continues .
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s Warning: Use only the power adapter that came with your
PowerBook Duo. Adapters for other electronic devices
(including other portable computers) may look similar, but
they may damage your computer. s
If you are connecting only an external floppy disk drive, a
keyboard, and/or a mouse, you don’t need to plug in the power
adapter.
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3. If you are connecting an external monitor, plug the
monitor’s power cord into an electrical outlet or power
strip. Then connect the monitor’s video cable to the
video port (marked with the icon ™) on the Duo
MiniDock.
You may find that your monitor’s power cord is designed to
plug into the power receptacle on the back of a computer,
rather than into an electrical outlet. Your Apple-authorized
dealer can supply a power cord with the correct plug.

4. If you are using a keyboard and/or mouse, connect it to
the Apple Desktop Bus (ADB) port on the Duo
MiniDock.

5. If you are using an external floppy disk drive, connect
its cable to the floppy disk drive port (marked with the
icon H).

Since the minidock has one ADB port, you’ll need to chain
devices together if you are connecting more than one. For
example, connect a keyboard to the ADB port, and then
connect a mouse to the keyboard.

continues .
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6. If you are using any other peripheral devices, such as
an external hard disk drive or a printer, connect them
now.
Follow the instructions that came with the device.
If you are connecting a SCSI device, you’ll need an HDI-30
SCSI System Cable to attach the SCSI device to the Duo
MiniDock. See the section on using SCSI devices for complete
information about connecting SCSI devices to your
PowerBook Duo system.
7. If you are using a LocalTalk network, connect your
LocalTalk cable.
Follow the instructions that came with the cable, or check
with your network administrator.

More about modem and printer ports
Several kinds of devices can be connected to the modem and
printer ports on the Duo MiniDock, but you can use only two
such devices at a time. The chart shows which devices can be
connected to which ports.
Device type

Modem port

Printer port

Direct-connect printer

yes

yes

Network printer

no

yes

External modem

yes

no

LocalTalk cable

no

yes

Before using a device connected to the modem or printer port,
you need to select it—usually by clicking an option in the Chooser
or in the PowerBook control panel (both available from the Apple
menu). See “Working With a PowerBook Duo System” later in this
section for more information.
When you have finished connecting your equipment to the Duo
MiniDock, you are ready to connect the PowerBook and begin
using your PowerBook Duo system.
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Before you dock

Don’t dock with the computer turned on

Before you connect the PowerBook Duo to the Duo MiniDock,
the computer must be shut down or in sleep.

If you try to connect to the Duo MiniDock with the PowerBook
Duo turned on, the computer will turn itself off. This process
erases any information you did not save.

Shut down for access to all devices
Docking with the computer shut down gives you access to SCSI
devices such as a hard disk drive or CD-ROM drive. The computer
can only recognize these devices when it is turned on (after
having been off ). When you turn the computer on, it recognizes
all attached devices (including an external monitor, floppy disk
drive, and keyboard).

Sleep for access to everything except SCSI devices
Docking with the computer in sleep gives you faster access to
most devices, including an external monitor, floppy disk drive,
keyboard, and mouse. The computer can recognize these devices
immediately when you wake it from sleep, provided they were
attached to the minidock before you connected the computer.
Docking when the computer is in sleep does not give you access
to SCSI devices until you restart the computer.

Before-you-dock summary
The computer can recognize the following devices when you
wake it from sleep, provided they were attached to the minidock
before you connected the computer:
n

external monitor

n

floppy disk drive

n

keyboard and mouse

n

direct-connect printer

n

external modem

n

any sound input or output device

The computer can’t recognize SCSI equipment (such as a hard
disk drive, CD-ROM drive, or scanner) until you restart.
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Connecting the PowerBook Duo
to the Duo MiniDock
1. Make sure the PowerBook Duo is in sleep or shut
down.

3. Slide the posts on the minidock into the corresponding
holes on the back of the PowerBook, and then gently
push the two devices together.

If the PowerBook is on when you try to connect it to the
minidock, the computer will turn itself off. This process erases
any information you did not save.
2. Pull up on the latch at the top of the Duo MiniDock.

This

Not This

4. Push down on the latch at the top of the minidock to
secure the connection.
The computer is not docked until the latch is pushed down.
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Turning on the PowerBook Duo System

Making your external monitor the main monitor

1. If you are using an external monitor or SCSI equipment
(such as an external hard disk drive), turn it on now.

If you are using an external monitor with your PowerBook Duo
System, you’ll probably want to use it as the main monitor (the
one on which the menu bar appears).

2. Turn on or wake the PowerBook Duo by pressing its
Power On key.
You can also turn on or wake the computer by pressing the
Power On key on your external keyboard, if you have one.
The Power On key is marked with a triangle pointing left.

To make the external monitor your main monitor, follow these
steps. You can only do this when your PowerBook is connected to
the Duo MiniDock.
1. Choose Control Panels from the Apple menu, and open
the Monitors control panel.
In the control panel you’ll see two rectangles representing
your two monitors.

continues .
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2. Drag the menu bar from the small rectangle
(representing your PowerBook screen) to the large
rectangle (representing your external monitor).

Trouble?
n

Nothing happened when you tried to turn on the
PowerBook Duo.
Make sure that all your equipment is connected properly, and
try pressing the Power On key again.
The battery may be drained. Plug in the power adapter and
then try pressing the Power On key again.
The Duo MiniDock might be damaged. See the service and
support information later in this book for help.

3. Choose Restart from the Special menu.
You must choose Restart for the new monitor configuration to
take effect.
The PowerBook’s screen is the main monitor whenever the
computer is not docked—this requires no action on your part.

n

The system is on, but the external monitor is dark.
Make sure the monitor’s power switch is on. Adjust the
monitor’s brightness and contrast settings.

n

You want the menu bar to appear on the external
monitor, but it appears on the PowerBook’s screen.
You may need to select the external monitor as your main
monitor. Open the Monitors control panel and make sure that
the white bar appears on the rectangle representing the
external monitor. If it doesn’t, drag it there and restart the
computer.
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n

The computer displayed a message saying that you had
to restart the PowerBook to get access to attached
devices, and you clicked OK, but you still don’t have
access.

Working with a PowerBook Duo system
This section summarizes
n

Clicking OK sends the message away, but it doesn’t restart the
computer. Choose Restart from the Special menu.
n

The icon of the external hard disk doesn’t appear on
the desktop.
To get access to an external hard disk drive, you must either
restart the computer, or connect the computer to the
minidock with the computer shut down.
1. Choose Shut Down from the Special menu.
2. Turn on your external hard disk drive and give it a
few seconds to warm up.
3. Press the Power On key to turn on the computer.

n

You want the system to start up from the external hard
disk, but it starts up from the hard disk inside your
PowerBook.

n

how your PowerBook Duo behaves when it is connected to
the Duo MiniDock, or when it is moved from one minidock to
another
how to take advantage of the Duo MiniDock’s features

Your preferences
The PowerBook Duo uses your preferences—including desktop
pattern, window views, and so forth—when you dock it. This
means that your PowerBook will be customized the way you like it
no matter where you work.

Input devices
When your computer is connected to the minidock, you can use
any attached input devices, including the keyboard and trackball
built into the PowerBook Duo.

Restart your computer. If that doesn’t work, check to make
sure that the external hard disk has a System Folder on it
(containing system software version 7.1 or later) and that you
have selected that disk in the Startup Disk control panel.
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Battery recharging

Monitors

A PowerBook Duo connected to the Duo MiniDock draws power
from its battery unless the power adapter is plugged in. If the
power adapter is plugged in, the battery recharges while the
computer is connected to the minidock. (This is the same way the
computer works if it is not docked.)

If an external monitor is connected to the Duo MiniDock, you can
use it as an extension of your PowerBook Duo’s built-in screen—
that is, you can drag objects from one screen to another and do
your work on either one.

Power adapter
Always use the power adapter when you connect your PowerBook
Duo to a Duo MiniDock supporting an external monitor, external
SCSI equipment, a printer, and/or an external modem.
If your Duo MiniDock is supporting only a floppy disk drive, a
keyboard, and/or a mouse, you can work without the power
adapter if you prefer. However, the battery will discharge faster
than it does when the PowerBook is not connected to the
minidock.

Power conservation
If you are using an external monitor, the PowerBook will not sleep
again until you disconnect it from the minidock.
If you are using only a floppy disk drive, a keyboard, and/or a
mouse, the computer sleeps as usual.

248 Chapter 13: Building a PowerBook Duo System

The PowerBook’s built-in screen is set to be the main monitor
(the one on which the menu bar appears).
You can make an external monitor the main monitor by selecting
it in the Monitors control panel. (See “Making Your External
Monitor the Main Monitor,” earlier in this section.) The
PowerBook’s built-in screen is the main monitor whenever the
computer is not connected to the minidock.
A feature called video mirroring allows you to display the same
Macintosh desktop on two screens at the same time. This feature
is useful when you want to do a presentation: you can use the
PowerBook screen to see and control what your audience views
on a larger screen. Use the PowerBook Display control panel to
turn video mirroring on or off.

Hard disks

Virtual memory

The PowerBook Duo starts up from its internal hard disk
automatically. If you have an external hard disk connected to your
Duo MiniDock, that disk’s icon also appears when you start up.

The PowerBook Duo can borrow space on a hard disk to increase
the memory available for using programs. The disk space is called
virtual memory.

You may prefer to start up from the external hard disk when the
PowerBook Duo is docked. If so, use system software version 7.1
or later to install a System Folder on that disk, and select it in the
Startup Disk control panel. See the instructions on installing
system software in the chapter on setting up your programs.

You can set aside virtual memory space on the hard disk
belonging to the PowerBook Duo, or on a hard disk connected to
the Duo MiniDock.

If you start up from an external hard disk, the preferences
selected on that disk override those selected on your PowerBook
Duo. When you use the PowerBook away from the minidock, the
computer uses the preferences associated with its own hard disk.

If you set aside virtual memory space on a hard disk connected to
the minidock, virtual memory will not be available when you use
the PowerBook away from the minidock. The next time you dock,
virtual memory is turned back on automatically.
If you set aside virtual memory space on the PowerBook’s hard
disk, virtual memory is always available.

v Startup disk surprise? If you select an external hard disk as
your startup disk, your PowerBook Duo will start up from any
external hard disk that has the same SCSI ID number as the
one you selected. v
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Modem
If you want to use an external modem with your PowerBook Duo
System, connect the modem cable to the Duo MiniDock port
marked with this icon: W
If your computer has an internal modem, select either Internal or
External Modem in the PowerBook control panel before opening
your telecommunications program.

If you have system problems

Removing the PowerBook Duo
from the Duo MiniDock
n

n

No SCSI devices or external monitor—use Sleep: If you
are not using any SCSI equipment or an external monitor, you
can disconnect the PowerBook while the computer is in sleep.
SCSI devices and/or monitor—use Shut Down: If you are
using SCSI equipment or an external monitor, you must shut
down the PowerBook and turn off any SCSI devices before
disconnecting.

If your docked computer crashes (the screen goes blank or fills
with gibberish) or freezes (the pointer doesn’t move and input
devices don’t work), press the power button on the back of the
minidock.

S Important: Don’t attempt to disconnect anything if the
PowerBook is still on. The computer will turn itself off, and
you will lose information you did not save. S

Pressing the power button erases any information you did not
save, but it allows you to restart the system and continue working.

Once the computer is in sleep or shut down, follow these steps:
1. Pull up on the lever at the top of the Duo MiniDock.
You may need to pull up twice to release the lever completely.
2. Gently pull the PowerBook away from the minidock.
If you always plan to use your connected devices in the same
location—at your desk, for example—you can leave everything in
place and simply disconnect the PowerBook Duo from the
minidock when you want to move the computer somewhere else.

Power button
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Using the PowerBook Duo Floppy Adapter
The Duo Floppy Adapter is an optional device that allows you to
connect a Macintosh HDI-20 External 1.4 MB Floppy Disk Drive
and up to three Apple Desktop Bus (ADB) devices—such as a
keyboard or mouse—to your computer.

Connecting the floppy adapter, disk drive,
and input device(s) to the PowerBook Duo
1. Make sure the PowerBook Duo is in sleep or shut
down. (Choose Sleep or Shut Down from the Special
menu.)
If you try to connect the floppy adapter with the computer
turned on, the computer turns itself off. You will lose any
information you did not save.

continues .
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2. Connect the floppy adapter to the PowerBook Duo.
You hear a click when the adapter is attached.

3. Connect the floppy disk drive’s cable to the floppy disk
drive port on the adapter. The port is marked with this
icon: H
Use only the Macintosh HDI-20 External 1.4 MB Floppy Disk
Drive with your PowerBook Duo. Other disk drives draw more
power than is recommended, and their connectors are of a
different type.
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4. If you are using an external keyboard or a mouse,
connect its cable to the Apple Desktop Bus (ADB) port
on the adapter. The port is marked with this icon: ◊
Since the floppy adapter has one ADB port, you’ll need to
chain devices together if you have more than one. For
example, you can connect a keyboard to the ADB port, and
then connect a mouse to the keyboard.

If you plan to use the computer’s battery as your power
source, the battery charge will last longer if you use ADB
devices designed for portable computers. These devices are
marked with this low-power icon: Á
If you plan to use your input devices with the power adapter
plugged in, it doesn’t matter which devices you use.
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Turning on the PowerBook Duo

n

On Apple keyboards, the Power On key is marked with a
triangle pointing left.

When you are ready to resume work, turn on the PowerBook Duo
in either of these ways:
n

Press the Power On key on your external keyboard.

Press the Power On key on your computer.

Trouble?
n

Power On key

Nothing happened.
Make sure everything is connected properly, and try pressing
the Power On key again.
The battery may be drained. Plug in the power adapter, and
then press the Power On key again.
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Disconnecting the floppy adapter, disk drive,
and input device(s) from the PowerBook Duo

If you always plan to use your connected devices in the same
location—at your desk, for example—you can leave everything
in place and simply disconnect the PowerBook Duo from the
floppy adapter when you want to move the computer
somewhere else.

1. Make sure the PowerBook Duo is in sleep or shut
down. (Choose Sleep or Shut Down from the Special
menu.)
If you try to disconnect with the computer turned on, the
computer turns itself off. You will lose any information you did
not save.
2. Remove the attached devices in any order.
Press the button on the floppy adapter to detach it from the
computer.

Floppy disk drive precautions
n

n

n

n

Button

Eject any disk from the drive before closing the cover.
Make sure the PowerBook Duo is in sleep or shut down
before connecting or disconnecting the disk drive.
Do not lift or carry the disk drive by its cable.
Avoid storing the disk drive where it will be exposed to
extreme heat or cold.

Other adapters
Additional PowerBook Duo expansion adapters are available from
other manufacturers. Most of them work in the same general way
as the floppy adapter, but see the information that came with the
equipment for instructions on connecting and using it.
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Using SCSI devices
A SCSI device is any product—including hard disk drives, CD-ROM
drives, scanners, and printers—that communicates with Macintosh
computers by means of a standard electronic interface. (SCSI
stands for Small Computer System Interface.) You can attach up to
six SCSI devices to your computer by linking them together in a
chain that starts at your computer system’s SCSI port.
There is a SCSI port on the Duo Dock and the Duo MiniDock.
(There is no SCSI port on the PowerBook Duo.) The SCSI port
looks like this:

SCSI port

SCSI port icon

To connect a SCSI device to this port, you need an Apple HDI-30
SCSI System Cable.
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Setting up one or more SCSI devices for use with your PowerBook
Duo System involves the steps listed here.
n

installing software

n

setting SCSI ID numbers

n

checking that the SCSI chain is properly terminated

n

connecting cables

These steps are described in the following sections.

Installing software
Most SCSI devices come with software that allows your computer
to communicate with them. These programs are called drivers. (If
no drivers come with a device, then it doesn’t need any.) To install
a driver, follow the instructions that came with the device.

Setting SCSI ID numbers
Each device in a SCSI chain must have a unique ID number
between 1 and 6 so the computer can identify it properly. The
information in this section can help you assign SCSI ID numbers
to the devices you want to use with your computer.

2. Locate the ID number indicator and switch (usually on
the back panel of the SCSI device).

ID number indicator
5

s Warning: Using two or more devices with the same SCSI ID
number can cause your equipment to malfunction. You could
lose information as a result. s

5

ID number switch

The hard disk inside your PowerBook Duo has the SCSI ID
number 0. If there is a hard disk in your Duo Dock, it has the SCSI
ID number 1. You can’t change this number, and you can’t assign
the ID number 1 to any other device you connect. (If there is no
hard disk in your Duo Dock, this restriction doesn’t apply.)

3. Check the ID numbers of all the devices you want to
connect.

See the documentation that came with your SCSI devices for
information about ID numbers and how to change them.

4. If you need to change a device’s ID number, choose an
available number between 1 and 6.

The ID numbers of Apple SCSI devices can be set as follows.

Remember that the number 1 is unavailable if your Duo Dock
has a built-in hard disk.

1. Make sure the SCSI device is turned off.
If the device is already part of a SCSI chain, make sure that all
devices in the chain are turned off, including the computer.

If all the devices have unique ID numbers, you’ve finished
this part of the procedure. Continue with the next section,
“Checking That the SCSI Chain Is Properly Terminated.”

5. Insert the end of a straightened paper clip into the
small hole below the ID number indicator.
The small hole gives you access to the ID number switch.
6. Push the ID number switch repeatedly until the
number you want appears in the ID number indicator.
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Checking that the SCSI chain is properly terminated

If you are attaching one SCSI device

To ensure accurate transmission of information, a chain of SCSI
devices must have a terminator at each end. Terminators are
built into some SCSI devices and can also be added externally.

Make sure that there is
n

an internal terminator in that device, or

n

an external terminator attached to that device.

If you are attaching more than one SCSI device
Make sure that there is
n

SCSI terminator
n

n

n

n

an internal terminator in, or an external terminator attached
to, the last device; and
no other terminator (internal or external) in the chain.

The Duo Dock and the Duo MiniDock both have built-in
terminators.

If you have too many devices with internal terminators, your
Apple-authorized service provider can remove extra terminators.

External SCSI devices from Apple do not have built-in
terminators.

Correct chain configurations are shown in the illustration on the
following page.

External SCSI devices from other vendors may have built-in
terminators; see the documentation that came with the
device.

What these facts mean to you: You do not need to add a
terminator at the beginning of the chain. You need to make sure
that the last (and only the last) device in the chain has an internal
or an external terminator.
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Connecting cables

Connecting one SCSI device

s Warning: When making SCSI connections, always turn off
power to all devices in the chain. Failure to do so can cause
the loss of information and damage to your equipment. s

If this SCSI device has an internal
terminator, omit this external terminator.

HDI-30 cable

1. Shut down your PowerBook and all SCSI devices in the
chain.
2. To connect the first device, use an Apple HDI-30 SCSI
System Cable.
Attach the smaller end of the cable to the SCSI port (marked
with the icon g) on the Duo Dock or the Duo MiniDock, and
the larger end of the cable to either SCSI port on the device.

Connecting more than one SCSI device
If this SCSI device has an internal
terminator, omit this external terminator.

HDI-30 cable

SCSI peripheral interface cables

3. To connect the next device, use a SCSI peripheral
interface cable.
Both cable connectors are the same. Attach one connector
to the available SCSI port on the first device, and the other
connector to either SCSI port on the next device.
4. Repeat step 3 for each additional device you want
to connect.
The illustration shows where to add cable terminators.

S Important: The total length of a SCSI chain should not
exceed 6 meters (20 feet). Apple SCSI cables are designed to
meet this restriction. If you are using SCSI cables from
another vendor, check the length of the chain. S
Once your SCSI devices are connected, always turn them on
before turning on your computer. If you turn the computer on
first, it may not be able to start up, or it may not recognize the
SCSI devices.
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Using your PowerBook Duo
as a SCSI disk
If you have a Duo MiniDock and a cable called the Apple HDI-30
SCSI Disk Adapter (which you can purchase separately), you can
connect your PowerBook Duo to any desktop Macintosh and have
the PowerBook function as though it were an external SCSI disk
drive. The PowerBook appears on the screen of the desktop
Macintosh as a hard disk icon, and you can transfer information
between the computers by dragging files. This feature of the
PowerBook is called SCSI disk mode.
SCSI disk mode is especially useful if you don’t have an external
floppy disk drive for your PowerBook Duo, or if you often need to
retrieve or store information on other Macintosh computers. You
can also use this feature to reinstall system software on your
PowerBook, as described later in this chapter.
s Warning: Follow the steps for connecting and disconnecting
SCSI devices carefully to avoid loss of information and
damage to your equipment. s

Connecting your computer as a SCSI disk
Before making any connections, you need to assign a SCSI ID
number to the PowerBook.
1. Choose Control Panels from the Apple (K) menu and
open the PowerBook Setup control panel.

2. In the SCSI Disk Mode section of the control panel,
click the ID number you want to assign.
If you are connecting the PowerBook to an existing SCSI
chain, make sure to give it an ID number different from those
of the other devices.

3. Turn off the PowerBook by choosing Shut Down from
the Special menu.
4. Shut down the desktop Macintosh.
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5. Turn off any other devices in the SCSI chain.

The illustration shows which cables to use and where to add
cable terminators. (Note that most configurations don’t
require external terminators.) Remove the terminator from
the last device in an existing chain before connecting the
PowerBook.

6. Connect the PowerBook to either (a) the desktop
Macintosh or (b) the end of the SCSI chain.
“Desktop Macintosh” includes all the models listed in the
illustration, as well as a PowerBook Duo in a Duo Dock.

Connecting to a desktop Macintosh

(a)
n
n

continues .

Models without internal hard disk: Classic, Classic II, LC, LC II, LC III, IIfx
Models with internal hard disk: Classic, Classic II, LC, LC II, LC III, SE,
SE/30, II, IIx, IIcx, IIc, IIsi, IIfx, Macintosh Centris, Macintosh Quadra

n

Models without internal
hard disk: SE, SE/30, II, IIx,
IIcx, IIci, Macintosh Centris,
Macintosh Quadra

n

n

Models without internal hard
disk: Plus, Portable
Models with internal hard disk:
Portable
No Terminator*

Terminator

SCSI system cable HDI-30 SCSI
disk adapter

SCSI system cable HDI-30 SCSI disk adapter

n

HDI-30 SCSI
disk adapter

Connecting to the end of a SCSI chain

(b)
n

SCSI system cable

Models without internal hard disk: Classic, Classic II, LC, LC II, LC III, IIfx
Models with internal hard disk: Classic, Classic II, LC, LC II, LC III, SE,
SE/30, II, IIx, IIcx, IIc, IIsi, IIfx, Macintosh Centris, Macintosh Quadra
SCSI peripheral
interface cables

SCSI system cable

HDI-30 SCSI disk adapter

n

n

Models without internal hard disk: Plus, Portable, SE, SE/30, II, IIx, IIcx,
IIci, Macintosh Centris. Macintosh Quadra
Models with internal hard disk: Portable
Terminator

SCSI system cable

SCSI peripheral
interface cables

HDI-30 SCSI disk adapter

*Do not use any terminators, non-Apple cables, or extension cables in this configuration,
or it will not work.
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s Warning: Always shut down the PowerBook before
connecting or disconnecting the SCSI disk adapter cable.
Connecting the adapter cable while the computer is turned
on can damage the computer. s
7. Turn on the PowerBook by pressing the Power On key.
After a few seconds a SCSI icon appears on the screen,
showing the SCSI ID number you assigned in step 2.

s Warning: If you do not see the SCSI icon, and the computer
either starts normally or displays an error message, choose
Shut Down (if you can) and then immediately disconnect your
computer from the SCSI chain. If you can’t choose Shut
Down, you should disconnect the cable anyway, or you may
lose information. Then go back and repeat steps 3 through 7,
making sure that you have shut down all your equipment, that
you are using the correct cables, and that you have put
terminators in the correct places. s
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8. Turn on the other SCSI devices in the chain.
9. Turn on the desktop Macintosh.
The PowerBook appears as a hard disk icon on the desktop
Macintosh. You can now transfer and use files as if the
PowerBook were an external disk drive.

Simplifying the SCSI disk connection process

Using SCSI disk mode to reinstall system software

If you regularly plan to use your PowerBook as a SCSI disk
with the same desktop Macintosh, you can leave the cables,
terminators (if any), and the SCSI disk adapter cable attached to
the desktop Macintosh. When you want to use your PowerBook as
a SCSI disk, simply shut down all devices and connect the adapter
cable to the SCSI port on the Duo MiniDock. Make sure to add a
terminator to the end of the SCSI chain when you remove the
PowerBook.

If you’re using SCSI disk mode to reinstall system software on
your PowerBook’s hard disk (because its System Folder was
damaged, for example), you may not be able to select a SCSI ID
number for the computer. If you don’t know what the current ID
number is, follow these steps:

These cables stay attached to your
desktop Macintosh or its SCSI chain.

1. If there is anything visible on the screen or any other
sign that the computer is on (even if it doesn’t appear
to be working properly), press the power button on the
back of the computer to make sure that all power is off.
2. Connect the PowerBook Duo to the Duo MiniDock.
3. Connect the SCSI disk adapter cable to the SCSI port
on the Duo MiniDock.

HDI-30 SCSI Disk Adapter

Connect and disconnect your computer here.

Don’t make any other connections yet.
4. Press the power button on the back of the Duo
MiniDock to restart the PowerBook Duo.

s Warning: Always disconnect your PowerBook from the
adapter cable when you are not using it as a SCSI disk. Your
PowerBook will not work correctly if the adapter cable
remains attached. s

continues .
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5. Note the SCSI ID number that appears on the screen.
You can’t change this number now, but if you are attaching
your PowerBook to an existing SCSI chain you can change the
numbers of other devices if there is an ID conflict.
6. Press the power button again to turn the PowerBook
off.
7. Shut down the desktop Macintosh and any other SCSI
devices in the chain.
8. Change conflicting SCSI ID numbers if necessary.

9. Connect the other end of the adapter cable to the
desktop Macintosh, or to the end of the SCSI chain.
The illustrations in the section “Connecting Your Computer
as a SCSI Disk” show the proper cables and terminator
placement.
10. Press the power button on the back of the Duo
MiniDock to restart the PowerBook.
11. Turn on the other SCSI devices in the chain.
12. Turn on the desktop Macintosh.
You can now reinstall system software on the hard disk in your
PowerBook Duo. Use the system software disks that came with
your PowerBook Duo, or with a system software upgrade kit
designed to work with your PowerBook. (The disks that came
with your desktop Macintosh, or any other Macintosh, may not be
the correct version.)
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Drawing battery power in SCSI disk mode

Quitting SCSI disk mode

Your PowerBook continues to draw battery power when you use it
as a SCSI disk. Low battery power is indicated by the appearance
of a blinking low-power warning on the PowerBook’s screen.

1. Shut down the desktop Macintosh.
2. Press the power button on the back of the Duo
MiniDock to turn off the PowerBook.
3. Turn off any other SCSI devices in the chain.
4. Disconnect the PowerBook from the adapter cable.

If you see this warning while using your computer as a SCSI disk,
either plug in the power adapter or quit SCSI disk mode, as
described in the next section, so you can remove the battery for
recharging. If you wait until the computer goes to sleep
automatically, you may lose information.
S Important: Do not attempt to change batteries while
your computer is in SCSI disk mode. S

If you regularly plan to connect your PowerBook to the same
desktop Macintosh, you can leave the adapter cable attached
to the SCSI chain on the desktop Macintosh. See “Simplifying
the SCSI Disk Connection Process,” earlier in this chapter.
S Important: If you leave the adapter cable attached to the
PowerBook, the computer will behave as though it is still in
SCSI disk mode when you try to restart. S
5. Disconnect the cables from the desktop Macintosh.
Your equipment is now ready for normal use. Make sure that
the SCSI devices connected to the desktop Macintosh are
properly terminated.
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Connecting a modem
Apple offers an optional, low-power, internal fax/data modem for
your computer. See the modem manual for information about this
modem and how to use it.
You can also connect an external modem to
n

the printer/modem port on the PowerBook Duo

n

the modem port on the Duo MiniDock

n

the modem port on the Duo Dock

To connect an external modem, follow these steps:
1. Make sure the computer is in sleep or shut down.
2. Connect the modem to a power source and to the
phone line.
See the documentation that came with the modem.
3. Make sure the modem is turned off.
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4. Connect the modem cable to the printer/modem port
(PowerBook Duo) or the modem port (Duo Dock or
Duo MiniDock).

Printer/modem port icon

Modem port icon

5. Turn on the modem.
6. Wake or restart the computer.
If your computer does not have an internal modem, the external
modem is ready to use.
If your computer does have an internal modem, continue with
step 7.
7. Choose Control Panels from the Apple (K) menu and
open the PowerBook Setup control panel.

8. Click the External Modem button.

Connecting a printer
The printer/modem port on the PowerBook Duo, and the
printer port on a Duo Dock or a Duo MiniDock, can accept either
a direct cable connection (to a printer such as the StyleWriter)
or a network cable connection (to a printer such as the
LaserWriter IINTX).

If you have an Express Modem and are using an external
modem, click the Normal button.

Printer port

Printer port icon

Some printers, including the Personal LaserWriter SC, are
connected through the SCSI port.
9. Close the control panel.

Follow the instructions that came with your printer to connect it
to your computer.

The external modem is ready to use.
If you have both an internal and an external modem, remember to
to select the modem you want to use in the PowerBook Setup
control panel before opening your telecommunications program.
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Connecting sound input and
output devices
The Duo Dock and the Duo MiniDock have a sound input port
(marked with the icon X) to which you can connect a
microphone.
The microphone provided with the Duo Dock can pick up sounds
within a range of several feet. You can place it near your computer,
or you can use the clip provided to attach it to your clothing. The
microphone has no on/off switch; it is controlled by the program
you use to record sounds. (Sound recording is described in the
chapter on sound and color.)
s Warning: Do not plug a sound output device (such as a pair
of headphones) into the sound input port. Doing so may
damage your audio equipment. s
The Duo Dock and the Duo MiniDock also have a sound output
port (marked with the icon -) to which you can connect
speakers, an amplifier, headphones, or other audio output
devices. The sound output port accepts a standard stereo
miniplug, like that used to attach headphones to a portable tape
player.
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Adding memory to your computer
Your PowerBook computer comes with at least 4 MB of RAM. By
adding memory upgrade cards you can increase your computer’s
memory up to 24 MB. (Note that any time you have 8 MB of RAM
or more, you need to turn on 32-bit addressing. See the section
called “Turning on 32-bit addressing” for help.) You can find out
how much memory your computer has by choosing About This
Macintosh from the Finder’s Apple menu.
Apple provides memory upgrades through its authorized dealers.
Memory upgrades are also available from other vendors; ask your
dealer for more information.
It is recommended that memory upgrades be installed by an
Apple-authorized dealer.
Your PowerBook computer also supports virtual memory, a
feature that makes use of hard disk space to provide additional
RAM.

Chapter 14

Travel, Storage, and Service
In this chapter
n

Traveling with the computer

n

Storing the computer

n

Getting service and support

n

Getting more information about Macintosh computers

Traveling with the PowerBook
The safety instructions in the first part of this book also apply
when you are traveling. In addition, note these precautions:
n

n

n

n

n

n

Do not transport your PowerBook while it is turned on.
Choose Sleep or Shut Down from the Special menu, and wait
until the hard disk stops spinning, before you move the
computer.
Transport batteries either inside the computer or in the
protective case provided with each battery. Do not transport
unprotected batteries.
Bring backup copies of your system software and other
important files on floppy disks, in case you need to
reinstall them.
Do not check your computer as baggage. Carry it with you.
Do not allow your computer or any hard disks or floppy disks
to pass through X-ray machines. Have security officials
manually inspect your computer and disks.
Be prepared to show security officials that your computer
is working. Have a charged battery or power adapter ready
to use.
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n

n

Some airlines may restrict or prohibit the use of computers in
flight. Check ahead to find out what restrictions, if any, apply.
Take the necessary plug adapters if you’re traveling overseas.
( You may need to use them with the power adapter.) You do
not need a voltage transformer. The power adapter can handle
90 volts to 260 volts AC (48 to 62 Hz).
Check the diagrams below to determine which plug adapters
you’ll need, or ask your travel agent.

Outlet Type

Locations
United States, Canada, parts of Latin America,
Japan, Korea, the Philippines, Taiwan
Former Soviet Union, most of Europe,
parts of Latin America, the Middle East,
parts of Africa, Hong Kong, India,
most of South Asia
Mexico, United Kingdom, Ireland, Malaysia,
Singapore, parts of Africa
China, Australia, New Zealand
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Storing the PowerBook
1. Save your work onto a hard disk or floppy disks.
2. Choose Shut Down from the Special menu.
3. Close the display.
4. Store the computer in a cool, dry place.
Storage temperatures should remain between 10° C/50° F and
40° C/104° F. Avoid leaving the computer where temperatures
may be extreme or unpredictable—in the trunk of a car, for
example.
You can store the computer with or without its battery. If you’re
planning to store the computer for longer than a month, plug in
the power adapter or remove the battery.

Protecting the PowerBook Duo system
from theft
The Duo Dock, Duo MiniDock, and Duo Floppy Adapter all have a
security slot to which you can connect a locking device and
security cable.
If you attach the cable to the Duo Floppy Adapter, for example,
and then connect the adapter to your computer, the adapter and
computer are both protected because the floppy adapter cannot
be removed from the computer until the security cable is
detached.
See your Apple-authorized reseller for more information about
this security system.

Service and support
If the PowerBook malfunctions or is damaged
If your computer is malfunctioning but does not appear to be
physically damaged, shut it down (and leave the power adapter
plugged in, if possible) until you can get help.
If you know or suspect that your computer is physically damaged,
disconnect the power adapter, remove the battery, and do not use
the computer until it can be repaired.

How to get help
For information on service and support, see the resource
information that came with your computer for instructions on
how to contact an Apple-authorized service provider or Apple for
assistance.
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If you cannot return to the Apple-authorized dealer from whom
you purchased your system, go to the nearest service location. For
the location nearest you, write or call one of the following:
Apple Computer, Inc.
Customer Relations
20525 Mariani Avenue
Cupertino, CA 95014-6299
USA
(800) 538-9696

Apple Canada, Inc.
7495 Birchmount Road
Markham, Ontario, L3R 5G2
Canada
(800) 268-7796/7637

For locations in other countries, either call the Apple
headquarters in your country or write to the United States
address on this page.
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Apple also offers service plans. One is the AppleCare Service
Agreement (available in the United States, Canada, and Australia
only), which extends full warranty coverage up to three years.
Your AppleCare contract will be honored at any participating
Apple-authorized dealer within the country of purchase—an
added benefit if you relocate.
You can purchase AppleCare at any time, but you may want to
purchase it with your system, or at least before your warranty
expires, to avoid an inspection at your own expense.

For more information about
Macintosh computers
Macintosh user groups
Whatever your level of computer experience, you may be
interested in joining a Macintosh user group. Group activities may
include new product demonstrations, question-and-answer
sessions, and classes on using programs or writing your own
programs.
Ask your Apple-authorized dealer for the name of the Macintosh
user group nearest you, or call 800-538-9696. For names of user
groups outside the United States, or if you’re interested in starting
your own group, contact:
Berkeley Macintosh User’s Group
1442-A Walnut Street, #62
Berkeley, CA 94709
USA
510-549-BMUG (510-549-2684)
or
Boston Computer Society
One Center Plaza
Boston, MA 02108
USA
617-367-8080

Technical information
Apple makes technical information for Macintosh computers
available through the Apple Technical Library and the Apple
Communications Library, both published by Addison-Wesley
Publishing Company and available at bookstores.

Apple Technical Library
The Apple Technical Library includes comprehensive technical
documentation for all Macintosh computer models as well as
the multivolume guide to the Macintosh operating system,
Inside Macintosh.

Apple Communications Library
The Apple Communications Library offers complete technical
information about Macintosh communications products and the
Macintosh in a network environment.

APDA
APDA (Apple Programmers and Developers Association) offers
access to a broad range of programming products, resources, and
information for anyone developing hardware or software for
Apple computers. These resources include the most current
versions of Apple and third-party development tools, debuggers,
compilers, languages, and technical references.
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To establish an APDA account, obtain ordering information, or
find out about site licensing and developer training programs,
contact:
APDA
Apple Computer, Inc.
20525 Mariani Avenue, M/S 33-G
Cupertino, CA 95014-6299
800-282-2732 (USA)
800-637-0029 (Canada)
408-562-3910 (International)
Fax: 408-562-3971
Telex: 171576
AppleLink address: APDA
If you provide commercial products and services, call
408-974-4897 for information about the developer support
programs available from Apple.
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Assistance for hardware and software developers
If you plan to develop hardware or software products for sale
through retail channels, you can get valuable support from Apple
Developer Programs. Write to:
Apple Developer Programs
Apple Computer, Inc.
20525 Mariani Avenue, M/S 51-W
Cupertino, CA 95014-6299
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Summary and Shortcuts

Working with icons
Selecting icons

Double-click
n

Double-click an object on screen by pointing to the
object and clicking twice in rapid succession, without
moving the mouse.
Double-clicking is a common shortcut for opening an icon or
the selected item in a directory dialog box.

Shift-click
n

Hold down the Shift key while clicking.
Shift-clicking is a way to select more than one icon or item
in a list.

To do this

Take these steps

Select an icon

Click the icon.

Deselect an icon

Click anywhere except the selected icon.

Select multiple icons

While holding down the Shift key, click
each icon.

Deselect an icon in a
group of selected icons

While holding down the Shift key, click
the icon.

Select multiple icons
that are near each other

1. Place the pointer at one corner of the
group of icons.
2. Drag diagonally to select the icons, then
release the mouse button.

Select contiguous icons
in a list

1. Place the pointer to the left of the top icon
or the bottom icon.
2. Drag up or down the list, releasing the
mouse button when the pointer is left of the
last icon.

Select text in an icon’s
name

Click the icon’s name (not the icon itself).
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Opening an icon

Working with windows

You open an icon by selecting it and choosing Open from the File
menu or using the keyboard shortcut x-O or x-Down Arrow. Or
you can double-click the icon.

Making a window the active window

Moving, copying, and renaming an icon
To do this

Take these steps

You make a window active by clicking inside it. You can also make
a window active by clicking its icon (even though it’s dimmed)
and choosing Open from the File menu, or by double-clicking the
dimmed icon.

Move an icon

Drag the icon to where you want it.

Moving a window and changing its size

Copy an icon onto
another disk

Drag the icon to the icon of the other disk
(or to an icon or window that belongs to
that disk).

To do this

Copy an icon on the
same disk

Rename an icon
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1. Click the icon to select it.
2. Choose Duplicate from the File menu, or
press x-D.
3. If you wish, rename the icon and drag it to a
new location. You can also make a copy by
holding down the Option key while you drag
the icon to another folder or window.
1. Select the icon’s name by clicking the name
(not the icon).
2. Type a new name and press the Return key.

Take these steps

Move a window

Drag the window’s title bar (at the
top of the window) to the new
location.

Resize a window

Drag the size box (in the
lower-right corner).

Or click the zoom box (in the
upper-right corner).
Close a window

Click the close box (in the
upper-left corner).
Or choose Close from the File
menu.
Or press x-W.

Scrolling through the contents of a window

Scroll box (shows
relative location in
window)

Opening higher-level folder windows
You can open a higher-level folder window (whose contents
include the active window) from a pop-up menu in the active
window’s title.
1. Hold down the x key as you press the active window’s
title.
A pop-up menu of the higher-level folders (and the disk)
appears.
2. Drag to choose a higher-level folder (or the disk), and
then release the mouse button.
The folder (or disk) window you chose appears as the active
window.

Scroll arrow (used
to view the content
beyond the
window’s borders)

n

n

n

Every window has two scroll bars, one for vertical
scrolling and one for horizontal scrolling. (A gray
scroll bar indicates more content beyond window’s
borders; a clear bar indicates all content is visible.)

Click the up, down, left, or right scroll arrow.
Click the vertical or horizontal scroll bar (when it’s
gray).
Drag the vertical or horizontal scroll box along its
scroll bar.

Open pop-up menu with the
name of the active window
at the top (“Old reports”)
Active window
showing the
contents of the
folder named “Old
reports”
This folder contains the folder “Old reports.”

If you hold down the Option key as well as the x key, the old
window closes when the new window appears.
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Using the outline form in list views

Working with menus

Any list view you choose from the View menu (that is, any view
except the icon and small icon views) shows the contents of the
active window in outline form. You can see the contents of a
folder without opening the folder in its own window.

Macintosh menus come in two types: pull-down menus and
pop-up menus. The menus in the menu bar are pull-down menus.

Menu bar (you
pull down menus
from here)

Open folder (with contents
indented below)

Menu titles

The Application
menu, which
shows the
programs that
are currently
open

Open folder inside
another folder
(with contents
indented below)

A downward-pointing triangle indicates that the folder’s
contents are displayed; a right-pointing triangle
indicates that the folder’s contents are hidden.

Click the triangle next to a folder name to display or hide the
folder’s contents in the active window. If you double-click a folder,
it opens in its own window, and its outline view closes.
v Shortcuts: When a folder is selected in an outline view,
pressing x–Right Arrow displays its contents and
x–Left Arrow hides its contents. v
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The Help menu, which
you use to display
information about items
on the screen

Dimmed command
(not available)

Menu commands affect
whatever you’ve
selected— in this case,
“Macintosh HD.”

Pop-up menus often appear in dialog boxes that you use to set
options or preferences. You can recognize a pop-up menu by a
small solid triangle, pointing down, next to its name. The name
shows the current option or preference.
Pop-up menu (closed)

Pressing the triangle
displays the menu
(but does not allow
you to choose a
menu item).

Choosing an item from a menu
To choose a command from a menu, point to the menu name,
press to “pull down” or “pop up” the menu, drag to the item you
want to choose so that it’s highlighted, and then release the
mouse button.

Choosing an item from a submenu
Some menu items are submenus. A submenu name has a small
solid triangle next to it, pointing to the right. The submenu opens
when the submenu name is highlighted.
To choose an item in a submenu:
1. Point to the menu name and press to open the menu.

Pressing the menu title or the icon displays
the menu and selects the title (allowing you
to choose a menu item by dragging to it).

2. Drag to the menu item so that the submenu appears.

continues .
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3. Drag sideways to the submenu, drag to the submenu
item you want to choose so that it’s highlighted, and
then release the mouse button.

Keyboard shortcuts in the Finder and in
directory dialog boxes
Key

Action

Up, Down, Left,
or Right Arrow key

Selects the next item in the direction of the
arrow

Tab key

Selects the next item alphabetically (except in a
directory dialog box and the Chooser)

Character
key (a, b, c . . .)

Selects the first item whose name begins with
that character (or the character following
closest to it in the alphabet)

x–Down Arrow

Opens the selected icon

x–Option–Down Arrow Opens the selected icon and closes the current
folder

x–Up Arrow

Opens the folder that contains the current folder

x–Option–Up Arrow

Opens the folder that contains the current
folder and closes the current folder

Return or Enter

In the Finder: Selects the selected icon’s name
for editing or saves the edited name
In a dialog box: the same as clicking the button
with the bold outline around it
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Troubleshooting
This section describes possible causes and solutions for some
common problems you may have with your PowerBook Duo, the
Duo Dock, the Duo MiniDock, or associated equipment provided
by Apple.

The PowerBook Duo
The computer won’t start.
n

This section is not comprehensive. Check the appropriate
reference section for additional help on specific topics.
s Warning: If you have a problem with your Apple computer
equipment and nothing presented in the manuals that came
with the equipment solves the problem, consult the service
and support materials that came with your computer for
information on how to contact an Apple-authorized service
provider or Apple for assistance. Attempting to repair the
equipment yourself may void the Limited Warranty. Contact
an Apple-authorized service provider or Apple for additional
information about this or any other warranty question. s

n

n

The computer may be on, but the screen brightness or
contrast may be turned down. Adjust the brightness and
contrast controls to see whether an image appears on
the screen.
The battery may be drained. Plug in the power adapter and
then press the Power On key above the keyboard.
There may be a temporary problem with the computer’s
power system. Press the x (Command), Control, and Power
On keys simultaneously, or press the power button on the
back of the computer.
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The computer just stopped.
n

n

n

The computer may have gone to sleep. Press any key (except
Caps Lock) or the Power On key to wake it again.

The computer exhibits odd behavior, such as many
unexplained system failures.
n

The battery may have drained so far that the computer has
put itself to sleep to protect the contents of RAM. Plug in the
power adapter and then press the Power On key.
The computer may have “crashed” due to temporary software
problems. Click the Restart button on the screen (if you see
one); press the x (Command), Control, and Power On keys
simultaneously; or press the power button on the back of the
computer. If you use these methods, you will lose any work
you have not saved.

n

n

n
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A common cause of unexplained problems is multiple System
Folders on your computer’s startup disk. The System Folder
that the PowerBook is using to operate is marked with an
icon. Use the Find command in the Finder’s File menu to
locate any other System Folders, and throw them in the Trash.
You may have a virus on your hard disk. Obtain a virusdetection program, use it to check all your disks, and
eliminate any viruses the program finds.
You may be using a program that’s not compatible with your
computer’s system software. Check the manual that came
with the program or contact the manufacturer.
You may have added a control panel or extension that is
incompatible with other programs you use. Restart the
computer with the Shift key held down until you see the
message “Extensions off.” If the problem does not recur,
remove any such items you recently installed.

Power

The battery can’t be recharged.
n

The battery is draining too fast.
n

n

n

n

Turn down the screen brightness, turn off virtual memory,
move the battery conservation slider in the PowerBook
control panel to Better Conservation, or work with the power
adapter plugged in.
Your computer supplies power to the modem whenever a
communications program is open. Quit your communications
program if you aren’t using it.
If you aren’t using network services, you can also save power
by turning off AppleTalk in the Chooser.
Your battery may need to be discharged and recharged
completely. See Chapter 6.

n

Older PowerBook batteries do not hold a charge as well as
new ones. You may need to replace the battery.

If all connections are OK, then the battery is probably
damaged or dead. You’ll need to obtain a replacement battery
from your Apple-authorized dealer.

The computer goes to sleep too often.
n

Open the PowerBook control panel and slide the slider to
Better Performance.

The PowerBook won’t run off the battery and/or the
battery won’t charge.
n

n

There may be a loose connection. Make sure all plugs are
securely attached.

Make sure your PowerBook is running system software
version 7.1 or later. You may have a new battery which
requires the later system software version.
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The computer doesn’t go to sleep automatically.
n

You may have dragged the slider to Never in Custom view of
the PowerBook control panel. Drag the slider to a lower
setting.

The screen
The screen looks blurred or out of focus.
n

n

n

n

n

n

You may be connected to a shared disk on the network. If you
are not using the information on the shared disk, disconnect
from it.
The printer/modem port may be in use. Quit your
telecommunications program or turn off background printing
in the Chooser (if the documents you’re printing can wait
until later).
One or more applications may be doing work in the
background. You can choose Sleep from the Special menu to
override them.

The screen is too dark.
n

n

n

The computer does not go to sleep if it is being used in a
Duo Dock.
The computer does not go to sleep if you are using it with a
Duo MiniDock and
m an external monitor or SCSI device is attached, or
m you started or restarted the computer after connecting it.

See Chapter 6 for more information about batteries and power
consumption.
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The viewing angle may not be optimal. Tilt the display on its
hinge until the screen looks better.

When you first turn on your computer, it may take several
minutes for the screen brightness to “warm up,” especially if
you’ve chosen a high setting.
The screen brightness or contrast may not be optimal for the
surrounding lighting. Adjust the brightness or contrast setting.
The screen dims automatically when the battery starts to run
low. You may need to recharge or replace the battery before
you can turn up the brightness.

The screen is flickering.
n

This problem sometimes occurs when your screen is set to
display the maximum number of grays. Try adjusting the
contrast control, or select fewer grays in the Monitors control
panel.

There are ghost images or black dots on the screen.
n

When the computer is left on for many hours, temporary
defects may appear on the screen. Put the computer to sleep.
The longer the computer was left on, the longer it will take for
the images to fade, but they will eventually disappear.

A window has disappeared.
n

n

The pointer moves too fast/too slowly.
n

You need to adjust the pointer’s tracking speed. Open the
Mouse control panel and choose a more comfortable setting.

n

A software problem may have caused the computer to
“freeze.” Restart the computer by pressing the Command (x),
Control, and Power On keys simultaneously. You will lose any
work you have not saved.

Windows belonging to open but inactive programs may be
hidden. Choose Show All from the Application menu to show
hidden windows.

An icon is blinking in the menu bar.
n

The pointer won’t move at all.

Another open window on the desktop may have covered the
one you’re looking for. Move, resize, close, or hide windows
you aren’t using until you see the one you want.

One of your programs needs attention. For example, you may
have set the Alarm Clock to go off at a particular time, or
PrintMonitor may be alerting you to a printing problem. Make
the program active and take the necessary action.
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The trackball

Memory

The trackball doesn’t work smoothly; it sticks or jumps
when rolled.

A “not enough memory” message appears when you try to
open a program.

n

There may be dust or dirt inside the trackball mechanism. To
clean the trackball, follow these steps.

n

1. Remove the trackball by turning the trackball retainer ring
counterclockwise, and lifting the trackball out of its cavity.
You may need to use a pen or your fingernail to lift the
trackball out.
2. Locate the small rubber rollers at the left and bottom
sides of the trackball cavity.

n

n

The rollers may look like small rings or wheels.
n

3. Use any reasonably clean, blunt object (your finger, a
cotton swab) to wipe off the rollers. Do not use any liquid
inside the computer.
4. Replace the trackball and its retainer ring.

n

This problem is related to the way the trackball is lubricated.
After you use it for a few minutes, the problem should go
away.
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If you are using a RAM disk or a disk cache, reduce its size and
then restart the computer.
Use extra space on your hard disk as virtual memory to
increase the amount of memory available for opening
programs.
If you consistently want to open more programs than memory
allows, you can purchase a memory expansion card from your
Apple-authorized dealer.

Virtual memory is supposed to be on, but it’s off.
n

You just cleaned the trackball, and it feels worse than
before.

Quit any programs you aren’t using, then try again to open
the program you want. If that doesn’t work, restart the
computer. Sometimes restarting makes additional memory
available.

If you set aside virtual memory space on the hard disk in or
connected to the Duo Dock or the Duo MiniDock, virtual
memory is not available when you use the computer away
from the dock. The next time you dock, virtual memory is
turned back on automatically. You can set aside space on your
computer’s internal hard disk if you want to use virtual
memory when the computer isn’t docked.

The Duo Dock

The computer is on but the monitor is blank.
n

You can’t insert the computer into the dock.
n

n

n

The dock may be locked. Turn the key to the horizontal
(unlocked) position and insert the computer again.
The door covering the dock connector may not be open.
Open the door and insert the computer again.
The PowerBook may not be shut down. Remove the
computer, open the display, choose Shut Down from the
Special menu, and try again.

You can’t turn on the docked computer.
n

Make sure all your equipment is connected properly and then
press the Power On key on your external keyboard. If nothing
happens, press the power switch on the back of the dock.

Make sure that the monitor is plugged in and that its power
switch is on. Then adjust the brightness and contrast controls
as necessary.

You can’t eject the computer from the dock.
n

n

The dock may be locked. Turn the key to the horizontal
(unlocked) position and press the eject button again.
Power to the dock may be interrupted. Insert the dock’s key, a
small screwdriver, or a similar object into the square hole on
the side of the dock and press gently to eject the computer.
( When the dock is locked, the hole is not available.)

See Chapter 13 for more information about the Duo Dock.
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The Duo MiniDock
You can’t turn on the docked computer.
n

n

Make sure your equipment is connected properly and then
press the Power On key on any of your keyboards. If nothing
happens, press the power button on the back of the
minidock.
The computer’s battery may need to be recharged. Plug in
the computer’s power adapter and then try pressing the
Power On key again.

The battery drains very quickly when you use the
computer with the minidock.
n

If you are using an external monitor, SCSI equipment, a
printer, or an external modem, you need to plug in the
computer’s power adapter.
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The menu bar appears on the PowerBook’s screen, but you
want it to appear on an external monitor.
n

n

Make sure the external monitor is connected properly and
turned on.
Make the external monitor the main monitor by opening the
Monitors control panel, dragging the small menu bar icon
from the small screen to the large one, and restarting the
computer.

See Chapter 13 for more information about the Duo MiniDock.

SCSI devices

n

You can’t turn on the computer after connecting a
SCSI device.
n

SCSI devices must be turned on before the computer itself.
Turn on the SCSI device(s) first, and then turn on the
computer.

The computer doesn’t recognize your SCSI devices.
n

n

n

The devices may be off. Check to make sure that they are
plugged in and turned on.
If the device is a disk drive, it may need to be initialized before
you can use it. See the instructions that came with the device.

n

n

Two or more devices in the SCSI chain may have the same ID
number. Check the ID number of each device to make sure
each one has its own number between 1 and 6, and change
any numbers that are not unique. (If there is a hard disk in
your Duo Dock, that disk has the ID number 1.)
When connecting SCSI equipment, it is important to use the
right cables and the correct number and placement of cable
terminators. Check the cables and terminators in the SCSI
chain and make sure that all cables are firmly attached.
A PowerBook connected to a Duo MiniDock in sleep cannot
recognize an attached SCSI device. Make sure the SCSI device
is turned on, and then restart the computer.

See Chapter 13 for more information about working with SCSI
devices.

The software (driver) needed to run the device may not be
installed in your System Folder. See the instructions that came
with the device.
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Disk drives and disks

n

The computer won’t start up from its hard disk, or the
hard disk icon doesn’t appear on the desktop.
n

n

n

There may have been a temporary software problem. Shut
down the computer, wait at least 10 seconds, and then turn it
on again.
If the computer is in a Duo Dock, someone may have selected
the dock’s hard disk as the startup disk. You can change this
setting in the Startup Disk control panel.
There may be a problem with the system software on the hard
disk. Start up the computer with the Disk Tools disk. If the
hard disk’s icon appears, reinstall system software as
described in Chapter 5. Disk repair programs can sometimes
fix problems of this kind.
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n

The information on the disk drive may be damaged. Try using
a disk repair program to repair or recover the information. If
this doesn’t work, you’ll need to reinitialize the hard disk. See
Chapter 7.
There may be a mechanical problem with the disk drive. If
none of the above suggestions works, take the computer to an
Apple-authorized service provider.

The hard disk keeps stopping and starting again.
n

The hard disk may be going to sleep to conserve power. Open
the PowerBook control panel and move the Battery
Conservation slider toward Better Performance.

The hard disk is full.
n

You can reclaim space on your hard disk by removing
unneeded files; installing a smaller, customized System Folder;
turning off virtual memory; or purchasing a disk optimization
program to reorganize the information on the hard disk.

A high-density (1.4 MB) disk you use with your PowerBook
computer is not recognized by another Macintosh.
n

The icon of a floppy disk doesn’t appear on the screen.
n

There may be a problem with the disk or disk drive. Try
inserting a different disk. If its icon does appear, the original
disk is probably damaged. You may be able to repair the disk
or recover some of the information on it. See Chapter 7. If the
icon of the second disk does not appear either, take the disk
drive to an Apple-authorized service provider for repair.

Some disk drives cannot recognize high-density disks. Try
inserting an 800K or 400K disk in the disk drive of the other
Macintosh. If that works, copy your files to an 800K disk or a
400K disk. If you regularly plan to use floppy disk drives of
different types, use the lower-capacity disks in all drives.

You can’t eject a disk from a floppy disk drive.
n

There may be a temporary mechanical problem with the disk
drive. Restart the computer and hold down one of the
trackball buttons while the computer starts up. If that doesn’t
work, carefully insert the end of a straightened paper clip into
the small hole near the disk drive’s opening, and push gently
until the disk is ejected.
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A message says that a disk is not initialized—but you
know that it is.

You can’t save or copy files onto a floppy disk.
n

n

The disk may not be seated properly in the disk drive. Eject it
and try inserting it again.
n

n

The disk may be damaged. If you insert another disk in the
drive and the message does not appear, you can assume that
the original disk needs repair. See Chapter 7 for information
about recovering information from a damaged disk. If the
second disk is also not recognized, take the disk drive to an
Apple-authorized service provider.

You can’t delete a file.
n

n

n

The floppy disk may be locked. Unlock it by sliding the tab so
that it covers the hole at the corner of the disk.
The file may be locked. You can unlock it in its Info window
(choose Get Info from the File menu). Or you can hold down
the Option key while you choose Empty Trash from the
Special menu.
An application program may be using the file. You’ll need to
quit the program.
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The disk may be locked. Unlock it by sliding the tab so that it
covers the hole at the corner of the disk.
The disk may be full. Delete files you no longer need or use a
different disk.

See Chapter 7 for more information about working with disk
drives and disks.

Modems

Printers

The external modem doesn’t work.

Your computer can’t find the printer.

n

The modem may be turned off or improperly connected.
Make sure it is turned on and that all connections are correct.

n

n
n

n

The modem port may not be activated. Open the PowerBook
Setup control panel and make sure that External Modem is
selected.
If you have an Express Modem, open the Express Modem
control panel and choose Normal. See the user’s guide that
came with your Express Modem for more help.

The internal modem doesn’t work.
n

The modem connection may not be activated. Open the
PowerBook Setup control panel and make sure that Internal
Modem is selected.

See the modem manual for more information about using and
solving problems with your modem.

The printer may be turned off. Turn it on.
The printer may not be selected in the Chooser. Open the
Chooser and select the printer you want to use.

Your printer does not appear in the Chooser window.
n

n

n

n

The printer may not be connected properly. Check the
connections between your computer and the printer,
including relevant sections of the network if appropriate.
The printer software may not be in your System Folder. Close
the Chooser and install the software you need.
AppleTalk must be active before you can use a network
printer. Make sure that AppleTalk is active in the Chooser.
If your network has zones, the printer you want may not be in
the currently selected zone. Make sure the correct zone is
selected.

Quick Reference 293

The network printer keeps restarting.
n

Someone on the network may be using a different version of
the printer software. Everyone connected to a network should
use the same printer software version. Consult the network
administrator for more information.

Nothing happens, or you see an error message, when you
try to print.
n

n

n

The printer may not be turned on. Make sure it is turned on
and warmed up.
The printer may be out of paper or have some other problem.
Check the printer status lights and any messages on your
screen.
If an error message states that the printer could not print your
document, turn the printer off for at least 10 seconds. Then
turn it on again, wait for it to warm up, and try to print again.
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Your documents are printed with the wrong fonts.
n

The printer may not have your fonts in its memory and is
substituting other fonts. You may be able to add the necessary
fonts to your printer (see Chapter 11), or print on a different
printer that has the fonts you want. If you have a LaserWriter,
you can turn off Font Substitution in the Page Setup dialog
box.

See Chapter 11 for general information about printing documents.
See the printer manual for more information about your printer’s
features or problems with the printed output.

Networks

You can’t open a shared disk or folder.
n

You can’t find or can’t open icons needed to set up
file sharing.
n

n

One or more icons may be in the wrong place. Make sure that
the Sharing Setup icon is in the Control Panels folder, and that
the File Sharing Extension file, the Network Extension file, and
the AppleShare file are in the Extensions folder. (Both folders
are inside the System Folder.)
Some network software may not be installed. Use the Installer
to install the appropriate network software.

n

n

n

n

AppleTalk must be active before you can use a shared disk.
Make sure that AppleTalk is active in the Chooser.
If your network has zones, the shared disk you want may not
be in the currently selected zone. Make sure the correct zone
is selected.

You may have entered your name or password incorrectly
when you tried to open the shared disk or folder. Check with
the owner of the item to make sure you are entering your
name and password correctly, and try again.

You can’t connect to your own computer from another
Macintosh.
n

The shared disk you want to connect to does not appear in
the Chooser window.

You may not have the access privileges needed to use the disk
or folder. Ask the network administrator or the owner of the
shared item to grant you access.

Make sure that your computer is turned on, file sharing is
turned on for both computers, you have the correct access
privileges, and you entered your name and password
correctly.

See Chapter 12 for more information about using your computer
on a network.

The computer that the disk is on must be turned on before
the disk can be shared. Make sure that computer is on and
that it has file sharing turned on.
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Application programs

A program doesn’t work, or malfunctions consistently.
n

A program won’t open.
n

n

n

Some programs can’t be opened from a locked floppy disk.
Make sure the disk is unlocked.
The program may be damaged. Recopy it from a known good
source (such as the original program disk).
There may not be enough memory available to open the
program. Quit other programs or change the program’s
memory size in its Info window.

n

n

n

You may have more than one copy of the program on your
hard disk. Remove extra copies by dragging them to the Trash.
The program may be damaged. Recopy it from a known good
source (such as the original program disk).
Your version of the program may be incompatible with your
system software. Consult the software manufacturer to find
out which version of the program you should be using.
The program may be using less memory than it needs to work
with your documents. Choose Get Info from the File menu
and increase the memory size.

A program runs very slowly.
n

Some programs are slowed by processor cycling. You can turn
processor cycling off; see Chapter 6.

A message says that a program could not be found.
n

You may be trying to open a document created with a
program you don’t have on your computer, or created with a
different version of the program. Obtain the correct program
and version. Or open the document with another program
that can read its format. (If another program can open a
document, the program icon becomes highlighted when you
drag the document icon to it.)
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You just did something you didn’t mean to do.
n

If you have not yet taken any other action, you can usually
undo your most recent action (even if you aren’t sure what it
was). Most programs have an Undo command in the Edit
menu. Choose Undo to go back one step in your work. You
cannot undo more than one action.

See the documentation that came with your programs for more
information about their operation and features.
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Return key: Moves the
insertion point to the
beginning of the next
line. In a dialog box,
pressing Return is the
same as clicking the
outlined button.

Keyboard and Character Sets
Tab key: Moves the insertion point
to the next stopping place (such as
a tab stop or data field).

Caps Lock key: A Shift key for
letters only (numbers and
symbols aren’t affected).
Shift key: Produces capital
letters (or the upper character
on the key).
Control key: In combination
with other keys, provides
shortcuts or modifies actions.
Option key: In combination with
other keys, produces special
characters or modifies actions.
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material, or the character to
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x (Command) key: Works in combination with
other keys as an alternative to choosing a menu
command or (in some programs) canceling an
operation in progress, such as printing.

Arrow keys: Move the insertion
point, as an alternative to using the
trackball. In some programs, the
arrow keys have other functions.
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Using Caps Lock

Typing special characters and symbols

The Caps Lock key on PowerBook computers does not stay
depressed even when it’s locked. Caps Lock is on when the light
on the key itself is on.

You can type a variety of special characters (with diacritical marks)
and symbols by pressing modifier keys in combination with
certain letter and number keys.

To turn Caps Lock on or off, press the Caps Lock key.

The Key Caps program, which is installed with the system
software, shows you the characters produced when you type
certain keys and key combinations in the fonts available on your
computer. Choose Key Caps from the Apple (K) menu, then
choose the font from the Key Caps menu.
Characters appear here when you press keys on
the keyboard or click them in the window.

Characters available in
the Chicago font
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Characters
available in the
Chicago font
when the
Option key is
pressed

The highlighted key represents the
key held down on the keyboard— in
this case, the Option key.

To type a character with a diacritical mark (such as an acute accent
or an umlaut), you press the Option key along with a specific
letter key, and then type the character.
Diacritical mark

Key combination

Grave accent ( ` )

Option–`, then type the character

Acute accent ( ´ )

Option–e, then type the character

Circumflex (^)

Option–i, then type the character

Tilde (~)

Option–n, then type the character

Umlaut ( ¨ )

Option–u, then type the character

The letter “c” with a cedilla (ç)

Option–c

If the character appears after the diacritical mark (rather than
with it), then the marked character is not available in the font
you’re using.
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Appendix B

Exchanging Disks and Files
With MS-DOS Computers

Initializing a disk in MS-DOS format
( You can also follow these instructions to initialize a disk in
ProDOS format.)
1. Locate the Apple File Exchange icon and open it.

Apple File Exchange is a file format conversion program supplied
on your system software disks. The program and translator files
are stored in the Apple File Exchange Folder.
You can use the program to initialize a disk in MS-DOS (or
Apple II ProDOS) format and convert files to and from MS-DOS
(or ProDOS). Apple File Exchange cannot open converted files;
you need to open them with an application program that
recognizes the converted files.

Apple File Exchange is supplied on one of your system
software disks.
When you open the program, the contents of the active
window are listed on the left side and an empty box appears
on the right side.
2. Insert a blank disk into your floppy disk drive.
A message reports that the program can’t read the disk and
asks if you want to initialize it. The message lists the formats
available in Apple File Exchange, including Macintosh,
MS-DOS, and ProDOS.
( You can initialize a disk that is not blank by inserting it,
clicking the Drive button until the disk’s name appears,
and then choosing Erase Disk from the File menu.)
continues .
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3. Click MS-DOS.
4. If necessary, click the capacity (in K) of the disk you
inserted.
If you want to initialize a high-density (˙) disk in MS-DOS
format, 1440K is the only option and it is already selected. If
you inserted a double-sided disk, click 720K.
Apple File Exchange cannot initialize a high-density disk in
720K format, nor can it read a double-sided disk that has been
initialized in the high-density (1.4 MB) format.

5. Click Initialize.
When initialization is finished, a message asks you to name
the disk.
6. Type a name for the disk, and then click OK.
MS-DOS filenames can have up to eight characters, followed
by an optional period and up to three characters.
The name of the disk you initialized appears above an empty
window. The disk’s icon doesn’t appear on your PowerBook
screen because the PowerBook can’t recognize a disk in
MS-DOS format.
7. Choose Quit from the File menu.

Disk capacity is the same
for Macintosh and MS-DOS
high-density disks.
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Follow these steps to translate an MS-DOS (or ProDOS) file:

Converting files to and from
MS-DOS format

1. Locate the Apple File Exchange program and open it.

Apple File Exchange provides two methods of file conversion—
text and binary. Text translation is for text files, and binary
translation is for other file types.
Apple File Exchange can also use translator files designed to
convert files into formats that specific programs can use. One
such translator file is provided with Apple File Exchange:
DCA-RFT/MacWrite, which converts documents between
MacWrite® format (for the Macintosh) and Document Content
Architecture/ Revisable Form Text format (used by many MS-DOS
word-processing programs).
File selected
for translation

Menus of
translator files
Directory
title or disk
name

Apple File Exchange is supplied on one of your system
software disks.
When you open the program, the contents of the active
window are listed on the left side and an empty box appears
on the right side.
2. Insert the floppy disk containing the files you want
to translate.
3. Use the Open, Drive, and Eject buttons to display the
files you want to translate and the disk or folder where
you want to store the translated files.
4. Click the names of the files or folders you want to
translate.
The appropriate translation menus (for translating from or to
Macintosh format) appear in the menu bar when you select
MS-DOS files.
continues .

Disk name
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5. Pull down the translation menu you want.
6. Make sure that the translators for the types of files you
selected have checkmarks; if not, choose them so
checkmarks appear next to them.
An active translator has a checkmark. The default translator
has a diamond (indicating that it’s always active). Choosing an
active translator makes it inactive.
7. Compare the size of the files or folders selected
for translation with the space available on the
destination disk.
Total space required appears between the lists; the space
available on the destination disk appears below its name.
If the size of the selected items is greater than the space
available on the destination disk, deselect some of the items,
remove some files on the destination disk (click Remove), or
use another destination disk (click Eject).

8. Click Translate.
If two or more active translators (other than Text or Default)
are capable of translating a selected file, a message asks you to
select the translator you want.
If the names of files or folders on the destination disk are the
same as those of files or folders being translated, a message
asks you to rename the file being translated.
If you need to select options before a file is translated, a dialog
box appears in which you can select the options.
9. Respond to any messages by selecting a translator,
renaming a file, or selecting options.
When Macintosh files are translated into MS-DOS files,
filenames may be shortened to conform to MS-DOS naming
conventions.
10. Choose Quit from the File menu.
v Converting MS-DOS files on a file server: Some file servers
can store information created by both Macintosh and MS-DOS
computers. For example, the AppleShare PC program allows
MS-DOS computers to store and translate files on an
AppleShare file server. Consult your authorized Apple dealer
or representative for more information about using a file
server and MS-DOS files. v
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Other file-conversion options
Apple File Exchange’s File menu provides several other options to
assist you with file conversions.

The active translators
and options for each
translator can be saved
in a file by choosing
“Save settings as.” You
can use these options
again later by choosing
“Restore settings from”
and opening the file.

To see explanations of the translators Apple File Exchange uses,
choose About Apple File Exchange from the Apple menu. Select a
translator from the list, and then click the About button for more
information. (Click Done to return to the program’s window.)

The program keeps a
log of all files translated,
showing the date, time,
and type of conversion.

Choose to rename
destination
(translated) files.
Names of files that can’t
be converted by the
active translators are
dimmed when this
item is checked.
Choose to reinitialize
a disk in any
available format.
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Appendix C

Map
The Map control panel lets you set your computer’s location and
find out the distance and the time difference between your
location and cities around the world. If you travel with your
computer and use Map to reset your location accordingly, the
time (in the Date & Time control panel) is automatically reset to
the local time.

Certain programs (in networking and telecommunications, for
example) can use your computer’s location to account for time
zones and distances when making calculations.

Setting your location
1. Choose Control Panels from the Apple (K) menu and
open the Map control panel.

To magnify the map in the control panel (showing less of the
world at a larger scale), hold down the Option key while you
open Map.
continues .
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2. Type the city nearest your current location and then
click the Find button (or press the Return key).
If you aren’t sure how the city is spelled, type the first few
letters and press the Return key. If the city isn’t found, you can
add it to the list of cities stored in Map (instructions are given
elsewhere in this appendix).
3. Click the Set button.
Your current location is indicated by a blinking cross.

Comparing locations
After you set your computer’s location, you can use Map to find
out:
m the distance from your location to another location
m the time at another location
m the time difference between your location and another
location
Open the Map control panel and find or add the other location
(instructions are given elsewhere in this appendix). You can also
choose a location by clicking anywhere on the map (the unnamed
location’s coordinates appear in the boxes for latitude and
longitude).

Click here to
display time
difference.
Distance to
location shown
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Local time in
location shown

The distance to and the time at the other location are shown at
the bottom of the window. The distance is based on the shortest
possible route (called the great circle).
To find out the time difference between your location and the
other location, click the words “Time Zone.” Click again to see the
other location’s time zone.

Finding a location
The Map has a list of locations, with information on the latitude,
longitude, and time zone of each location.
1. Choose Control Panels from the Apple (K) menu.
2. Open the Map control panel.
To magnify the map in the control panel (showing less of the
world at a larger scale), hold down the Option key while you
open the Map control panel.
3. Type the city you are looking for and then click the
Find button (or press the Return key).
If you aren’t sure how the city is spelled, type the first few
letters and press the Return key.
If you don’t know the name of a city but know where it is, you
can find it by clicking its location on the map. Each blinking
point is a location in the list. If you click in the map and then
drag to a blinking point, that location’s name, latitude,
longitude, and time zone appear.
(If you hold down the Option key while clicking the Find
button, Map displays, one at a time, all the locations in its list.)
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Adding or removing a location
Adding a location
1. If the map does not show the location you want to add,
scroll by dragging beyond the map in the direction of
the location.
2. Click the location.
A blinking star appears at the location, and its coordinates and
approximate time zone are displayed.
3. Type the name of the new location.

5. If the time zone is not correct, click the Time Zone
boxes and type in the correct number.
When the box at the end of the Time Zone line is checked,
the boxes show how much time the location is ahead (east) of
Greenwich Mean Time. Otherwise, they display how much
time the location is behind (west of ) Greenwich Mean Time.
The map estimates the time difference based solely on
longitude. Since the boundaries and time of time zones are
determined politically, you may need to consult a time zone
chart, map, atlas, or globe for the correct time.
6. Click the Add City button.

4. If you know the coordinates, type them in the latitude
and longitude boxes.

The new location is added to the list. If your computer beeps,
the location is already part of the list.

When the N and E boxes are checked, the boxes next to them
display North latitude and East longitude, respectively.
Otherwise, they display South latitude and West longitude.

To change details about a location, you need to remove it and
then add it again.

Changing or removing a location
1. Find a location.
2. Click the Remove City button.
If you want to keep the location but change the coordinates
or time zone, type the new coordinates or time zone, then
click the Add City button.
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Index
A
About This Macintosh (Apple menu) 161
accent marks, typing 298–299
access privileges. See also file sharing;
registered users; shared disks
accessing your computer from
another 204–205
assigning
for folders and disks 207
to users 198–199
categories of users 206
giving away folder ownership 201
icons for 209, 210
preventing access 199–200
strategies for assigning 208–209
types of access 206, 207, 208–209
AC power source for running the
computer 87
active program
identifying 80
switching 50–52, 80

active window
making a window active 34–36, 51–52,
61, 276
printing contents of 171
adapters for overseas travel 270. See also Duo
Floppy Adapter
ADB devices, connecting with the Duo Floppy
Adapter 251–253
ADB port
Duo Dock 219
Duo Floppy Adapter 253
Duo MiniDock 241
adding a location with Map 310
adjusting
blink rate of menu items or insertion
point 157
brightness and contrast controls 5, 7, 24
chair 22, 23
disk cache 162
display 3, 24
keyboard operations 155–156
trackball or mouse operations 154
Alarm Clock (Apple menu) 149–150

aliases
creating and using 120–121
locking 110
for shared disks 188
APDA (Apple Programmers and Developers
Association) 273–274
Apple-authorized dealer or service provider
xiii, 19, 268, 271–272, 281
AppleCare service plan 272
Apple Developer Programs 274
Apple File Exchange (Apple menu) 301–305
Apple HDI-30 SCSI Disk Adapter cable 17,
260, 261, 262
Apple HDI-30 SCSI System Cable 219, 242,
256, 259
Apple HD SC Setup program 105–106, 116
Apple menu
About This Macintosh 161
Alarm Clock 149–150
Apple File Exchange 301–305
Battery 66, 88
Chooser 165–167, 183–184, 185–187
installing/removing items 121, 146–147
opening programs from 78
Scrapbook 82
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Apple Menu Items folder 121, 146
AppleShare 185–186
AppleShare PC program 304
AppleTalk. See also LocalTalk; networking
software; networks
choosing a printer 167
turning off to make more memory
available 161
turning on 183–184
zones 186
Apple Technical Library/Apple
Communications Library 273
Application menu
Hide Others 80
PrintMonitor 173
Show All 80
switching the active program 51–52, 80
Application menu icon 48, 51, 52
application programs. See also programs
installing 78–79
overview 53
preferences for 146–147
tips for using 78
troubleshooting 296
arrow keys 45, 280, 297
arrow pointer 8–11, 28, 54, 62, 285. See also
I-beam pointer
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audio output devices 268
automatic power conservation settings 104
automatic sleep 13, 90, 100–101, 284
AutoRemounter control panel 189

B
background pattern on screen 138–139
background printing 167, 173, 284
backing up files 111
backlight dimming. See screen dimming
Balloon Help 67–68
batteries. See also battery power conservation
backup batteries 87, 94, 96
burns from damaged batteries 95
care and safety instructions 18, 20, 90, 95
conserving power when changing power
sources 104
damaged 95, 283
disposal of dead batteries 96
Duo Dock and 222
Duo Floppy Adapter and 253
Duo MiniDock and 248
duration of charge 87–88, 95, 99
low-power icon 265
low-power messages 89–90, 95
maximizing battery life 95, 97–98
monitoring charge level 87–90

recharging 90–93, 95
reconditioning (PowerBook Duo
270c) 97–98
removing or replacing 94, 222
SCSI disk mode and 265
temperature ranges for 90
time needed to recharge 91, 92, 93, 95
tracking battery charge 66
transporting 18, 269
Battery (Apple menu) 66, 88
battery conservation settings (PowerBook
control panel) 66–67, 99, 100–104
Battery Conservation slider 67, 100–102
Battery desk accessory 66, 88–89
battery power conservation. See also batteries
automatic sleep 100–101
changing power sources 104
off power state 12
processor cycling 99, 102–103
processor speed 103
regulating power consumption 100–104
setting Custom options 101–104
sleep power state 13, 99, 222
tips for 92, 99
using Battery Conservation slider 67,
100–102
using Duo Dock 222
using a RAM disk 83

Battery Reconditioning application 97–98
beep sound
setting 131–132
with Sticky Keys or Slow Keys 156
binary method of file conversion 303
bitmap fonts 175
blinking question mark icon 6, 73
blink rates 157
blurred screen 284
brightness controls 5, 7, 24
brightness level, power conservation and 99
burns to skin and eyes from damaged
batteries 95
By Label ( View menu) 128, 139

C
cables
Apple HDI-30 SCSI Disk Adapter cable 17,
260, 261, 262
Apple HDI-30 SCSI System Cable 219,
242, 256, 259
connecting SCSI devices 259
Ethernet 183
floppy disk drive 241
LocalTalk 183, 219, 242
power adapter 2, 239
safety instructions for 18
Token Ring 183

Caps Lock key 297, 298
care
of computer equipment 18–20
of floppy disks 69
carpal tunnel syndrome 21
CD-ROM disc, sharing 194–195
chaining devices
Duo Dock 219, 223
Duo Floppy Adapter 253
Duo MiniDock 241
SCSI chains 256, 258–259
chair, adjusting 22, 23
changing
amount of memory a program uses 81
appearance of windows 158
background pattern on screen 138–139
color of window borders 137
colors in the Label menu 140–141
documents 54–57, 58–60
formats for date and time 151–152
formats for numbers and currency 153
highlight color or shade of gray 136–137
icons 159
information in views 158
items in the Label menu 148
keyboard layouts 155
locations with Map 310
name of an icon 62–63
password 190–191, 205
stationery pad 127

character repeat rate 155
Chooser (Apple menu) 165–167, 183–184,
185–187
choosing
action to perform 32
commands 32
items from menus 279–280
printer 165–167
Clean Up Desktop (Special menu) 32, 117
Clear (Edit menu) 82
clicking 29, 55
Clipboard 56
clock 148–149
Close (File menu) 52
close box 40, 41, 42, 52, 276
CloseView control panel 143–144
Close Window (File menu) 42, 276
closing. See also quitting; turning off
documents 52, 61
windows 40, 41–42, 276
Color control panel 136–137
color printers 171
colors
assigning a label and color to an
icon 128, 139
background pattern 139
displaying colors or grays 135
highlight color or shade of gray 136–137
in the Label menu 140–141
window borders 137

Index 315

color wheel 140–141
Command x key 16, 45, 297
keyboard shortcuts and 58
commands
choosing 32
defined 32
keyboard shortcuts for 58
computer viruses 79, 282
connecting
to a floppy disk drive 69
to a shared disk 185–189
the computer as a SCSI disk 260–263
computers on a network 183
equipment to the Duo
Dock 218–219
equipment to the Duo Floppy
Adapter 251–253
equipment to the Duo
MiniDock 239–242, 244
external modem 266–267
hard disk to a printer 178
printers 267
SCSI device cables 259
sound input and output devices 268
to your computer from
another 204–205, 295
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conserving battery power. See battery
power conservation
containers, desktop and 42–44
contrast controls, adjusting 5, 7, 24
Control key 16, 45, 156, 297
control panels
AutoRemounter 189
CloseView 143–144
Color 136–137
Date & Time 148–149, 151–152
Easy Access 156
File Sharing Monitor 202–203
General Controls 138–139, 157
installing in System Folder 146–147
Keyboard 155
Labels 140–141, 148
Map 307–310
Memory 83, 84, 162–164
Monitors 135, 141–142, 245–246
Mouse 154
Numbers 153
PowerBook 66–67, 99, 100–104
PowerBook Display 142
Sharing Setup 184, 192, 202, 205, 212
Sound 131–134
Startup Disk 85, 108
Users & Groups 193, 195–201, 204–205,
213–214
Views 128, 158

converting files to MS-DOS or ProDOS
format 303–305
Copy (Edit menu) 82, 160
copying
documents 61–62
icons 276
items from the Scrapbook 82
copyright laws, file sharing and 195
creating
documents 49
folders 118
RAM disk 83–84
cumulative trauma disorders (CTDs) 21
currency and numbers formats 153
custom installation
of printer software on networked
computers 169–170
of system software 76–77
Custom View (PowerBook control panel) 67,
100, 101–104
Cut (Edit menu) 56
cutting and pasting text 56

D
damaged
battery 283
computer 271
floppy disks 111, 113, 114–115, 291–292
programs 296
date and time
changing formats for 151–152
to print a document 173
setting 148–149
using Map 307
Date & Time control panel 148–149,
151–152
DCA-RFT/MacWrite, converting files
between 303
dead batteries, disposal of 96
delays
before acceptance of next keystroke 156
before keys repeat 155
Delete key 49, 55, 58–60, 297
deleting text 49, 55, 58–59
desk accessories
Battery 66, 88–89
Key Caps 178, 298–299

desktop
contents of 42–44
printing 171
illustration 15
moving items to 121
diacritical marks 298–299
dialog boxes
custom installation 76, 170
directory 119, 177
Easy Install 75, 76
to name and save a document 50
Page Setup 168, 172
directory dialog boxes 119, 177
discharging/recharging the battery 95
disconnecting
Duo Floppy Adapter 255
Duo MiniDock 250
from file sharing 203–204
from shared disk 187, 200
from SCSI disk mode 265
program links 212
disk cache 162
diskettes. See floppy disks
Disk First Aid program 17, 113, 114–115
disk repair programs 114–115
Disk Tools disk 17, 77
Apple HD SC Setup 105–106, 116
Battery Reconditioning 97
Disk First Aid 113, 114–115

display. See also monitors; screen
adjusting angle of 24
closing to put the computer to sleep 13
opening and adjusting 3
disposal of dead batteries 96
docked computer. See Duo Dock; Duo Floppy
Adapter; Duo MiniDock
documents. See also files
changing 54–57, 58–60
closing 52, 61
copying 61–62, 292
creating 49
deleting 292
editing 54–57, 58–60
icons 44
making a document window active 61
naming 49–50, 119
opening 53–54, 61
opening at startup 146
printing 170–171
background printing 167, 173, 284
saving 49–50, 57, 119, 292
troubleshooting 292
double-clicking 54, 60, 275
adjusting speed 154
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double-sided floppy disks 69, 70. See also
floppy disks
erasing 108
initializing 107
with Apple File Exchange 302
Download Fonts (LaserWriter Font Utility)
177
downloading
fonts 176–177
PostScript files to a LaserWriter 180
Download PostScript Files (LaserWriter Font
Utility) 180
dragging 31, 55
Duo Dock
access to devices 243
automatic sleep 100
battery usage 222
chaining devices 219, 223
connecting
equipment 218–219
to networks 219
SCSI devices 219, 223
sound input and output devices 268
docking the computer 220
ejecting the computer from 226–228, 287
features 216–217
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hard disk connected to 223
inserting the computer 220, 287
installing a NuBus card 228–236
LocalTalk and 224
locking 217, 220, 225, 271
modems 224
monitors 217, 287
weight limit 218
ports
ADB 219
illustration of 217
modem 224, 266–267
SCSI 256
sound output 268
video 218
preferences in effect 222, 223
security slot 225, 271
selecting a network connection 224
setting up 218–220
sleep 222
starting up from 223
subassembly 230–232, 235
terminators for SCSI chains 258
troubleshooting 220, 221, 224, 227, 287
turning on a docked computer 221, 287
unlocking 226
virtual memory 223
VRAM 217

Duo Floppy Adapter
battery usage 253
chaining devices 253
connecting 251–253
disconnecting 255
locking 271
other types of adapters 255
ports
ADB 253
floppy disk drive 252
security slot 271
shut down and sleep 251, 255
turning on the connected computer 254
Duo MiniDock
automatic sleep 100
battery usage 248, 288
chaining devices 241
connecting
to the computer 244
equipment 239–242
sound input and output devices 268
devices recognized by 243
disconnecting 250
docking 243–244
features 237–238

hard disk connected to 249
LocalTalk and 238, 242
locking 271
modems 238, 239, 242, 250
monitors
connecting an external
monitor 239–240, 248
disconnecting 250
making an external monitor the main
monitor 245–246, 248
supported by the MiniDock 238
troubleshooting 288
video mirroring 248
ports
ADB 241
floppy disk drive 241
illustration 238
modem 242, 266–267
printer 242
SCSI 256, 263
sound output 268
video 240
power adapter and 239–240, 248
preferences in effect 247, 249
removing the computer 250

SCSI disk mode 17, 260, 263
security slot 271
setting up 239–242
sleep 243, 244, 248, 250
starting up from external hard disk 249
terminators for SCSI chains 258
troubleshooting 246–247, 250, 288
turning on the connected
computer 245, 288
using input devices with 247
virtual memory 249
Duplicate (File menu) 62, 276

E
Easy Access control panel 156
Easy Install dialog box 75, 76
Easy View (PowerBook control panel) 67,
100, 101
editing documents 54–57, 58–60
Edit menu
Clear 82
Copy 82, 159
Cut 56
Paste 56, 82, 160

Eject Disk (Special menu) 112
ejecting the PowerBook Duo from the Duo
Dock 226–228
electrical equipment, safety instructions
for 18
Empty Trash (Special menu) 64
turning off the warning message 160
Enter key 280
Erase Disk (Special menu) 84, 108
erasing
floppy disk 108
RAM disk 84
Ethernet network 224. See also networks
exchanging disks and files with MS-DOS or
ProDOS format 301–305
expansion adapters 255
external floppy disk drive. See floppy
disk drives
external hard disk drive. See hard disks
external modem. See modems
external monitor. See monitors
eye fatigue from computer use 22
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F
fatigue from computer use 22, 25
file conversion to MS-DOS or ProDOS
format 303–305
File menu
Close 52
Close Window 42, 276
Duplicate 62, 276
Find 122–125
Find Again 122
Get Info
changing an icon 159
changing the amount of memory a
program uses 81
creating a stationery pad 126
information about files 127
locating the original of an alias 121
locking a file 110
turning off the Empty Trash
warning 160
Make Alias 120, 188
New Folder 118
New Group 197–198
New User 195
Open 33, 35, 38
Page Setup 168
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Print 170–171
Print Desktop 171
Print Window 171
Put Away 64, 112, 187
Quit 60
Save 49, 57
Sharing
folder ownership 191, 201–202
program linking 213
selecting a folder or disk to
share 194–195
selecting users to share a folder or
disk 198–199
setting access privileges 207
files. See also documents
assigning colors and labels to 128, 139
converting to MS-DOS or ProDOS
format 303–305
downloading to a LaserWriter 180
locking/unlocking 110
making copies of 62
organizing in folders 118, 119
straightening up icons on the desktop 117
throwing away 63–64
translators for file conversion 301,
303–305
troubleshooting 292

file server. See shared disks
file sharing. See also access privileges;
networks; registered users;
shared disks
accessing your computer from
another 204–205
disconnecting users from 203–204
guest access 193, 194, 195–196
making a folder or disk private 195
monitoring 202
naming registered users and
groups 195–198
overview 192
selecting a folder or disk to
share 194–195
selecting user access 198–199
troubleshooting 295
turning off 161, 202
turning on 192–193
File Sharing Monitor control panel 202–203
Find Again (File menu) 122
Finder
changing appearance of Finder
windows 158
finding items on any disk 122
making active 50–52
overview 53

Find (File menu) 122–125
finding
items using search criteria 122–125
locations with Map 309
the original of an alias 121
fixed-size fonts 175
flickering screen 284
floppy disk drive port
Duo Floppy Adapter 252
Duo MiniDock 241
floppy disk drives. See also Duo
Floppy Adapter
connecting an external drive to the Duo
MiniDock 241
connecting your computer to 69
damaged 111
included with the Duo Dock 216
Macintosh HDI-20 External 1.4 MB Floppy
Disk Drive 251–252
troubleshooting 291–292
floppy disks
backing up files 111
care of 69
compared with hard disks 70
damaged 111, 113, 114–115, 291–292
double-sided 69, 70

ejecting 112, 291
erasing 108
high-density 69, 70
icon 43, 70
initializing 107
in MS-DOS or ProDOS format 301–302
inserting 71
locking/unlocking 109
problems saving files 111
restarting the computer from 17, 77
testing/repairing 114–115
troubleshooting 111, 113, 114–115,
291–292
types of 69, 70
folders
access privileges to 207–209
Apple Menu Items 121, 146
creating and naming 118
creating on shared disks 190
displaying/hiding contents of 278
Fonts 174, 176
icons 43, 209, 210
Macintosh Basics 10
naming 118
organizing files with 118
ownership 190, 191, 201–202

selecting a folder to share 194–195
Startup Items 78, 146
System Folder 38, 73, 74
installing files in 146–147
more than one 77, 78
removing files from 147
throwing away 63–64
font catalog 178
fonts
displaying available fonts 178
downloading 176–177
font substitution option 172
installing 146, 175
obtaining 174
printing font samples 178
removing from the printer’s memory 179
troubleshooting 172, 294
types of 174–175
used in views 158
Fonts folder 174, 176
formatting. See initializing
FPU socket, Duo Dock 217
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G
General Controls panel 138–139, 157
Get Info (File menu)
changing an icon 159
changing the amount of memory a
program uses 81
creating a stationery pad 126
information about files 127
locating the original of an alias 121
locking a file 110
turning off the Empty Trash warning 160
ghost images on screen 285
giving orders to your computer 32
grays
displaying 135
highlight color or shade of gray 136–137
in the Label menu 140–141
grounding plug 2
grouping files with labels 128, 139
groups of users. See also registered users
access privileges 206–209
displaying 197–198
naming 197
program linking 214
removing from list of registered users 201
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guest users. See also access privileges;
registered users
accessing files on shared disks 185, 186
denying access to 199–200
folder ownership 190, 191
program linking 211, 213
turning on guest access for file
sharing 193, 194, 195–196

H
hard disks
access privileges to 207
available for the Duo Dock 216
backing up files 111
compared with floppy disks 70
connecting an external drive to the Duo
MiniDock 242
connecting to a printer 178
damaged 113–115
in the Duo Dock 223
giving away ownership of 201–202
icon 43, 70
initializing 105–106
precautions 113

sharing 194–195
testing/repairing 114–116
transferring files 129
troubleshooting 16–17, 77, 290–291
using hard disk space as
memory 163–164
hard disk sleep 101–102
hardware development resources 273–274
health-related information and computer
use 21–25
help
Balloon Help 67–68
obtaining service and support 271–272
Help menu
Hide Balloons 68
Show Balloons 67, 168
Hide Balloons (Help menu) 68
Hide Others (Application menu) 80
hiding windows 80
high-density floppy disks 69, 70
erasing 108
initializing 107
with Apple File Exchange 302
not recognized by another disk drive 291
highlight color 136–137
horizontal scroll bar 39–40, 277

I, J
I-beam pointer 54–57, 58–60, 62. See also
arrow pointer; insertion point
icons
access privileges 209, 210
Application menu 48, 51, 52
assigning labels and colors to 128, 139
blinking 285
blinking question mark 6, 73
changing 159–160
changing the name of 62–63
copying 276
document 44
dragging to desktop 121
dragging to System Folder icon 146–147
folder 43, 209, 210
hard and floppy disk 43
low-power icon 265
Macintosh HD 9, 33
moving 276
opening 33, 276
PowerBook HD 9, 33
program 43

renaming 276
selecting 29, 32, 275
shared disk 43
startup disk 15, 33
straightening up 117
suitcases (font families) 175, 176
TeachText 48
Trash 15, 34, 44, 64
types of 42–44
used in views 158
ID numbers for SCSI devices. See SCSI
ID numbers
ImageWriter printer 168, 172
Info window
adjusting program memory size 81
changing an icon 159–160
creating/changing a stationery pad 126
finding the original of an alias 121
information about files 127
locking a file 110
Initialize Printer’s Disk (LaserWriter Font
Utility) 178
initializing
floppy disks 107
in MS-DOS or ProDOS format 301–302
hard disks 105–106

inserting
a battery 94–95
the PowerBook Duo into the Duo
Dock 220
text 55, 58–59
insertion point 49, 54, 58. See also I-beam
pointer
adjusting blink rate of 157
Installer program 74–77, 85, 169, 170
installing
fonts 175
items in the Apple menu 121, 146
NuBus card in the Duo Dock 228–236
printer software on networked
computers 169–170
SCSI device software 256
a sound 132, 146
system software 74–77
Install Me First disk 74, 76, 85
interference with radio and television
reception xiii
internal modem. See modems
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K

L

keyboard
adjusting angle of 24
adjusting character repeat rate and
delay 155
adjusting for slow typing 156
changing layouts 155
connecting
to the Duo Dock 219
to the Duo Floppy Adapter 251–253
to the Duo MiniDock 241
correct posture for using 23
illustration 297
safety instructions for 20
special keys on 45
Sticky Keys 156
typing special characters and
symbols 298–299
Keyboard control panel 155
keyboard files 147
keyboard shortcuts 58, 280
using Sticky Keys 156
Key Caps program 178, 298–299
kilobytes (K) 70

Label menu
assigning labels to files 128
changing colors or grays in 140–141
changing items in 148
Labels control panel 140–141, 148
LaserWriter Font Utility program 176–180
LaserWriter printer. See also printers
background printing 167, 173, 284
connecting a hard disk to 178
displaying available fonts 178
downloading PostScript files to 180
downloading PostScript fonts to 176–177
Page Setup dialog box 168
printing a start page 179
removing fonts from memory 179
restarting 179
license agreement for software 78, 195
limited warranty 19, 281
linking
allowing others to link to your
programs 212–214
to programs on other computers 210–211
list views
changing information included in 158
outline form in 278
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LocalTalk. See also AppleTalk; networking
software; networks
cables 183, 219, 242
Duo Dock and 224
Duo MiniDock and 238, 242
locating items using search criteria 122–125
locating the original of an alias 121
locations, Map and 307–310
locking
the Duo Dock 217, 220, 225, 271
files 110
floppy disks 109
log files
of file conversions 305
of PostScript activity 180
low-power icon 265
low-power messages 89–90, 95

M
Macintosh Basics folder 10
Macintosh Basics tour 7, 10–11
Macintosh desktop. See desktop
Macintosh HDI-20 External 1.4 MB Floppy
Disk Drive 251–252
Macintosh HD icon 9

Macintosh user groups 273–274
MacWrite/DCA-RFT, converting files
between 303
magnifying the screen image 143–144
main battery. See batteries
main monitor 141–142, 245–246
Make Alias (File menu) 120, 188
malfunctioning computer 271
Map control panel 307–310
math coprocessor socket, Duo Dock 217
megabytes (MB) 70
memory. See also RAM; virtual memory
adding 268
adjusting disk cache 162
changing the amount of memory a
program uses 81
checking memory use 161
fonts and 172
“not enough memory” message 286
protecting contents of while replacing the
battery 87, 94
RAM disk and 83, 84, 85
removing fonts from printer’s
memory 179
tips for memory management 161–162
using the 32-bit addressing feature 164

Memory control panel 83, 84, 162–164
menu bar 51, 52
illustration 15, 278
menu items, adjusting blink rate of 157
menus
choosing items from 279–280
displaying 30
overview 32, 44
pop-up 279
pull-down 278
microphone
connecting 268
recording sounds 133–134
microprocessor speed 103
minidock. See Duo MiniDock
modem port 166
Duo Dock 224, 266–267
Duo MiniDock 242, 266–267
modems
automatic sleep and 100
connecting an external modem 266–267
connecting to the Duo Dock 224
connecting to the Duo MiniDock 238,
239, 242, 250
internal 266–267
power conservation and 99
troubleshooting 293

modifier keys 45
keyboard shortcuts 58
special characters and symbols 298–299
Sticky Keys 156
monitors. See also display; screen
connecting to the Duo Dock 218
correct positioning of external monitor 25
designating the main monitor 141–142
external monitor and the Duo MiniDock
connecting 239–240
disconnecting 250
making it the main monitor 245–246
supported by the Duo Dock 217
supported by the Duo MiniDock 238
using a second monitor for
presentations 142
using more than one monitor 141–142
video mirroring 142, 248
weight limit of 218
Monitors control panel 135, 141–142,
245–246
mouse
adjusting tracking and double-clicking
speed 154
connecting
Duo Dock 219
Duo Floppy Adapter 251–253
Duo MiniDock 241
correct positioning of 24
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Mouse control panel 154
moving. See also transporting
hidden contents of windows into
view 38–40
icons 276
items to the desktop 121
windows to other parts of the
screen 40–41, 276
MS-DOS format
converting files to and from 303–305
initializing a disk in 301–302
musculoskeletal discomfort from computer
use 21–22

N
naming
computer and owner 84
converted files 305
documents 49–50, 119
folders 118
registered users and groups 195–198
network administrator
choosing printers 166, 167
connecting computers and installing
software 182, 183
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limiting access to shared disks 185
restricting users from changing
passwords 190
updating printer software 169
networking software, removing from System
Folder 147. See also AppleTalk;
LocalTalk; networks
networks. See also access privileges; file
sharing; passwords; registered
users; shared disks
backing up files 111
choosing a network printer 166–167
connecting to 183
Duo Dock and 224
Duo MiniDock and 242
installing application programs from 78
installing system software from 74, 76
naming the computer and owner 184
overview 181–182
troubleshooting 295
updating printer software 169–170
network zones 166, 167, 186, 211
New Folder (File menu) 118
New Group (File menu) 197–198
New User (File menu) 195
nickel-metal-hydride batteries. See batteries
noun/verb sequence for selecting objects and
giving commands 32

NuBus cards
available for the Duo Dock 217
installing in the Duo Dock 228–236
NuBus slots 232
numbers and currency formats 153
Numbers control panel 153

O
off power state 12, 14. See also shut down
on-line help. See Balloon Help
on power state 14
Open (File menu) 33, 35, 38
opening
documents 53–54, 61
icons 33, 276
programs 48
the Trash window 35, 64
windows 33–35, 277
operating system 53. See also system
software
Option key 45, 156, 297, 299
original of an alias, locating 121
outlet types for overseas travel 270
outline fonts 174
outline form in list views 278

P
Page Setup (File menu) 168
Page Setup dialog boxes 168, 172
paper, feeding manually 173
paper supply, checking with
PrintMonitor 173
passwords. See also access privileges;
registered users
assigning 196
changing 190–191
when accessing your computer from
another 205
connecting to shared disks 187, 189
typing in Sharing Setup control panel 184
Paste (Edit menu) 56, 82, 160
patterns, changing the background pattern
on screen 138–139
Personal LaserWriter SC 166
pointing 28
pop-up menus 279
ports
ADB
Duo Dock 219
Duo Floppy Adapter 253
Duo MiniDock 241

floppy disk drive
Duo Floppy Adapter 252
Duo MiniDock 241
included with the Duo Dock 216, 217
included with the Duo MiniDock 238
LocalTalk 224
modem 166
Duo Dock 224, 266–267
Duo MiniDock 242, 266–267
power adapter 2
printer 166, 183
Duo Dock 267
Duo MiniDock 242, 267
printer/modem 266–267
safety instructions for 19, 20
SCSI
Duo Dock 256
Duo MiniDock 256, 263
sound output, Duo Dock and Duo
MiniDock 268
video
Duo Dock 218
Duo MiniDock 240
PostScript files, downloading 180
PostScript fonts, downloading 176–177
PostScript log files 180

power adapter
automatic sleep and 100
Duo MiniDock and 239–240, 248
plugging in 2
power conservation when changing power
sources 104
recharging the battery 90–93
safety instructions for 19, 20
troubleshooting 5
using to conserve battery power 99
PowerBook control panel 66–67, 99,
100–104
PowerBook Display control panel 142
PowerBook Duo system. See Duo Dock; Duo
Floppy Adapter; Duo MiniDock
PowerBook Duo 270c, reconditioning the
battery 97–98, 99
PowerBook Duo 210, 230, or 250, maximizing
battery life 95
PowerBook HD icon 9, 33
power button
emergency use of 12, 14
on Duo Dock 224
troubleshooting 5, 17, 281–282
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power conservation. See battery
power conservation
Power On key 4, 7, 14, 100
troubleshooting 5, 16, 281–282
power sources 87, 104
power states 12–14
presentations, using a second monitor
for 142, 248
pressing with the trackball 30
Print (File Menu) 170–171
Print Desktop (File menu) 171
printer/modem port 266–267
printer port 166, 183
Duo Dock 267
Duo MiniDock 242, 267
printers. See also LaserWriter printer
automatic sleep and 100
choosing 165–167
connecting 267
to the Duo Dock 219
to the Duo MiniDock 238, 239, 242
troubleshooting 293–294
printer software
installing/removing from System
Folder 146–147
updating on networked
computers 169–170
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Printer Update document 169
printing
background printing 167, 173, 284
canceling 173
color or gray-scale documents 171
contents of a window or the desktop 171
documents 170–171
font catalog 178
font samples 178
memory and 172
startup page 179
troubleshooting 172, 294
PrintMonitor (Application menu) 173
Print Window (File menu) 171
processor cycling 99, 102–103
processor speed 103
ProDOS format
converting files to and from 303–305
initializing a disk in 301–302
programming resources 273–274
programs. See also application programs
Apple HD SC Setup 105–106, 116
Battery Reconditioning 97–98
changing memory usage 81
disconnecting a program link 212
Disk First Aid 17, 113, 114–115

icons 43
Installer 74–77, 85, 169
installing 78–79
LaserWriter Font Utility 176–180
linking 210–214
listed in Application menu 52, 80
opening 48
at startup 146
quitting 60, 61
switching 50–52, 80
TeachText 48, 52
tips for using 78
troubleshooting 296
types of 53
virus-detection 79, 282
working with several at a time 80–81
publish-and-subscribe feature 182
pull-down menus 278
pulling down a menu 30, 279
Put Away (File menu) 64, 112, 187

Q
question mark. See blinking question
mark icon
Quick Reference
icons 275–276
keyboard shortcuts 280
menus 278–280
troubleshooting 281–296
windows 276–278
Quit (File menu) 60
quitting. See also quitting; turning off
a program 60, 61
SCSI disk mode 265

R
radio and television reception, interference
with xiii
RAM. See also memory; virtual memory
adding 268
protecting contents when battery power is
low 90
protecting contents while replacing the
battery 87, 94
requirements for using a RAM disk 83

RAM disk
creating 83–84
erasing 84
precautions 83
resizing or removing 84
restarting the computer and 16, 17
using as your startup disk 85, 99
rearranging text 56
recharger 91–93
recharging the battery
after discharging it 95
in a recharger 91–92, 95
in both the computer and a recharger 93
in the computer 90–91, 95
in SCSI disk mode 265
troubleshooting 283
reconditioning the battery (PowerBook Duo
270c) 97–98
reconnecting to shared disks 189
recording sounds 133–134
registered users. See also access privileges;
file sharing; passwords; shared disks
accessing files on shared disks 185,
186, 189
accessing your computer from
another 204–205

assigning access to a shared folder or
disk 198–199
assigning passwords to 196
denying access to 199–200
displaying lists of 197–198
folder ownership and 190, 191, 201–202
naming 195–197
program linking 211, 214
reinstalling system software 74
using SCSI disk mode 263–264
removing
battery 94
computer from the Duo MiniDock 250
files from the System Folder 147
items from the Apple menu 121, 146
locations with Map 310
RAM disk 84
registered users 201
sounds 133
renaming
converted files 305
icons 62–63, 276
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repairing
computer 19
disks 114–116
repetitive stress injuries (RSIs) 21
replacing
backup batteries 96
main battery 94
selected text 55, 59–60
reset switch 16
resizing
RAM disk 84
window 36–37, 50, 276
restarting
the computer 16–17
RAM disk and 83
a LaserWriter 179
and reconnecting to shared disks 189
Restart (Special menu) 16
Restart Printer (LaserWriter Font
Utility/Utilities menu) 179
retrieving items from the Trash 64
Return key 280, 297
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S
safety instructions
batteries 18, 20, 90, 95
computer equipment 18–20
floppy disk drives 255
floppy disks 69
hard disks 113
installing a NuBus card in the Duo
Dock 228, 229, 233
ports 19, 20
power adapter 2, 19, 20, 90, 91
recharging batteries 90, 91
sound devices 268
traveling with the PowerBook 269–270
using a RAM disk 83
Save (File menu) 49, 57
saving your work 49–50, 57, 119
scalable fonts 174
scanner software 146–147
Scrapbook (Apple menu) 82
screen. See also display; monitors
care and safety instructions 20
magnifying the screen image 143–144
troubleshooting 284–285

screen dimming
Custom View and 102
Easy View and 101
power conservation and 99
troubleshooting 284
scroll arrow 39, 40, 277
scroll bars 39–40, 277
scroll box 40, 277
SCSI devices
access to, using the Duo MiniDock 243
chaining 256, 258–259
connecting to the Duo Dock 219, 223
connecting to the Duo MiniDock 238,
239, 242
disconnecting from the Duo
MiniDock 250
installing software for 256
overview 256
setting ID numbers for 257
terminators for chains 258, 261
troubleshooting 289

SCSI disk mode
backing up files 111
connecting your computer as a SCSI
disk 17, 260–263
copying programs from a desktop
Macintosh 74, 78
low battery power 265
quitting 265
reinstalling system software 263–264
repairing hard disks 113
shutdown and 262, 263
troubleshooting 262
SCSI drivers 256
SCSI ID numbers 106, 114
reinstalling system software and 263–264
setting 257, 260
SCSI port 256, 263
search criteria for finding files 122–125
security options using passwords 189
security slot 225, 271
selecting
icons 29, 275
objects on the screen 32
and replacing text 55, 59–60

service and support 271–272
service plans 272
setting locations with Map 307–308
setting up
computer 2–6
Duo Dock 218–220
Duo MiniDock 239–242
your work area for optimal comfort 22–25
shared disk icons 43
shared disks. See also access privileges; file
sharing; networks; registered users
automatic sleep and 100
connecting to 185–189
converting MS-DOS files on 304
creating a folder 190
disconnecting from 187
folder ownership 190, 191, 201–202
guest access 185, 186
making private 195
reconnecting to 189
setting user access 198–199
troubleshooting 295

Sharing (File menu)
folder ownership 191, 201–202
program linking 213
selecting a folder or disk to
share 194–195
selecting users to share a folder or
disk 198–199
setting access privileges 207
Sharing Setup control panel 184, 192, 202,
205, 212
Shift-clicking 275
Shift key 45, 156, 297
shortcuts. See keyboard shortcuts
Show All (Application menu) 80
Show Balloons (Help menu) 67, 168
showing windows 80
Shut Down (Special menu) 12
disconnecting from a shared disk 187
RAM disk and 83, 85
removing the battery 94
using the Duo Dock 220, 226
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shutdown state
connecting an external modem 266
connecting/disconnecting Duo Floppy
Adapter 251
connecting/disconnecting SCSI disk
adapter cable 262, 263
disconnecting Duo MiniDock 250
recharging the batteries 91, 93
transporting the computer 269
size box 36–37, 38–39, 276
sleep power state 13, 14, 89
automatic sleep 13, 90, 100–101
connecting an external modem 266
Duo Dock and 222
Duo Floppy Adapter and 251, 255
Duo MiniDock and 243, 244, 248, 250
power conservation 13, 99, 100
recharging batteries 91, 93
transporting the computer 269
troubleshooting 284, 285
when AppleTalk is active 184
Sleep (Special menu) 13
RAM disk and 83
removing the battery 94
Slow Keys 156
Small Computer System Interface. See SCSI
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sodium hydroxide, leaking from damaged
batteries 95
software development resources 273–274
software license agreement 78, 195
Sound control panel 131–134
sound input and output devices,
connecting 268
sound input port, recording sounds 133–134
sound output port, Duo Dock and Duo
MiniDock 268
sounds
installing 132, 146
recording 133–134
removing 133, 147
setting the beep sound 131–132
Special menu
Clean Up Desktop 32, 117
Eject Disk 112
Empty Trash 64
turning off the warning message 160
Erase Disk 84, 108
Restart 16
Shut Down 12
disconnecting from a shared disk 187
RAM disk and 83, 85
removing the battery 94
using the Duo Dock 220, 226
Sleep 13, 94

start page, printing 179
Start Page Options (LaserWriter Font
Utility) 179
startup 15
opening items automatically 146
startup disk
designating 108
Duo Dock hard disk as startup disk 223
icon 15, 33
overview 70, 73
scanning sequence for 109
using a RAM disk as the startup disk 85, 99
Startup Disk control panel 85, 108
Startup Items folder 78, 146
stationery pads, saving documents
as 126–127
Sticky Keys 156
storing
the computer 270
documents 119
items in the Scrapbook 82
StyleWriter printer 173
subassembly of the Duo Dock 230–232, 235
submenus 279–280
suitcase icons 175, 176

switching programs 50–52, 80
symbols, typing 298–299
system crash 16, 282
“system error” message 16
system extensions
installing in System Folder 146–147
removing to make more memory
available 161
System Folder
backing up 74
installing files in 146–147
more than one 77, 78, 282
opening into a window 38
removing files from 147
system software and 73
System Folder icon 146–147
System Folder window 38, 147
system sleep 101–102
system software
installing 74–77
overview 53, 73
reinstalling 74
using SCSI disk mode 263–264

T
Tab key 280, 297
TeachText program 48, 52
technical information, obtaining 273–274
technical support 271–272
television and radio reception, interference
with xiii
temperature ranges
for battery 90
for computer 20, 270
templates, saving documents as 126–127
terminators for SCSI chains 258, 261
testing disks 114–116
text, changing 54–57, 58–60
text method of file conversion 303
32-bit addressing 164
3.5-inch floppy disks 69, 70
time and date
changing formats for 151–152
setting 148–149
setting time to print a document 173
using Map 307
time zones, Map and 307–310
title bar 40, 41
Token Ring network 224. See also networks

trackball
adjusting tracking and double-clicking
speed 154
“breaking in” 8
choosing commands 32
clicking 29, 55
correct posture for using 23
dragging 31, 55
learning to use 8–11, 28–31
pointing 28
pressing 30
safety instructions for 20
troubleshooting 286
tracking speed 154
transferring
files 129
fonts to a LaserWriter 176–177
translation menus 303–304
translator files for file conversion 301,
303–305
transporting. See also moving
batteries 18, 269
the computer 19, 269–270
Trash 63–64
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Trash icon 15, 34, 44, 64
Trash window 35, 64
traveling with the computer 269–270
troubleshooting. See also safety instructions
accessing your computer from
another 205, 295
Apple Menu items 121
AppleShare icon doesn’t appear in
Chooser 186
application programs 296
batteries 283
blinking icons 285
blinking question mark 6, 73
computer just stopped 282
computer viruses 79, 282
damaged computer 271
Duo Dock 220, 221, 224, 227, 287
Duo MiniDock 246–247, 250, 288
ejecting a floppy disk 112
file sharing 295
finding or opening Sharing Setup icon 184
floppy disks and drives 291–292
hard disks 17, 77, 290–291
jagged fonts or missing letters 172
low-power messages 89–90
malfunctioning computer 271
modems 293
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“not enough memory” message 286
nothing appears on the screen 5
opening an alias 120
password not accepted 187
pointer movement 285
power adapter 5
power button 5, 17, 281–282
Power On key 5, 16, 281–282
printer icon doesn’t appear in
Chooser 166, 167
printers 293–294
printing and fonts 172, 294
programs 296
repairing disks with Disk First
Aid 114–115
restarting the computer 16–17
saving files on a floppy disk 111
screen 284–285
SCSI devices 289
SCSI disk mode 262
shutting down the computer 12
sleep power state 283, 284
starting the computer 5, 14, 281
starting up from a hard disk 113–114
“system error” message 16
system failures 282
trackball 286
virtual memory 286
viruses 79, 282
window disappears 285

TrueType fonts 174
turning off. See also closing; quitting
Alarm Clock 150
computer 12
Empty Trash warning 160
file sharing 161, 202
turning on the computer 4, 7, 14
connected to the Duo Dock 221
connected to the Duo Floppy Adapter 254
connected to the Duo MiniDock 245
how it starts itself up 15
typing 23, 45, 49
special characters and symbols 298–299
using special keys 297, 298

U
unlocking
Duo Dock 226
files 110
floppy disks 109
Untitled window 48, 49
user groups 273–274
users. See guest users; registered users
Users & Groups control panel 193, 195–201,
204–205, 213–214

V
variable-size fonts 174
vertical scroll bar 39, 40, 277
video mirroring 142, 248
video port
Duo Dock 218
Duo MiniDock 240
video support, included with the Duo
Dock 217
viewing contents of containers 44
viewing hidden contents of a window 38–40
View menu
By Label 128, 139
changing items in 158
displaying window contents or list of
items 128
outline form in list views 278
views, changing information in views 158
Views control panel 128, 158
virtual memory. See also memory; RAM
adjusting use of 163–164
Duo Dock and 223
Duo MiniDock and 249
power conservation 99
troubleshooting 286

viruses 79, 282
VM Storage file 164
VRAM, Duo Dock 217

W
waking the computer. See also turning on
the computer
how to wake the computer from
sleep 7, 12, 13, 14, 100
reconnecting to shared disks 189
startup process and 15
wall mount plug 2
warranty information 19, 281
windows
changing appearance of 158
changing color of borders 137
changing size of 36–37, 50
closing 40, 41–42, 276
displaying contents with View menu 128
hiding and showing 80
making a window active 34–36, 51–52,
61, 276
moving hidden contents into view 38–40
moving to another part of the
screen 41–42
opening 33–35, 277

printing contents of 171
scrolling through 39–40, 277
System Folder window 38, 147
Trash window 35, 64
troubleshooting 285
Untitled window 48, 49
viewing contents of containers 44
work area, setting up to enhance
comfort 22–25

XY
X-ray machines at airports and your
PowerBook 269

Z
zones. See network zones; time zones
zoom box 36, 37, 276
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